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About this document

The following topics are discussed in this section:

• “Who should read this document and why” (page 13)

• “What you need to know” (page 13)

• “How this document is organized” (page 14)

• “What’s new in this document” (page 15)

• “Text conventions” (page 15)

• “Related documents” (page 17)

Who should read this document and why
This document is for those who require performance metrics for devices in 
the Preside Multiservice Data Manager network. This document describes the 
performance management tools and how to use them.

What you need to know
This document assumes that you have an understanding of 

• network management

• the elements in your network including the Passport and MPE 9500 
products 

• the UNIX operating system
Preside MDM Performance Management  User Guide   15.1
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How this document is organized
This document contains the following sections:

• “Performance management tools overview” (page 19) gives a description 
of the performance management tools and how to access them. 

• “Data Viewer configuration” (page 21) describes the Data Viewer tool 
for collecting and displaying performance information about Simple 
Network Management Protocol (SNMP) and Passport devices and 
components. This section also provides procedures for using this tool. 

• “Data Viewer real-time collection” (page 35) describes real-time 
collection procedures that operator’s use to collect, display, and analyze 
performance information in real-time mode for component monitoring 
and diagnositics. 

• “Data Viewer retrieval of collected metrics” (page 47) describes the 
procedures for replay mode, to analyze collected performance 
information for planning, pattern analysis, and fault cause analysis. 

• “Data Viewer basic procedures” (page 53) describes basic procedures for 
operations such as starting and stopping, and for interface management 
through both the Preside Multiservice Data Manager Toolset and the 
Operator client in both real-time and replay modes. 

• “Data Viewer window” (page 69) describes the main components in the 
Data Viewer windows for both real-time and replay modes. 

• “Data Viewer fundamentals” (page 91) describes information specific to 
real-time mode, replay mode, or both. 

• “DPN Performance Viewer” (page 107) describes the DPN Performance 
Viewer and provides instructions on how to use this tool. 

Supplemental information in the appendices includes the following: 

• Appendix A, “ Passport performance metrics” (page 129), describes 
Passport performance metrics that the Data Viewer generates, by 
component in alphabetical order. 

• Appendix B, “DPN-100 metrics” (page 301), describes metrics 
supported by the Data Viewer application. 
241-6001-031   15.1    
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• Appendix C, “Metric file format” (page 307), describes SNMP metric 
file format and elements. 

What’s new in this document
The following changes were made to this document:

• “MPE support” (page 15)

• “Operator client support” (page 15)

• “Restructure” (page 15)

MPE support
This document now includes new Data Viewer tool procedures and text to 
support MPE. The Data Viewer tool supports MPE in much the same way as 
it does Passport. However, the Data Viewer tool does not support collection 
of multiple component instances of MPE devices.

Operator client support
This document includes new Data Viewer tool procedures and text to support 
MPE real-time and replay modes on the Operator client.

Restructure
This document has been restructured using a task-based model. 

Text conventions
This document uses the following text conventions: 

• nonproportional spaced plain type

Nonproportional spaced plain type represents system generated text or 
text that appears on your screen.

• nonproportional spaced bold type

Nonproportional spaced bold type represents words that you should type 
or that you should select on the screen.
Preside MDM Performance Management  User Guide   15.1
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• italics

Statements that appear in italics in a procedure explain the results of a 
particular step and appear immediately following the step.

Words that appear in italics in text are for naming.

• [optional_parameter]

Words in square brackets represent optional parameters. The command 
can be entered with or without the words in the square brackets.

• <general_term>

Words in angle brackets represent variables which are to be replaced 
with specific values.

• UPPERCASE, lowercase

Uppercase and lowercase letters that appear in UNIX commands and 
parameters must be matched exactly. The system matches upper and 
lowercase characters differently.

• UPPERCASE, lowercase

Passport commands are not case-sensitive and do not have to match 
commands and parameters exactly as shown in this document, with the 
exception of string options values (for example, file and directory names) 
and string attribute values.

• ->

A right-pointing arrow in a procedure indicates that a menu item has 
submenus from which you must choose. The appropriate submenu 
selection is shown immediately after the arrow. 

• |

This symbol separates items from which you may select one; for 
example, ON|OFF indicates that you may specify ON or OFF. If you do 
not make a choice, a default ON is assumed.
241-6001-031   15.1    



About this document   17
• ...

Three dots in a command indicate that the parameter may be repeated 
more than once in succession.

The term absolute pathname refers to the full specification of a path starting 
from the root directory. Absolute pathnames always begin with the slash ( / )
symbol. A relative pathname takes the current directory as its starting point, 
and starts with any alphanumeric character (other than /).

Related documents
See the following document for related information:

• 241-6001-011 Preside MDM Fault Management User Guide
Preside MDM Performance Management  User Guide   15.1
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Chapter 1
Performance management tools overview

There are two performance management tools available on the Preside 
Multiservice Data Manager. 

• Data Viewer. Data Viewer monitors performance metrics of components 
associated with (Simple Network Management Protocol (SNMP), 
MPE_9500, and Passport devices using a graphical interface. Data 
Viewer also traces faults in the network, collects information about 
network load, and generates statistics for reporting analytical purposes. 
For an overview of the Data Viewer tool, see “Data Viewer” (page 19)for 
information. 

• DPN Performance Viewer. DPN Performance Viewer monitors 
performance metrics of components associated with DPN devices using 
a graphical interface, traces faults in the network, collects information 
about network load, and generates statistics for reporting analytical 
purposes. For details, see “DPN Performance Viewer” (page 107). 

Note: The DPN Viewer is only available from the Toolset and cannot be 
accessed from the Operator client.

Data Viewer
Data Viewer can be used in two modes: 

• Real-time mode

• Replay mode

Use the Data Viewer tool to collect, display, and analyze performance 
information in real-time mode for component monitoring and diagnostics. 
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20   Chapter 1 Performance management tools overview
Use the Data Viewer in replay mode to analyze collected performance 
information for planning, pattern analysis, and fault cause analysis. 

Prerequisites to using Data Viewer
• To use Data Viewer in real-time mode, the user must have permission to 

authenticate using a device. 

• To use Data Viewer in replay mode, collect and save the following files: 

— BDF 

— Data Viewer Saved Statistics 

— Streamed Passport Statistics 

— Statistical Retrieval System 

• To configure Data Viewer for real-time mode, the user must have 
administrator level privileges. 

Data Viewer navigation
• “Data Viewer configuration” (page 21) 

• “Data Viewer real-time collection” (page 35) 

• “Data Viewer retrieval of collected metrics” (page 47) 

• “Data Viewer basic procedures” (page 53) 

• “Data Viewer window” (page 69) 

• “Data Viewer fundamentals” (page 91) 
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Chapter 2
Data Viewer configuration

Customize the Data Viewer configuration when you want to make changes to 
the initial default configuration, or when you need to make changes to 
existing metrics or add new metrics. 

Use Data Viewer configuration procedures to

• create or update metrics files

• integrate the metrics files needed for Data Viewer operation

User Preferences can be configured for Data Viewer. System level 
preferences are set by the administrator for a group of users, and user level 
preferences are set by individual users for themselves. Instructions for 
customizing user preferences are found in 241-6001-301 Preside MDM 
Customization Administrator Guide.

Prerequisites to Data Viewer configuration
• To configure Data Viewer you must have administrator level privileges.

• Be familiar with the differences between the Operator client and the 
Preside Multiservice Data Manager Toolset. For more information, see 
241-6001-100 Preside MDM Installation. 

Navigation
• “Data Viewer metrics configuration” (page 22)

• “Creating a new metric file” (page 25)

• “Updating the Data Viewer agent map file” (page 31)
Preside MDM Performance Management  User Guide   15.1



22   Chapter 2 Data Viewer configuration
• “Updating the PMDCD configuration file” (page 32)

• “Updating an existing metric file” (page 32)

Data Viewer metrics configuration 
Use the metrics configuration procedures to create or update metrics on 
SNMP devices, and Passport. Metrics configuration requires product 
integration for SNMP devices and Passport devices. SNMP devices require 
PMDCD configuration updates when there are changes to the metrics. 

Note: The Nortel Networks Multiservice Provider Edge (MPE) metrics 
file cannot be changed in this release.

Instructions support the Toolset and Operator client environments unless 
other wise indicated.

Prerequisites
• Data Viewer must be installed (as part of the Preside Multiservice Data 

Manager installation). 

• Fault Management must be configured. 

• Configuration variables values must be defined in a separate planning 
activity. 

Navigation
• “SNMP device metrics configuration procedures navigation” (page 24)

• “Passport metrics configuration procedures navigation” (page 24)
241-6001-031   15.1    



Chapter 2 Data Viewer configuration   23
Metrics configuration procedures
Use the following taskflow to identify the procedures needed to perform 
metrics configuration for SNMP devices, and Passport devices.
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24   Chapter 2 Data Viewer configuration
Metrics configuration procedures navigation
SNMP device metrics configuration procedures navigation
• “Creating a new metric file” (page 25) or “Updating an existing metric 

file” (page 32)

• “Updating the Data Viewer agent map file” (page 31)

• “Updating the PMDCD configuration file” (page 32)

• “User preferences for Data Viewer” in the 241-6001-301 Preside MDM 
Customization Administrator Guide

 Passport metrics configuration procedures navigation
• “Creating a new metric file” (page 25) or “Updating an existing metric 

file” (page 32)

• “Updating the Data Viewer agent map file” (page 31)

• “User preferences for Data Viewer” in the 241-6001-301 Preside MDM 
Customization Administrator Guide
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Creating a new metric file 
Use this procedure to create a new metric file that allows you to collect and 
display data using Data Viewer. 

Note: You cannot customize the MPE metric file. 

Instructions support SNMP devices, and Passport unless other wise indicated.

For details about the required elements and format of the metric file, see 
“Metric file format” (page 307).

Navigation
• “Procedure steps” (page 25)

• “Variable definitions” (page 28)

• “Sample Cdata notation for metrics in a metrics file job aid” (page 28)

• “Sample metrics file job aid” (page 29)

Procedure steps
1 Log on as root.

2 Access the appropriate directory for creating a new metric file:

3 Using a UNIX editor, open a new file for editing. 

4 The subsequent steps in this procedure specify the required entries that 
you need to add to create a metric file. 

5 Define the beginning of the metric file:

<METRICFILE>

For Access directory

SNMP devices cd /opt/MagellanNMS/cfg/pmr

Passport cd /opt/MagellanNMS/cfg/pmr

cd /opt/MagellanNMS/ext/lib/cfg/
pmr

MPE MPE metrics file cannot be 
customized in this release
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For more information on how to structure a metrics file, see “Sample 
metrics file job aid” (page 29).

6 Define a component:

<COMPONENT NAME = “<component name>”>

Note:  Use the symbol | after the component name to indicate if an 
instance is required.

7 Use this table to add SNMP-specific commands. Otherwise, go to the next 
step.

8 Define the metric element:

<METRIC NAME = “<metric name>”

Note:  Do not use an equal sign “=” in the <metric name>; it may cause 
parsing errors. 

For more information, see “Variable definitions” (page 28).

9 Specify whether or not the metric is to be polled by default by specifying 
one of the POLLBYDEFAULT options.

POLLBYDEFAULT = “<yes|no>”

For more information, see “Variable definitions” (page 28).

10 If required, specify a threshold value for the metric.

For... Instruction Command

SNMP devices If the component requires an IP 
address separate from the 
device itself, type the following 
entry.

<SEPARATE_IP/>

If the component requires 
mapping a component instance 
in the component name to a 
different value, type the 
following entry.

<MAP NAME = “<name>”
 VALUE = “DEC(<offset>)”>s

MPE Define the community string. <PROMPT NAME=”community 
string”>

Define the MPE 9500 index 
mapping label on the Input 
Request dialog.

<PARAMETER=”label name”>
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THRESHOLD = “<value>”

11 Define the METRIC STACK attribute:

STACK = “<stack elements>”

For more information, see “Variable definitions” (page 28).

12 If required for SNMP devices and MPE, specify the metric index.

INDEX = “<index elements>”

For more information, see “Variable definitions” (page 28).

13 Define the end of the METRIC element tag:

</METRIC>

14 If required, define additional metric elements by repeating step 8 to 
step 13.

15 Define the end of the COMPONENT element tag:

</COMPONENT>

16 If required, define additional component elements by repeating step 6 to 
step 15.

17 Define the end of the METRICFILE element tag:

</METRICFILE>

18 Add an optional description to the METRIC component in the metric file 
using the CDATA label. For example

<![CDATA[Discarded packets with priority 0 from
interface since the last baseline reset.]]>

Note:  Do not use a @ or ^ in CDATA. These characters may cause 
parsing errors.

For more information, see “Sample metrics file job aid” (page 29).

The CDATA section is optional. Any metric without the CDATA section will 
be used by Data Viewer; however, Data Viewer will show a dialog with the 
message, “The description for this metric is not available from the metric 
file.”

Note:  The only non-printable character allowed is ‘\n’.

19 Save and close the file.

Change the file permissions to allow read access by the group and others, 
and read-write access by the owner.
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chmod 664 <file name>

Variable definitions

Sample Cdata notation for metrics in a metrics file job aid
The following is an example of a Cdata metric description for metric “Tx 
Cells From Baseline”. Use it as a model when creating Cdata metric 
definitions. 

Variable Definition

<component name> is the name of the component to define

<file name> is the name of the metric file used in step 3

<index elements> specifies the index of the attributes in the stack

<metric name> is the name of the metric

<name> is the component instance in the component 
name

<offset> is an integer or single alphabetic character (A to 
Z) used to decrement the component instance

<prompt name is the name of the prompt used to define both the 
community string and index mappings

<SEPARATE_IP/> specifies that the IP address is separate from the 
device

<stack elements> specifies the attributes to be polled and their 
calculations

<value> is the threshold value

<METRIC NAME=“Tx Cells From Baseline”
POLLBYDEFAULT=”yes”
STACK=”(txCell/NUM)BASELINEDELTA”>
<![CDATA[Discarded packets with priority 0 from
interface since the last baseline reset.]]>
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Sample metrics file job aid
The following is an example of a metrics file. 

<METRICFILE>

<DEFINE>

<ENTRY NAME="CPUMemHeapTotal"

OID=".1.3.6.1.4.1.3199.10.28.1.2.14"/>

<ENTRY NAME="CPUMemHeapFree"

OID=".1.3.6.1.4.1.3199.10.28.1.2.13"/>

<ENTRY NAME="CPUMBufClusterFree"<ENTRY NAME="PacketsDropped"

OID=".1.3.6.1.4.1.3199.10.28.1.1.3.1.14/>

<ENTRY NAME="PacketsForwarded"

OID=".1.3.6.1.4.1.3199.10.28.1.1.3.1.15/>

</DEFINE>

<COMPONENT NAME = "XYZ">

<PROMPT NAME="%COMMUNITY_STRING" PARAMETER="VRF Community

String"/>

<PROMPT NAME="index1" PARAMETER="Interface Number"/>

<PROMPT NAME="index2" PARAMETER="Protocol Number"/>

<METRIC NAME="Total Memory in Heap"

POLLBYDEFAULT="no"

STACK="(CPUMemHeapTotal/NUM) DELTA"

INDEX=”index1">

</METRIC>

<METRIC NAME="Free Memory in Heap"

POLLBYDEFAULT="no"

STACK="(CPUMemHeapFree/NUM) DELTA"

INDEX="index1">

</METRIC>

<METRIC NAME="Free MBuf cluster in the CPU"

POLLBYDEFAULT="no"

STACK="(CPUMBufClusterFree/NUM) DELTA"

INDEX="index2">

</METRIC>

<METRIC NAME="Number of packets dropped"

<!-- This is a comment. This sample continues on the next page-->
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<METRIC NAME="Number of packets dropped"

POLLBYDEFAULT="no"

STACK="(PacketsDropped/NUM) DELTA"

INDEX ="index2">

</METRIC>

<METRIC NAME="Number of packets forwarded"

POLLBYDEFAULT="no"

STACK="(PacketsForwarded/NUM) DELTA"

INDEX="index2">

</METRIC>

</COMPONENT>

</METRICFILE>
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Updating the Data Viewer agent map file 
Use this procedure to update the Data Viewer agent map file. The Data Viewer 
map file maps the client session to Preside Multiservice Data Manager 
(MDM) servers. Clients open sessions with the Data Viewer agent. The agent 
connects to the corresponding MDM servers. Once connected to the servers, 
the agent provides information to the graphic user interface (GUI).

Use this procedure for SNMP devices only.

For information about the Data Viewer agent map file (pmrtype.map), see 
241-6001-310 Preside MDM Server Reference Guide.

Procedure steps
1 Copy the pmrtype.map file from the directory /opt/MagellanNMS/lib/cfg/

pmr to the directory /opt/MagellenNMS/cfg/pmr.

2 Using a UNIX editor, open the file pmrtype.map file.

3 Specify the device type and the name of the metric file.

<device type>:<metric file with full path name>:PMDCD

4 Save and close the file.

Variable definitions

Variable Definition

device type defines the device. 

metric file with full 
path name

defines the file name and the location of the 
metrics file for the device type
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Updating the PMDCD configuration file
Use this procedure to update the PMDCD configuration file to allow the Data 
Viewer data collection daemon to collect and display real-time performance 
information for Simple Network Management Protocol (SNMP) devices in 
the network. 

Use this procedure for Passport and SNMP devices only.

For information about the PMDCD configuration file (pmdcd.cfg), see 
241-6001-310 Preside MDM Server Reference Guide.

Procedure steps
1 Copy the pmdcd.cfg file from the directory /opt/MagellanNMS/lib/cfg/pmr 

to the directory /opt/MagellenNMS/cfg/pmr.

2 Using a UNIX editor, open the file pmdcd.cfg file.

3 Add the device type and sysName OID:

sysName:<device type>:<sysName OID>

4 Save the changes and close the file.

Variable definitions

Updating an existing metric file 
Update an existing metric file when a metrics file has already been defined 
and only minor changes need to be made.

Instructions support SNMP devices, and Passport unless other wise indicated.

Note: You cannot update or customize the MPE metric file in this release. 

Procedure steps
1 Copy the default metric file from one of the following directories:

• /opt/MagellanNMS/lib/cfg/pmr

Variable Definition

device type defines the device type. 

sysName OID defines the system object identifier
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• /opt/MagellanNMS/ext/lib/cfg/pmr

It is recommended that you copy the metric files to the directory /opt/
MagellanNMS/cfg/pmr.

2 Modify the metric file in the directory /opt/MagellanNMS/cfg/pmr, 
maintaining the format requirements specified in “Metric file format” 
(page 307).

3 Save the changes and close the file.

Note 1:  Use a different map file other than the default pmrtype.map file 
to contain the modified map information for the device type.

Note 2:  Use the device type or PPtype (for Passport) as the map file 
name to uniquely identify the file.

4 Copy the pmrtype.map from the directory /opt/MagellanNMS/lib/cfg/pmr 
or /opt/MagellanNMS/lib/cfg/pmr to the directory /opt/MagellanNMS/cfg/
prm.

5 Using a UNIX editor, open the file pmrtype.map file.

6 Modify the path name of the metric file associated with the device type.

7 Save the changes and close the file.
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Chapter 3
Data Viewer real-time collection 

Use Data Viewer real-time collection procedures to collect, display, and 
analyze performance information in real-time mode for component 
monitoring and diagnostics. 

Prerequisites for collecting real-time statistics
• To use Data Viewer in real-time mode, the user must have permission to 

authenticate using a device. 

Navigation

Metrics collection procedures navigation
• “Collecting performance information for single or multiple component 

instances” (page 36)

Data recording procedures navigation
• “Recording component information to a Data Viewer Saved Statistics 

file” (page 42)

• “Viewing a Data Viewer Saved Statistics file” (page 44)
Preside MDM Performance Management  User Guide   15.1



36   Chapter 3 Data Viewer real-time collection
Collecting performance information for single or multiple 
component instances 

Use this procedure to collect performance information for single or multiple 
components in real-time. 

Instructions support both the Toolset and Operator client environments unless 
other wise indicated.

Data Viewer supports performance collection from MPE for single 
component instances only. If multiple component instances are specified, 
they are ignored. Only the index specified by the user in the Input Request 
dialog is used for polling.

Navigation
• “Prerequisites” (page 36)

• “Procedure steps” (page 36)

• “Components selection job aid” (page 39)

• “Controlling data collection in real-time job aid” (page 40)

Prerequisites
• The Data Viewer must be running in real-time mode.

• If starting the Data Viewer from within another fault management tool, 
begin at step 6 of this procedure. 

Procedure steps
1 In the Data Viewer window enter the device name in the Device Name 

field, or click the down arrow of the Device Name field to scroll to the 
device name, or click Search to expand the dialog and enter device name 
search criteria.

2 Click OK. 

The Data Viewer - Group Authentication dialog opens if you have not 
previously authenticated.

3 Click the down arrow next to the Group field and select a group. 

4 Click the down arrow next to Userid field and select a user ID.

5 Enter your password if the password field is not automatically populated.
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6 Click OK.

A list of component names associated with the device appears in the 
Component field of the Data Viewer window. 

7 Specify the component to monitor by performing one of the following:

• Click the down arrow at the right of the Component field to scroll to 
the component name.

• Type the component name in the Component field.

The fully defined component name appears in the Component field. 
There can be multiple component levels in the fully defined 
component name, for example, CA/1 SH/1 BRM/5 

A forward slash after a component name indicates that there are 
multiple instances of that component. Specify an instance. 

• If a “?” appears after a component name, type the number of the 
component after the slash.

Pressing the right arrow on the keyboard moves the cursor to the next 
component that requires a component number. 

8 Specify multiple component instances to monitor by entering their values 
after the lowest level component in the Component field. 

A “?” after a component name indicates that there are multiple instances 
of that component. Specify the instance for each of these components by 
doing one of the following: 

• Type the number of each component instance to be polled. Use a 
semi-colon to separate each component instance from the next (for 
example, DIM_TI PO/2;4;5). 

Pressing the right arrow on the keyboard moves the cursor to the next 
component that requires a component number. 

• Type the wild-card “*” to poll all instances of the component. 

Note:  MPE 9500 devices do not support monitoring of multiple 
component instances. 

9 If the metrics for the selected component(s) require an index, the Index 
Request dialog opens. 

10 If the metric for the selected component requires a community string, 
enter a value for the Community String in the dialog. 

11 If the metric for the selected component requires an index, enter a number 
value for the Index Number into the dialog. 
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12 If there have been changes resulting from step 10 or step 11, press 
Accept. 

The metrics that are available for the component appear in the Available 
Metrics list. 

13 In the Max Components field, enter the maximum number of 
components to monitor. Enter a number in this field if a wildcard (*) or a 
range of sequential component numbers is entered into the Component 
field. 

The metrics available for the selected components appear in the 
Available Metrics list. Add new metrics for the components if required. 
For information on adding metrics see “Creating a new metric file” 
(page 25). 

Note:  MPE devices do not support monitoring of multiple component 
instances. 

14 Enter the number of seconds for gathering data in the Polling interval 
(Secs) field. 

The default is 60 seconds.

15 To limit the number of times data is collected for this component, enter a 
number into the Number of Polls field. 

Polling stops when the number of polls reaches the Number of Polls 
value. 

If the Number of Polls is empty, data collection continues until the user 
clicks Pause or Stop, or selects File -> Exit from the Data Viewer. 

For Polling interval range

SNMP devices 30 to 600 seconds

Passport 30 to 600 seconds

MPE 5 to 600 seconds

CAUTION:
Selecting a low polling interval when multiple devices are 
selected can flood the network and affect its performance.
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16 In the Available Metrics list, click the metric name in the Available 
Metrics list.

17 Click Select to move the selected metric to the Selected Metrics list or 
click Remove to remove metrics from the Selected Metrics list.

Note:  For a metric description, select the metric, and then right-click to 
display Help. A dialog displays the selected metric’s description. 

18 Click Start to begin data collection.

The message area at the bottom of the Data Viewer window displays 
status information on device and component connection. When 
connection is successful, a message in the status line indicates that the 
metric list was received. 

19 Press Start. 

20 Click OK.

Incoming data appears in the data panel area in the lower half of the Data 
Viewer window. A delay equal to the number of seconds in the polling 
interval can occur before data starts arriving.

If necessary, change the order of the columns in the data panel area and 
sort the values for each metric in ascending order. 

21 Optionally, click Reset to change the MPE component to collect data on. 
Repeat step 9 to step 20.

22 Optionally, from the View menu, change the view. 

View detailed performance information about each component. See 
“Viewing summary and detailed performance information” (page 62). 

Components selection job aid
A “?” after a component name in the Component field indicates that there 
are multiple instances of that component. 

Note: MPE devices do not support polling of multiple component 
instances. If multiple component instances are specified, they are 
ignored. Only the index specified by the user in the Input Request dialog 
is used for polling.
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To select multiple component instances to monitor, enter one of the following 
after the forward slash: 

• Wild-card “*” to poll all instances of the component. These restrictions 
apply to the use of the wildcard. 

For Passport, use the wildcard character, “*”, at the end of the component 
name to select multiple components. For example, EM/NODE47 SHELF 
CARD/* displays all cards on the shelf. Enter “*” for multiple 
component display, since context supplies only single component names. 
If the Passport version supports it, use the component administration 
system (CAS) extended wild carding. Substitute a wildcard character for 
a subcomponent within a component name. For example, EM/NODE47 
FRUNI/* FRAMER displays information on all available FrameRelay 
UNI Framers. 

Use the wildcard only for the lowest component type in the component 
name. For example, EM/MUNICH SHELF CARD/*

Note: Do not target too many components using extended Ricardian as 
this can negatively impact the performance of both the Passport and the 
workstation. 

• If the component instances are sequential, type the first and last numbers 
in the range, separated by dots (for example, to select instances 2, 3, 4, 
and 5, type EM/MUNICH SHELF CARD/2.5). 

• Type the number of each component instance to be polled. Use a semi-
colon to separate each component instance from the next (for example, 
EM/MUNICH CARD SHELF/2;4;5).

Controlling data collection in real-time job aid
One of the following actions are possible:

• To begin polling metrics for the specified component(s) using the current 
polling selections click Start.

• To suspend data collection click Pause.

• To resume data collection click Continue.

• To stop polling metrics for the specified component(s) using the current 
polling selections click Stop. 
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• To restart polling using the same settings, click Start. 
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Recording component information to a Data Viewer Saved 
Statistics file

Use this procedure to record data files, and write the component information 
to a Data Viewer Saved Statistics file for future reference. 

Instructions support both the Toolset and Operator client environments unless 
other wise indicated.

• “Prerequisites” (page 42)

• “Procedure steps” (page 42)

Prerequisites
• The Data Viewer must be in real-time mode.

• Saved files must not exceed 10 Mega bytes. When this limit is reached, 
the file should be closed and a new file opened.

Procedure steps
1 From the File menu, select Start Recording.

2 From the Data Recording Options dialog, select one of the following 
options:

• Record Starting Now saves all the data the Data Viewer has 
collected since start-up

• Record All Available Data saves the metric data that the Data 
Viewer collects during the next and subsequent polling intervals

3 Click OK.

4 From the Select Recording File dialog, select an existing file name or 
enter a new name for the Data Viewer Saved Statistics file. The Data 
Viewer tool provides the default file name. 

5 Select Open for new files. 

The Data Viewer opens a Data Viewer Saved Statistics file and writes the 
performance information to it. The Data Viewer Saved Statistics file is 
updated as more information is received.

6 When selecting an existing file name, the Legacy Dialog opens. Select 
an option in the dialog:
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• Select Continue to add a new performance information to the Data 
Viewer Saved Statistics file.

All information already in the file is retained.

• Select Cancel to select another file name or to create a new Data 
Viewer Saved Statistics file.

The Open dialog opens. Enter the name of the file to open. 

7 From the File menu select Stop Recording to stop logging.

Output to the Data Viewer Saved Statistics file stops and the file closes.
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Viewing a Data Viewer Saved Statistics file
Use this procedure to view the Data Viewer Saved Statistics file after saving 
the component information. 

Instructions support both the Toolset and Operator client environments unless 
other wise indicated.

• “Prerequisites” (page 44)

• “Procedure steps” (page 44)

Prerequisites
The Data Viewer must be in real-time mode.

Procedure steps
1 From the File menu, select View Recording.

The View File window opens. 

If a Data Viewer Saved Statistics file is open, the name of the open Data 
Viewer Saved Statistics file appears in the window. View this Data Viewer 
Saved Statistics file or change the file name to view a different Data 
Viewer Saved Statistics file. 

2 To view a different Data Viewer Saved Statistics file, from the File sub 
menu, select Load file. 
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The Open dialog opens. 

3 Select a Data Viewer Saved Statistics file to view. 

The Data Viewer Saved Statistics file appears in the View File window. 
When viewing the current Data Viewer Saved Statistics file, new data is 
continuously written to the file as received. 

4 To close the Data Viewer Saved Statistics file and the View File window, 
select File -> Exit.
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Data Viewer retrieval of collected metrics

The Preside Multiservice Data Manager Data Viewer tool in replay mode is 
used to analyze collected performance information for planning, pattern 
analysis and fault cause analysis. 

Prerequisites to retrieving collected metrics
To use Data Viewer in replay mode, files of one of the following types needs 
to have been previously collected and saved: 

• BDF 

• Data Viewer Saved Statistics 

• Streamed Passport Statistics 

• Statistical Retrieval System 
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Retrieving data files
Replay BDF, Data Viewer Saved Statistics, Streamed Passport Statistics, 
Statistical Retrieval System files on a local workstation, and from an Operator 
Client after data has been collected. 

Note: When using Operator Client to view BDF files, ensure that BDF 
data files have be transferred to the local directory for Operator Client.

The default record description files (RDF) are used to decode bulk data 
format (BDF) files. Data Viewer locates the default RDF when it is launched 
in replay mode. Data Viewer may not display BDF files correctly if changes 
are made to RDF or BDF files after the tool is launched. 

If the BDF files were recorded using an older version of the RDF files and the 
data record does not contain the current RDF version, use the Select RDF 
option to select the corresponding RDF for the BDF files. Begin the following 
procedure at step 5. See 241-6001-309 Preside MDM Management Data 
Provider User Guide for information on managing BDF data, and 
customizing RDF data records.

Instructions support both the Toolset and Operator Client environments 
unless other wise indicated.

Navigation
• “Prerequisites” (page 48)

• “Procedure steps” (page 48)

• “Data Viewer file selection job aid” (page 51)

Prerequisites
The Data Viewer must be in replay mode.

Procedure steps
1 Use this table to select the appropriate access method.
241-6001-031   15.1    



Chapter 4 Data Viewer retrieval of collected metrics   49
2 Access the files by a file system mount or FTP the files to the local 
workstation.

3 From the Operator Client Data Viewer Options menu, choose Replay 
Mode.

4 Verify that both the record description file (RDF) and the bulk data file 
(BDF) exist.

5 To use the default RDF, go to step 7, otherwise, continue with this step. 
From the Options menu, choose Select RDF.

6 From the Select RDF File dialog, select an RDF file and click Open.

7 In the File Retrieval section of the Data Viewer replay mode window, 
select a Data Type from the pull-down menu, if required:

• Data Type
Accounting, Alarm, All (default), Availability, Data Viewer Saved 

For Go to

local access step 5

remote access step 2

Operator Client access step 3
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Statistics, Log, Outage, Statistics Retrieval System, SCN, 
Statistics, Streamed Passport Statistics

8 If required, select a Device Type from the pull-down menu:

• Device Type
All (default), DPN, Others, Passport, MPE 

9 If required, in the Device Name field, type the device.

• specify <nodename | nodeid> for Accounting, Alarm, Scn, Log, 
Statistics and Outage data types

• device name has no impact on Availability type

• specify <nodename> for SRS and Data Viewer Saved Statistics data 
types

• specify <Passport-groupname> in Streamed Passport statistics data 
type

10 If required, specify the Start Date and End Date:

• Use Start Date to specify a range of start date (yyyy/mm/dd) and 
time (hh:mm:ss) of the filename to be filtered. Any files with the start 
date and time later than the Start Date are selected. 

• Use End Date to specify a range of end date (yyyy/mm/dd) and time 
(hh:mm:ss) of the filename to be filtered. Any files with an end date 
and time earlier than the End Date are selected. 
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11 Click Retrieve Files to add data files.

12 Select the file(s) from the File Selection dialog and click OK. For 
information on how to select multiple files or file ranges, see “Data Viewer 
file selection job aid” (page 51)

13 The file(s) appear in the Files Selected area.

14 Select the file(s) to view from the Files Selected area.

15 Click View.

The Progress Information dialog flashes on the screen briefly, 
depending on the size of the files. The files are displayed in the Data Panel 
area of the Data Viewer window.

16 To view multiple files with the same data type, use Shift+click (to select a 
group of consecutive files) or Ctrl+click (to select individual files). 

17 If required, from the View menu, select a different view.

Data Viewer file selection job aid
For instruction on how to select a file, a range of files, or multiple files from 
the file selection dialog use this job aid. 
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To select a single file
• Click the mouse on a file name and click OK. The file is added to the 

Files Selected area of the Data Viewer window and the File Selection 
dialog closes.

• Click the mouse on a file name and click Apply. The file is added to the 
Files Selected area of the Data Viewer window and the File Selection 
dialog remains open.

To select a range of files
• Click the mouse on the first file name, press shift and click the mouse on 

the last file name and click OK or Apply to confirm the selections.

To select multiple files

• Press control, and click the mouse on multiple file names and click the 
OK or Apply to confirm the selections.
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Data Viewer basic procedures

Use Data Viewer basic procedures for operations such as starting and 
stopping, or managing the interface of the Data Viewer from the Preside 
Multiservice Data Manager Toolset and from Operator client in both real-
time and replay modes. 

Navigation
Real-time mode

• “Starting the Data Viewer in real-time mode” (page 49)

• “Starting the Data Viewer in real-time mode from within another fault 
management tool” (page 51)

• “Starting other fault management tools from Data Viewer” (page 52)

Replay mode
• “Starting the Data Viewer in replay mode” (page 53)

Real-time and replay modes
• “Exiting the Data Viewer” (page 54)

• “Editing user preferences” in 241-6001-301 Preside MDM 
Customization Administrator Guide

Controlling the display of performance information
• “Rearranging data display” (page 55)

Viewing performance information
• “Viewing summary and detailed performance information” (page 56)
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• “Changing the color assigned to a metric” (page 58)

• “Managing the graphical display” (page 59)

• “Removing files from the Files Selected area” (page 60)
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Starting the Data Viewer in real-time mode
Use this procedure to start Data Viewer in real-time mode to analyze 
performance data. 

Figure 1, “Toolset performance management tools,” (page 49) shows 
performance management tools available from the Preside Multiservice Data 
Manager Toolset. 

Figure 1
Toolset performance management tools

Figure 2, “Operator client toolset performance management tools,” (page 50) 
shows performance management tools available from the Operator client. 
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Figure 2
Operator client toolset performance management tools

Procedure steps

1 In the application main window, select Performance -> Data Viewer.

The Data Viewer window opens. The default is real-time mode and latest 
poll view.

2 In the Operator client window, select Performance -> Data Viewer from 
the menu.

The Data Viewer window opens. The default is real-time mode and latest 
poll view.

If running Toolset, see... If running Operator client, see...

step 1 step 2
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Starting the Data Viewer in real-time mode from within 
another fault management tool

Use this procedure to start the Data Viewer from the following fault 
management tools:

Procedure steps
1 From a fault management tool, open the Start Tools menu. For details, 

refer to the tool’s documentation. 

A pop-up menu opens.

2 From the pop-up menu, select Performance -> Data Viewer.

The Data Viewer window opens. 

If running Toolset If running Operator client

• Network Viewer

• Component Information Viewer

• Component Status Display

• Network Status Bar

• Alarm Display

• Passport Shelf View

• MPE Shelf View

• Passport Nodal Provisioning

• MPE Nodal Provisioning

• Network Browser 

• Component Information Viewer

• Alarm Display

• Passport Shelf View

• MPE Shelf View

• Passport Nodal Provisioning

• MPE Nodal Provisioning
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Starting other fault management tools from Data Viewer 
Use this procedure to start other fault management tools from Data Viewer 
using Start Tool. The following tools can be started from Data Viewer:

Procedure steps
1 From the Data Viewer tool, right click in the data panel area and select the 

Start Tool menu.

2 From the pop-up menu, select an FCAP label and the tool name.

The selected fault tool opens in a new window. 

If running Toolset If running Operator client

• Network Viewer

• Component Information Viewer

• Component Status Display

• Network Status Bar

• Alarm Display

• Passport Shelf View

• MPE Shelf View

• Passport Nodal Provisioning

• MPE Nodal Provisioning

• Network Browser 

• Component Information Viewer

• Alarm Display

• Passport Shelf View

• MPE Shelf View

• Passport Nodal Provisioning

• MPE Nodal Provisioning
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Starting the Data Viewer in replay mode
Use this procedure to start the Data Viewer in replay mode to analyze 
collected data at a later date 

Procedure steps

3 In the application main window, select Accounting -> Data Viewer.

The Data Viewer window opens. The default is replay mode and 
spreadsheet view.

4 In the Operator client window, select Performance -> Data Viewer from 
the menu.

The Data Viewer window opens in real-time mode.

5 In the Data Viewer window, select Options -> Replay Mode from the 
menu.

The Data Viewer switches to replay mode.

If running Toolset, see... If running Operator client, see...

step 1 steps 2 and 3
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Exiting the Data Viewer
Use this procedure to exit the Data Viewer. 

Procedure steps
1 From the File menu, select Exit

All open windows close and history for the session is discarded.
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Rearranging data display
Use this procedure to sort the values and change the order of the data 
columns. 

Instructions support both the Toolset and Operator client environments unless 
other wise indicated.

Data Viewer displays metric values in two locations:

• Data panel area in the lower half of the Data Viewer window

• Summary and detailed statistics tables for a specified statistic in the 
views area (real-time and replay modes)

Procedure steps
1 To change the order of the columns, select each column header and drag 

it to its new position.

2 To sort the values for a metric in ascending or descending order, click in 
the column header for the metric. 
Preside MDM Performance Management  User Guide   15.1



62   Chapter 5 Data Viewer basic procedures
Viewing summary and detailed performance information
Use this procedure to view detailed and summary information collected for 
each component. 

The information is displayed in the Graph window, in both table and graphic 
formats.

Instructions support both the Toolset and Operator client environments unless 
other wise indicated.

Procedure steps
1 In the data panel area, click in a component row. 

2 Click Graph.
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The Graph window opens. To monitor multiple components, launch 
multiple versions of the Graph window. See “Managing the graphical 
display” (page 59).

This sample screen displays detailed information about one component.

3 Click the Detail tab to view detailed information.

4 Click the Summary tab to view summary information.
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Changing the color assigned to a metric 
Use this procedure to change the color assigned to a metric. For more 
information on graphs see “Managing the graphical display” (page 59).

Instructions support both the Toolset and Operator client environments unless 
other wise indicated.

Procedure steps
1 In the data panel area, click in a component row. 

2 Click Graph.

The Graph window opens. 

3 From the graph selection table, click the color bar for the metric in the 
statistics table. 

The Pick a Color window appears. This window provides options and 
sample displays to allow selection or color mixing for the metric.

4 Choose a new color for the metric.

5 Click OK to set the color.

The new color appears in the Color column of the graph selection table 
and in any existing graphs in which the metric is used. 
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Managing the graphical display
Use this procedure to specify performance data to view in thumbnails, multi 
graphs or trend graphs, and in line or bar graph format. 

Instructions support both the Toolset and Operator client environments unless 
other wise indicated.

Procedure steps
1 In the Graph window, click the checkboxes in the graph selection table to 

select the metrics to graph.

The Data Viewer plots the data collected for the selected metrics and 
displays it in the graph area. Only the metrics selected in the graph 
selection table appear in the graph.

The color of each line or bar in the graph matches the color assigned to 
the metric in the detailed statistics table. The x axis of the graph shows 
the time each set of data was collected.

The endpoint of the graph line represents the latest performance data 
collected. The data and the graph are updated according to the polling 
interval selected in the Data Viewer window.

2 To view a different type of graph, do one of the following:

• Click the ThumbNails, the Multi Graphs or the Trend Graphs tab in 
the graph area.

• From the Options menu, select Line or Bar.

Note:  For thumbnail graphs, change the display by clicking the right 
mouse button on the Thumbnail graph. A context menu with Range 
setting (Default) or Range setting (Customized) is displayed. Click on the 
context menu and the Customize Display Range dialog opens. Change 
the minimum and maximum display values, and click OK.

3 To clear the graphs and display new data, deselect the graph box in the 
graph selection table.

Any graphs selected in the graph selection table are cleared.
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Removing files from the Files Selected area
Use this procedure to remove one or more files data files while working with 
collected data.

Instructions support both the Toolset and Operator client environments unless 
other wise indicated.

Prerequisites
The Data Viewer must be in replay mode.

Procedure steps
1 Select the file(s) to view from the Files Selected area.

2 Click Remove Selected.

3 The Files Selected area is refreshed without the removed files.
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Removing all files from the Files Selected area
Use this procedure to remove all files. 

Instructions support both the Toolset and Operator client environments unless 
other wise indicated.

Prerequisites
The Data Viewer must be in replay mode.

Procedure steps
1 From the Files Selected area, click Remove All.

The Files Selected area is refreshed without any file names being 
displayed.
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Data Viewer window

This section contains descriptions for all the main components in the Data 
Viewer windows for real-time mode and replay mode.

Navigation
• “Data Viewer window for real-time mode” (page 69). 

• “Dialog boxes” (page 77).

• “Data Viewer window for replay mode” (page 78).

• “Applicable to real-time and replay modes” (page 83).

• “Graph window” (page 83). 

Data Viewer window for real-time mode
The Data Viewer window for real-time mode is described in this section. 
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Data Viewer window - Real-time mode in latest poll view

Navigation
• “Splitter bar” (page 71)

• “Menu bar” (page 71)

• “Polling criteria area” (page 73)

• “Metric selection area” (page 75) 

• “Command buttons” (page 75) 

• “Status line” (page 76)

polling 
criteria 
area

metric 
selection 
area

menu bar

splitter bar

data 
panel 
area

status 
line

graph button
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• “Graph button” (page 77) 

• “Dialog boxes” (page 77)

Splitter bar
A splitter bar between the metric selection area and the data panel area divides 
the Data Viewer window into two adjustable window panes. The window 
panes adjusts to hide or show each area, or to have one area fill the entire Data 
Viewer display. 

To change the relative size of each window pane, click and drag the mouse 
over one of the window pane movement arrows.

Menu bar
The menu bar organizes commands into the following menus:

File menu
The File menu contains the following commands:

“File menu” (page 71) Provides a command to exit the Data Viewer tool. 
“Options menu” (page 72) Controls operating modes and RDF selection.
“View menu” (page 72) Controls the display of the following views: 

Spreadsheet View, Record View, Component 
View, and Latest Poll View.

“Help menu” (page 73) Provides access to online help.

Connect To Server Connects to the server to start a polling session. 
A message in the Status line displays connection 
status information. 

Start Recording Writes statistical data, including baseline-delta 
statistics, to the Data Viewer Saved Statistics file. 
Provides the option to overwrite an existing Data 
Viewer Saved Statistics file or start a new file with 
a new name. The file is placed in the home 
directory, unless an absolute pathname is 
specified. 
This command has the following options:

->Record All Available 
Data 

Writes to the Data Viewer Saved Statistics file all 
the metric data that the Data Viewer has collected 
since start-up. 
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Options menu 
The Options menu contains the following commands: 

View menu
The View menu contains a list of data views. The selected view is displayed 
in the data panel area. Select one view at a time. When a view is selected, its 
menu option is disabled. 

The View menu contains the following commands:

->Record Starting Now Writes the metric data that the Data Viewer 
collects during the next and subsequent polling 
intervals.

Stop Recording Stops output to the Data Viewer Saved Statistics 
file and saves and closes the file. 

The null value makes a break point on the graph 
to make a pause and resume more visible. In the 
data record file, the null values appear as empty 
between the delimiter. Reset all baseline values 
collected from the first poll taken by clicking 
Continue.

View Recording Displays the View File window. From the window, 
select a file to view. View baseline delta statistics 
also. By selecting the file that is currently open, 
new data is written to the file as it is received. 

Load File opens the selected Data Viewer Saved 
Statistics file and writes it to the screen.

Exit closes the Data Viewer Saved Statistics file.
Exit Terminates the polling session and closes all Data 

Viewer windows. 

Replay Mode Retrieves collected data. When this option is 
selected, Replay Mode is enabled and Real-Time 
Mode is disabled. 

Real-Time Mode Collects and displays real-time statistical data 
from different devices. 

Spreadsheet View Sets the data displayed in the data panel area to 
Spreadsheet View

Record View sets the data displayed in the data panel area to 
Record View
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Note: The views are described in the section, “Views” (page 95).

Help menu
The Help menu contains the following commands:

Polling criteria area
In the polling criteria area in the Data Viewer window, specify the device and 
associated component(s) from which to gather information, and the polling 
interval.

The polling criteria area contains six fields: 

• Device Type specifies the device type to monitor. When there is only one 
device type in the list, this device is selected automatically when Data 
Viewer starts in Real-time mode, or when switched from Replay mode to 
Real-time mode.

• Device Name lists device names for the device type. Enter the device 
name or select an item from the menu. If the device type for Passport is 
selected, the Authenticate dialog prompts for the group, use name and 
password. 

• Component specifies the component(s) to monitor. The Component 
field contains a list of the component types that are defined in the metric 
file. Select one component to monitor for MPE_9500, or one or more 
components to monitor for a Passport. 

Component View Sets the data displayed in the data panel area to 
Component View.

Latest Poll View Sets the data displayed in the data panel area to 
Latest Poll View

Help On Window Provides descriptive help information about a 
window.

What’s This? Displays information about a selected area of the 
window. 
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• Max Components specifies the maximum number of components to 
monitor. The default value for this field is 100. Network traffic is 
impacted if the maximum component number is too large. Enter a 
number in this field when selecting multiple components using either the 
wildcard (*) or a range of component numbers. 

This attribute does not apply to MPE devices.

No Max Component value is necessary when selecting a single 
component instance, or multiple component instance with a semi colon 
as the separator. If the Max Component value is specified, it does not 
have any impact on the number of components returned. 

• Polling interval (Secs) specifies the polling interval (in seconds) for data 
collection. The polling interval has a range of 30 seconds to 600 seconds 
for Simple Network Management Protocol (SNMP) devices. The default 
value is 60 seconds. For Passport devices, the polling interval has a range 
of 10 seconds to 600 seconds. For MPE_9500 devices, the polling 
interval range is 5 seconds to 600 seconds. The default for both Passport 
and MPE_9500 devices is 60 seconds. If the polling interval is not within 
the range, the Information dialog opens and displays the acceptable 
range.

Note: The polling interval is a target value; depending on network speed, 
some data collection may take longer. The polling interval also impacts 
the traffic of the network. A small polling interval can flood the network 
with too much traffic and impact network performance. A polling 
interval of less than 30 seconds is not recommended. 

Note: Follow the recommendation below when deciding what polling 
interval to use and how many attributes to poll to facilitate optimum 
network performance:

Note: number of metrics X number of components / polling interval in 
seconds < 1.7 
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• Number of Polls specifies the number of polls to execute during the 
polling session. If a number is entered in the field, polling stops when this 
number is reached. If a number is not entered, polling continues until the 
tool stops, polling pauses or stops, or monitoring starts on another 
component.

Metric selection area
Use the Metric Selection area in the Data Viewer window to specify the 
metrics to poll. This area contains the following fields and buttons:

• Available Metrics lists the metrics that are defined for the component 
but are not selected for polling. Select any or all of the metrics from this 
list for polling. Right-click a metric to display a description of the metric.

• Selected Metrics lists the metrics that are selected for polling. Remove 
any metric from this list by clicking the metric name, and then clicking 
the left arrow. Right-click a metric to display a description of the metric.

• Use Select All to select all available metrics to be polled. The metrics are 
moved from the Available Metrics list to the Selected Metrics list. This 
option is grayed out if there are no metrics in the Available Metrics 
section. 

• Use Select to select a specific metric to be polled. The metric is moved 
from the Available Metrics list to the Selected Metrics list. This option 
is grayed out if no metrics are selected in the Available Metrics section. 

• Use Remove to remove a specific metric to be polled. The metric is 
moved from the Selected Metrics list to the Available Metrics list. The 
Remove option is grayed out if no metrics are selected from the 
Available Metrics section. 

• Use Remove All to remove all metrics to be polled. The metrics are 
moved from the Selected Metrics list to the Available Metrics list. This 
option is grayed out if there are no metrics in the Selected Metrics 
section. 

Command buttons
The command buttons in the Data Viewer window control component 
searches and polling session. The following buttons are available: 
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Status line 
The status line appears at the bottom of the Data Viewer window. The status 
line displays messages about the connection process. For example, the 
message “Waiting for server response” is displayed during a connection 
attempt to a component. 

Search Allows the user to find a specific node by 
searching with the help of filters and pattern 
matching. The user can specify criteria, such as 
the node name starting characters to search all 
the nodes that contain the pattern. The user may 
also specify the maximum number of matches to 
display. 

Accept Allows the user to accept the component being 
polled. Displays the Input dialog for the MPE 9500 
component and all available metrics.

Start Applies the settings in the polling criteria and 
metric selection areas and launches a new polling 
session. All statistical data from previous polling 
sessions are discarded. 

Pause Suspends the current polling session. Statistical 
data collected to this point remain in the data 
panel area.

Continue Resumes the polling session. All subsequent 
statistical data are added to the data panel area. 
When polling is resumed after a pause, all metric 
values will be reset to null for the first poll after 
resuming. The null value makes a break point on 
the graph to make a pause and resume more 
visible. In the data record file, the null values 
appear as empty between the delimiter. All 
baseline values are reset to the value collected 
from the first poll taken clicking Continue.

Stop Ends the polling for the current settings. To restart 
polling using the same settings, click Start.

Reset Baseline Resets the value of all baseline delta metrics. No 
other metric will be affected by this reset and all 
previous data (gathered before the reset) will be 
maintained and can be viewed and saved. This 
button is only enabled when baseline delta 
metrics are being measured during active polling.
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On a first attempt to establish a connection to a network component, there is 
a delay until a response is received from the server. During this delay, the 
status line at the bottom of the Data Viewer window displays the status of the 
connection.

The status line is dived into three fields. The left-most message field contains 
a description of the last command that was executed. The middle field which 
is the last baseline reset time field displays the last time the card or shelf was 
reset if this information is available. The right-most hostname field displays 
the nodename to which it is connected. If service selection is made from the 
Data Viewer window, it will be reflected in the next opened application.

Graph button
Click the Graph button to open the Graph window. See “Graph window” 
(page 83).

The Graph button is enabled for all views in real time mode. It is enabled for 
some files in replay mode in any of the four views. These files include DV 
collected record, Management Data Provider (MDP) collected statistics, 
Statistics Retrieval System (SRS) and Streamed Passport Statistics (PMSP) 
files. 

Dialog boxes
There are three dialog boxes, one related to authentication, one related to 
input required to collect MPE statistics, and a third that provides information 
related to the polling interval.

Navigation
• “Input Request dialog” (page 77)

• “Information dialog” (page 78)

• “View File dialog” (page 78)

• Authentication dialog, see 241-6001-122 Preside MDM SNMP MDM 
Toolset and Operator Client Basic Operations

Input Request dialog
The Input Request dialog opens and allows the user to specify the metric 
index for the component.
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See the figure “Input Request dialog” (page 78).

Input Request dialog

Information dialog 
The Information dialog displays the acceptable polling interval range.

View File dialog 
The View File dialog displays a list of files that collected metrics are written 
to. From the list, select the file that is currently open. View new data as it is 
written to the file. 

Data Viewer window for replay mode
The Data Viewer window for replay mode is described in this section. 

Community String Specifies the community string in use, or where 
multiple community strings exist, allows the user 
to specify one.

Interface Number Allows the user to specify the SNMP index 
number

OK Sets all the specified values, initiates a polling 
request and displays all available metrics for the 
specified component in the main window.

Cancel Closes the Input dialog. All information in the 
dialog is ignored. 

Help Displays help on the Input dialog.
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Data Viewer window - Replay mode in spreadsheet view

Navigation
• “Menu bar” (page 80)

• “File menu” (page 80)

• “Options menu” (page 80)

• “View menu” (page 80)

• “Help menu” (page 81)

file 
retrieval
criteria 
area

files 
selected 
area

menu bar

splitter bar

data 
panel 
area

status 
line

graph button
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• “File retrieval criteria area” (page 81)

• “Files selected area” (page 82)

Menu bar
Use the Data Viewer to view performance information through the menu bar 
commands. The menu bar contains the following menus:

File menu
The File menu contains the following command:

Options menu 
The Options menu contains the following commands: 

View menu
The View menu contains a list of data views. The selected view opens in the 
data panel area. Select one view at a time. When a view is selected, its menu 
option is disabled. 

“File menu” (page 80) Provides commands related to files and a means 
to exit the Data Viewer tool. 

“Options menu” (page 80) Controls display of menu bars, icons bars, node 
labels, background maps, and legends. Also sets 
preferences and filters. 

“View menu” (page 80) Control which nodes are shown in the network 
display area. Network model navigation and 
background zooming can also be performed with 
these commands. 

“Help menu” (page 81) Gives access to online help.

Exit Terminates the polling session and closes all Data 
Viewer windows. 

Real-Time Mode Sets the collection mode to real time. When this 
option is selected, Real-Time Mode is enabled 
and Replay Mode is disabled.

Select RDF Displays a dialog to select an RDF file. The 
specified RDF file is used to view the selected 
Bulk Data Format (BDF) files in replay mode.

Unselect RDF clears the selected RDF file when this menu item 
is selected
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The View menu contains the following commands:

Note: The views are described in the section, “Views” (page 95).

Help menu
The Help menu contains the following commands:

File retrieval criteria area
Use the file retrieval criteria to select files to replay. The file retrieval criteria 
area consists of the following input areas:

Note: The maximum file size that can be retrieved is 10 Mega bytes.

• Select the Data Type pull-down list for the following data types: 
Accounting, Alarm, All, Availability, Data Viewer Saved Statistics, 
Log, Outage, Statistics Retrieval System, Scn, Statistics, Streamed 
Passport Statistics. The default is All for all data types.

• Select the Device Type pull-down list to filter on specific device types: 
All, DPN, Others, Passport, MPE. The default is All for all device 
types.

• Use Device Name to enter a device name to filter on. This field matches 
the following field of filename field depending on the selected data type:

— specify <nodename | nodeid> for Accounting, Alarm, Scn, Log, 
Statistics and Outage data types

— device name has no impact on Availability type

Spreadsheet View Sets the data displayed in the data panel area to 
Spreadsheet View

Record View Sets the data displayed in the data panel area to 
Record View

Component View Sets the data displayed in the data panel area to 
Component View. 

Help On Window Provides descriptive help information about a 
window.

What’s This? Displays information about a selected area of the 
window. 
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— specify <nodename> for SRS and Data Viewer Saved Statistics data 
types

— specify <Passport-groupname> in Streamed Passport statistics data 
type

• Use Start Date to specify a range of the start date (yyyy/mm/dd) and 
time (hh:mm:ss) of the filename to be filtered. Any files with the start 
date and time larger than the Start Date are selected.

• Use End Date to specify a range of the end date (yyyy/mm/dd) and time 
(hh:mm:ss) of the filename to be filtered. Any files with the end date and 
time smaller than the End Date are selected.

• Use Retrieve Files to open the File Selection dialog. This dialog is a tree 
representation of the available directories and files for the selected type. 
Navigate the file system to locate files for the selected data type. The 
default directory for the selected Device Type is displayed. The default 
directory varies depending on the Device Type selected.

Files selected area
The files selected area displays a listing of retrieved files. The files are 
displayed in tabular format. Click and drag a column heading to reorder the 
columns.

This area consists of the following areas:

• File Names displays the name of the files selected for possible viewing.

• Path displays the directory location of the selected BDF files.

• File Size in Bytes displays the size of each selected BDF file. The 
maximum size is 10 Mega bytes.

• Remove Selected removes the selected file from the Files Selected area.

• Remove All removes all files from the Files Selected area.

• View lists the selected files in the specified view.
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Applicable to real-time and replay modes
This section contains information that applies to both real-time mode and 
replay mode. See the following information:

• “Data panel area” (page 83)

• “Graph window” (page 83)

Data panel area
The data panel area displays one of the following views:

• spreadsheet

• record

• component

• latest poll

The information displayed in the views is displayed in the following columns:

1 Record # contains the record number. This column is visible in 
spreadsheet view and record view. 

2 Index/Component is visible in real-time mode. The Index/Component 
column contains either the Passport name, or the Simple Network 
Management Protocol (SNMP) indexID of the component(s) for SNMP 
devices and MPE_9500, and the component under monitor. 

Note: The Index/Component is visible in the spreadsheet, record and 
latest poll view in real-time mode. In component view, the component is 
shown in a tree diagram.

File name is visible in replay mode. This column contains the location 
and the name of the file.

3 Time is visible in real-time mode. This column contains the time the 
metrics were received.

4 The remaining columns contain metric values or data from replayed files.

Graph window
The Graph window contains summary and detailed statistics tables. 
Selecting the Detail or Summary tab displays the appropriate table.
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See the figures “Graph window: Summary panel” (page 85) and “Graph 
window: Detail panel” (page 86) for sample displays.

Navigation
• “Splitter bar” (page 84)

• “Title bar” (page 87)

• “Menu bar” (page 87)

• “Statistics tables” (page 88)

• “Graph area” (page 89)

• “Graph selection table” (page 89)

Splitter bar
A splitter bar separates the summary or detail statistics display into two 
adjustable window panes. Click the mouse on one of the arrows in the splitter 
bar to configure window pane size. Adjust the window panes to hide or show 
each area or to have one area fill the entire Data Viewer display. Another 
splitter bar separates the graph and graph selection table.
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Figure 3
Graph window: Summary panel
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Figure 4
Graph window: Detail panel
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Title bar
The title bar in the Graph window identifies the component to which the data 
applies. The title bar displays the full component name, including the device 
type and name.

Menu bar
The menu bar in the Graph window contains the following menus:

File menu
The File menu in the Graph window contains the following commands:

Options menu
The Options menu in the Graph window contains the following commands:

Help menu
The Help menu in the Graph window contains the following commands:

“File menu” (page 87) Provides commands related to files and a means 
to exit the Data Viewer tool. 

“Options menu” (page 87) Controls display of menu bars, icons bars, node 
labels, background maps, and legends. Also sets 
preferences and filters. 

“Help menu” (page 87) Permits access to online help.

Close Closes the Graph window. 

Line Changes thumbnail, multi graphs, and trend 
graphs to line graphs 

Bar Changes thumbnail, multi graphs and trend 
graphs to bar graphs 

Help On Window Provides descriptive help information about a 
window.

What’s This? Displays information about a selected area of the 
window. 
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Statistics tables
The statistics table appears in the upper half of the Graph window. The table 
displays the values for each record in the record file. The table displays metric 
values for each of the metrics polled for a particular component. New data is 
added to the statistics tables as it is received. The data appear in red if the 
values exceed the thresholds defined in the metric file for the component. 
Display summary statistics or detailed statistics by selecting the appropriate 
tab.

Summary statistics
Numeric type values are displayed in the summary statistics table. Summary 
statistics are available through the Summary tab. The Summary tab contains 
the following information:

• Field contains the names of the metrics.

• Minimum contains the minimum value of the statistic data collected for 
each of the metrics.

• Maximum contains the maximum value of the statistic data collected for 
each of the metrics.

• Average contains the average value of the statistic data collected for each 
of the metrics.

Detailed statistics
Numeric and string type values are displayed in the detailed statistics table. 

Detailed statistics are available through the Detail tab. The detailed statistics 
table provides statistic data (numeric type or string) collected for each of the 
metrics polled for a particular component. 

The detailed statistics table contains

• a record received for the component at different polling intervals (real-
time mode)

• a record in a file associated with the selected component (replay mode)

• the name of each field that is being is displayed in each column. Change 
the order of the columns by dragging each header to its new location. 
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Note: The number of Graph windows opened and the number of graphs 
running also impacts the memory usage.

Graph area
The graph area appears in the lower half of the Graph window. The graph 
area displays metric field values for a particular component in graphical 
format. Only the selected metric fields appear in the graph. The line displayed 
in the graph for each metric field matches the color defined in the graph 
selection table. 

Three types of graphs are available: thumbnail, multi graphs, and trend 
graphs. Select a graph type by clicking the appropriate tab in the graph area. 

The multi graph shows an absolute graph. The X axis shows the time value. 
If there is not enough space, not all the time values are displayed in the trend 
and multi graph panels. Use the horizontal scroll bar to view the other time 
values. The Y axis shows the field value. 

The trend graph is a percentage relative scale with the Y axis showing the 
field value relative to the maximum. The comparison is with the instance field 
value to the maximum value on this field that has occurred during the time 
captured in the trend graph. The X axis shows the time stamps when the field 
values are polled

Graph selection table
Only statistics metrics with numeric type are displayed in the graph selection 
table. The graph selection table contains the following columns:

• Graph contains a list metric fields for graphical display. Only the 
selected metric fields in this table appear in the graph. The checkboxes 
can reduce or filter the metric fields to be shown on the graphs. For more 
information on the graphical display, see “Graph area” (page 89).

• Color contains the color of the graph associated with a metric fields. A 
default color is assigned to each metric. Change the color by clicking in 
the “Color” column for the metric. This launches the “Pick a Color” 
window. 

• Field contains the name of the metric fields.
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Chapter 7
Data Viewer fundamentals

The Data Viewer tool is a Preside Multiservice Data Manager diagnostic tool 
that collects, and displays performance information in real-time mode and 
replay mode for analysis. 

This chapter includes information specific to real-time mode, replay mode, 
and to both modes. See the following sections for more information:

• “Real time mode” (page 92). See “Menu bar” (page 71) for more 
information on the menu items specific to real time mode.

• “Replay mode” (page 94). See “Menu bar” (page 80) for more 
information on the menu items specific to replay mode.

• “Views” (page 95). 

• “Graphic display” (page 102)

Data Viewer capabilities
The Data Viewer has the following capabilities:

• The Data Viewer supports the following modes:

— real-time mode

— replay mode

• The Data Viewer supports the following views:

— spreadsheet view 

— record view
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— component view 
This view supports all device types in real-time mode. In replay 
mode, this view supports Statistical Retrieval System (SRS), 
Streamed Passport Statistics (PMSP), Data Viewer Saved Statistics, 
and Management Data Provider statistics.

— latest poll view (real-time mode only)

Note: The Performance Measurement Stream Processor (PMSP) server 
is used only in a Succession Network solution.

• The Data Viewer supports the following graphic displays:

— thumbnail graphs 

— multi graphs

— trend graphs 

Real time mode
Note: This section applies to real-time mode. See the following sections: 
“Replay mode” (page 94), and “Views” (page 95).

Data from Passport, MPE 9500, and Simple Network Management Protocol 
(SNMP) devices is collected in real-time mode. Use the Data Viewer to do 
the following tasks:

• help trace faults in the network 

• collect information about network load

• generate statistics for reporting and analytical purposes

The Data Viewer collects attributes for Passport, MPE 9500, and SNMP 
devices and uses the attributes to derive more meaningful metric values. The 
Data Viewer also supports 64-bit counters for Passport, MPE 9500, and 
SNMP devices.

Passport and MPE 9500 network components use the Generic Prober (GP) 
server to collect performance information. This tool also provides a metric 
file that contains a list of available metrics for each Passport, MPE 9500, and 
SNMP component. A metric file is a text file that is written in XML format. 
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The contents of a metric file depends on the MPE 9500, Passport, or SNMP 
device type to which the file applies. One metric file is required for each MPE 
9500, Passport, or SNMP device type. 

The metric names appear in the Data Viewer window when a component is 
selected to monitor. Metrics are chosen for display for each component, 
during each polling session. The metric values display in both tabular and 
graphical formats. Metrics and components can be added to the metric file as 
required. 

Note: If the service selected in “Network Access” is changed after the 
Data Viewer starts when using Operator client, the Data Viewer client is 
not notified and there is no impact on the connection to the existing Data 
Viewer server host. Data Viewer must be launched after a service 
selection change to connect to the new host name specified in the service 
selection.

Metric files are customized by adding metrics and components as required. To 
customize a metric file, use a standard UNIX text editor, follow the format in 
the file and provide accurate and complete information. For information on 
the elements of a metric file and the format in which they must be used, see 
“Metric file format” (page 307).

Working with Data Viewer Saved Statistics files
The Data Viewer may be configured to write the information it collects in 
real-time mode to a Data Viewer Saved Statistics file and to save it for future 
reference. The Data Viewer Saved Statistics file is updated as new data is 
received. 

The Data Viewer Saved Statistics file is saved in the home directory, unless 
an alternate path is specified. Change the default directory by double clicking 
on the directory name. It is recommended that you use the default saved 
statistics file name because it has been set up for saved statistic files filtering 
in replay mode. 

Note: Saved statistic files filtering in replay mode may not work properly 
if the default file name is changed.
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The information of a Data Viewer Saved Statistics file matches the 
information entered in the polling criteria and metric selection areas of the 
Data Viewer window. 

The figure “Data Viewer Saved Statistics file” (page 94), shows an example 
of this file.

Figure 5
Data Viewer Saved Statistics file

Replay mode
Note: This section applies to replay time mode. See the following 
sections: “Real time mode” (page 92), and “Views” (page 95).

In replay mode, view collected data from

• Performance Measurement Stream Processor (PMSP)

• Management Data Provider (MDP)

• Statistical Retrieval System (SRS)

• Data Viewer 

Note: This document does not contain information on PMSP, MDP or 
SRS. See 241-6001-309 Preside MDM Management Data Provider User 
Guide.
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Views
This section contains information that applies to both real-time mode and 
replay mode. 

The data panel area displays one of the following views:

• spreadsheet

• record

• component

• latest poll

The data panel area in the Data Viewer window in real-time mode displays 
the metric values collected during the current polling session, and the 
retrieved data files in replay mode. 

In real-time mode, the maximum number of records that may be collected in 
real time is 50,000/(number of metrics polled + 2). When this number is 
reached, the oldest set of data records is discarded and replaced by the latest 
set of data records received. 

The data appear in red if the values exceed the thresholds defined in the metric 
file for the component.

Spreadsheet view
The spreadsheet view displays the data values in spreadsheet tabular format. 
Spreadsheet view supports real-time mode and replay mode. Spreadsheet 
view is the default view in replay mode if the data type is Accounting, 
Alarm, SCN, Log or Outage.

Spreadsheet view uses a record description file (RDF) to label each column if 
the data is in bulk data format (BDF).The data in the first row of a comma 
separated value (CSV) file is used to label each column if the data is in CSV 
format. 

Select a row then click Graph to display the detailed statistics table and the 
summary table. Display summary or detailed statistics by selecting a tab.

Note: The field names are described in “Data panel area” (page 83).
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See the following figures:

• “Real-time - Spreadsheet view” (page 96) shows the Data Viewer 
window in real-time mode and spreadsheet view.

• “Replay - Spreadsheet view” (page 97) shows the Data Viewer window 
in replay mode and spreadsheet view.

Figure 6
Real-time - Spreadsheet view
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Figure 7
Replay - Spreadsheet view

Record view
The record view supports all device types in real-time mode and all data types 
in replay mode.The record view shows the field name and the field value. 
Selecting the record number displays the content of the record at the right.

Select a record number then click Graph to view the detailed statistics table 
and the summary table of the component instance specified in the selected 
record. Display summary or detailed statistics by selecting a tab.

Note: The field names are described in “Data panel area” (page 83).

data 
panel 
area
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See the following figures:

• “Real-time - Record view” (page 98) shows the Data Viewer window in 
real-time mode and record view. 

• “Replay - Record view” (page 99) shows the Data Viewer window in 
replay mode and record view.

Figure 8
Real-time - Record view

data 
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area
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Figure 9
Replay - Record view

Component view
The component view supports all device types in real-time mode. In replay 
mode, the component view supports the data types: SRS, Streamed Passport 
Statistics, Data Viewer Saved Statistics, and Management Data Provider 
statistics. 

The panel displays the components and subcomponents in the data collected 
in real-time collection mode or the selected files in replay mode. The 
component information is displayed in a tree format. Select a component in 
the component tree to view the records associated with the component in 

data 
panel 
area
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detail and summary tables. Click Graph to view the Graph window 
associated with the selected component. Display summary or detailed 
statistics by selecting a tab. 

Note: The field names are described in “Data panel area” (page 83).

See the following figures:

• “Real-time - Component view” (page 100)

• “Replay - Component view” (page 101) 

Figure 10
Real-time - Component view
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Figure 11
Replay - Component view

Latest poll view
The latest poll view supports real-time mode only. The latest poll view is the 
default view for real-time collection mode. Latest Poll View displays the 
metric values from the latest poll during the current polling session. Each row 
of data in the latest poll view applies to a different component instance. Select 
a row then click Graph to view detailed statistics table and the summary 
table. Display summary or detailed statistics by selecting a tab. 

Note: The field names are described in “Data panel area” (page 83).

The figure “Real-time - Latest poll view” (page 102) shows the Data Viewer 
window in real-time mode and latest poll view. 
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Figure 12
Real-time - Latest poll view

Graphic display
The graph area appears in the lower half of the Graph window. The graph 
area displays metric field values for a particular component in graphical 
format. Only the selected metric fields appear in the graph. The line displayed 
in the graph for each metric field matches the selected color in the graph 
selection table. 
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metric 
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Three types of graphs are available: thumbnail, multi graphs, and trend 
graphs. Select a graph type by clicking the appropriate tab in the graph area. 
From the Options menu, change thumbnail, multi graphs, and trend graphs to 
a line graph or a bar graph by selecting the Line or Bar command. Different 
metrics are displayed on the graphs with different colors. The color of the line 
representing the metric in the graph is determined by the color of the metric 
defined in the graph selection table.

New data is added to the graph as it arrives in real-time mode.

See the figures “Graph window showing thumbnail graphs” (page 104), 
“Graph window showing multi graphs” (page 105), and “Graph window 
showing trend graphs” (page 106).
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Figure 13
Graph window showing thumbnail graphs

The multi graph shows an absolute graph. The X axis shows the time value. 
If there is not enough space, not all the time values are displayed in the trend 
and multi graph panels. Use the horizontal scroll bar to view the other time 
values. The Y axis shows the field value. 
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Figure 14
Graph window showing multi graphs

The trend graph is a percentage relative scale with the Y axis showing the 
field value relative to the maximum. The comparison is with the instance field 
value to the maximum value on this field that has occurred during the time 
captured in the trend graph. The X axis shows the time stamps when the field 
values are polled
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Figure 15
Graph window showing trend graphs
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Chapter 8
DPN Performance Viewer

This section describes the DPN Performance Viewer and provides 
instructions on how to use this tool. The following information is included:

• “DPN Performance Viewer overview” (page 107)

• “Performance Viewer window” (page 108)

• “DPN Performance Viewer dialogs” (page 113)

• “DPN Performance Viewer Procedures” (page 120)

• “Customizing DPN Performance Viewer default settings” (page 126)

• “Understanding DPN Performance Viewer log files” (page 127)

DPN Performance Viewer overview
The DPN Performance Viewer (Performance Viewer) collects and displays 
performance information about DPN network components. Use the DPN 
Performance Viewer tool to

• help trace faults in the network 

• collect information about network load 

• generate statistics for reporting and analytical purposes

The DPN Performance Viewer collects statistics on the status of components 
called metrics. Select the metrics to view, choosing a text or graphic format. 
Component information is obtained in real-time over short periods. The 
display varies according to the type of components under monitor. Write 
collected information to an ASCII log file for later analysis or processing. 
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The DPN Performance Viewer collects attributes from DPN network 
components using the General Management Data Router (GMDR) server. 
The DPN Performance Viewer uses these attributes to derive more 
meaningful metric values. These values are displayed as a history in a 
graphical format.

For DPN metric details, see “DPN-100 metrics” (page 301).

For additional information on the DPN Performance Viewer, see

• “Performance Viewer window” (page 108)

• “DPN Performance Viewer dialogs” (page 113)

• “Keyboard shortcuts” (page 113)

• “Starting the DPN Performance Viewer” (page 120)

• “Displaying component information” (page 121)

• “Controlling the graphic display” (page 123)

Performance Viewer window
The Performance Viewer window contains three or four areas, depending on 
which component is being viewed. Except for the Menu Bar area, which is 
always visible, the other areas are separated by “window panes”. Configure 
the relative size of each area by clicking and dragging the mouse over one of 
the window pane movement boxes. One area can fill the entire DPN 
Performance Viewer display.

See the figure “Performance Viewer window” (page 109) to view a sample 
Performance View window.
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Figure 16
Performance Viewer window

On the first attempt to establish a connection to a network component, or 
subsequently use the Change Parameters command, there is a delay until a 
response is received from the GMDR. During this delay, the status line just 
below the menu bar displays a message, and the shape of the cursor turns into 
that of a clock. When a response is received, either as performance data or 
some kind of connection error, the status line turns blank and the cursor 
returns to its normal shape. A delay of about one minute occurs when the 
GMDR first connects to DPN networks. 

See the following information:

• “File menu” (page 110)

• “Options menu” (page 111)

• “Help menu” (page 111)

• “Status message area” (page 112)

menu bar

status 
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• “Shelf display area” (page 112)

• “History display area” (page 112)

• “Metric list area” (page 112)

File menu
The File menu contains commands for files, for the application as a whole, 
and for exiting the DPN Performance Viewer tool. The available commands 
include: 

• Log to File opens a dialog that prompts for a file name to save the 
complete visible metric history. If that filename already exists, it is 
overwritten. Note the following: 

— The file is placed in the home directory, unless an absolute pathname 
is specified. 

— The file is updated every time more data is collected until the user 
selects the Stop Log menu option, exits the DPN Performance 
Viewer, or changes to a different component. 

— The DPN Performance Viewer always provides a graphic display, 
whether or not output is simultaneously recorded in a specified file. 

— Although users can view it in text form, a file is normally processed 
by other applications (custom and future tools). 

— The Log to File command is only available when no log is currently 
running. 

• Stop Log stops output to the file and closes it. 

• Use View Log File to view an ASCII file in a text window. The last 
known log file name is used as a default file name, which the user can 
change this after the PV Log File Name dialog opens. If the current log 
file is being viewed, new logs are written to it as they are received. The 
text window is actually an xtail command. It contains a file name field 
near the top of the window that can be changed to a different file name 
View the file by clicking Show. The Pause button freezes output to the 
xtail session until toggled off. 

• Use Exit to close the DPN Performance Viewer. All windows associated 
with the session close except for any xtail sessions started using the View 
Log File command. 
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Options menu
Use the Options menu commands to customize the DPN Performance 
Viewer session. 

• Change Parameters opens the Performance Viewer Setup dialog. Use 
this setup dialog to change the refresh interval for retrieving metrics and 
to change the component being monitored. 

For a changed refresh interval, the DPN Performance Viewer remaps the 
metric history based on the new refresh interval. For a larger refresh 
interval, the older graph history appears squeezed; for a smaller refresh 
interval, the older graph history appears stretched. 

Changing the refresh interval does not affect the log file. However, 
changing the component stops the log file and creates a new graph.

• Use the Reset History Graph command to work with a list of multiple 
components in the Performance Viewer window. This command 
toggles the reset function of the graph on or off. As a result, one of the 
following commands is available:

— Reset History Graph On resets the graph to the initial data 
collection time whenever another component is selected from the 
list. 

— Reset History Graph Off retains the current position of the graph 
whenever another component is selected from the list.

— The active behavior of the graph is always opposite to the choice that 
is visible in the Options menu.

Help menu
The Help menu provides the following options:

• What’s This? provides help information about an object in the window. 
Contains help information on a specific object in the window. When 
selected, the cursor changes to a question mark. Place the cursor 
anywhere on the window and click; the online help window opens with 
information on that feature. when no particular object is selected, general 
help for the application opens. 

• Help on Help contains information about how to use the help facility. 
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• Help on Window provides descriptive help information about a 
window. 

• Help on Keys provides help information about keyboard shortcuts. 

Status message area
The Status Message Area displays messages. For example, the message 
“Waiting for server response” is displayed during a connection attempt to a 
component. 

When no warning message is being displayed, the Status Message Area 
shows which component is currently selected for viewing. 

Shelf display area
The Shelf Display Area displays a list of DPN components. This list displays 
the name of the sub-components (omitting the module name) and the key 
metrics collected. View all the metrics in the history and metric list areas.

To select a component for viewing in the history and metric area, click the 
component in the list, or click the button below one of the cards or logical 
processors. 

A DPN component displayed in orange means that it is out of service. 

History display area
The History Display Area displays the history of metric values for a particular 
component using line graphs. Use the scroll bar at the bottom of the graph to 
scroll through the complete history of the current DPN Performance Viewer 
session. Move the History Line to see values for specific times in the graph. 
First, put the cursor in the History Display Area. Left click the mouse to move 
the History Line to the current cursor position. Use the left and right arrow 
keys to move the History Line in increments of one data point. 

Metric list area
Use the Metric List Area to toggle particular metric displays on or off. It also 
gives information about the metric value, its value at a particular time in 
history (corresponding to the vertical white bar in the History Display Area), 
and its minimum and maximum possible values. Shaded buttons cannot be 
selected for display. 
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Note: For some metrics, notably the “packets per second” types, the 
maximum value may increase depending on the history. This allows 
trunks of different speeds to be monitored in a meaningful way. 

Clicking the HiWater button in the metric list area changes the history 
marker to that metric's high-water point. For information on the metrics, see 
“Customizing DPN Performance Viewer default settings” (page 126).

Keyboard shortcuts
The DPN Performance Viewer provides the following keyboard shortcuts: 

• Ctrl+L invokes Log to File

• Ctrl+S invokes Stop Log

• Ctrl+V invokes View Log File

• Ctrl+E invokes Exit

• Ctrl+C invokes Change Parameters

DPN Performance Viewer dialogs
The DPN Performance Viewer provides the following dialogs:

• “Performance Viewer Setup dialog” (page 113)

• “PV Log File Name Entry dialog” (page 116)

•  “Warning and error dialogs” (page 117)

Some DPN Performance Viewer dialogs have default action buttons. They 
are visually distinguished by an extra box around them. Press the Return key 
anywhere in the dialog to activate the default button. 

Performance Viewer Setup dialog
Use the Performance Viewer Setup dialog to specify the performance 
information to display. This dialog appears on starting the DPN Performance 
Viewer for the first time, or when changing components or probing interval. 
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The following items appear in the dialog: 

• Refresh Interval (seconds) sets the refresh interval (in seconds) used to 
gather data. The refresh interval has a default value of 300 seconds. Use 
the slide bar or click to the left or right of the bar for more refined tuning. 
The refresh interval is a target value; depending on network speed, some 
data collection may take longer. The selectable range of the refresh 
interval is from 60 seconds to 600 seconds (10 minutes) for DPN devices. 

When selecting a DPN display, set the refresh interval equal to or greater 
than the largest Network Control System (NCS) status probe interval for 
the whole network. Failure to do this may result in components 
incorrectly being displayed as out-of-service. 

The initial refresh interval used for a DPN status display is 30 seconds, 
regardless of the setting for Refresh Interval. The initial short collection 
interval is used to quickly gather data as it becomes available. The short 
refresh interval is used only for the first full Refresh Interval. That is, 5 
minutes of 30 second refreshes occur; after that, refreshes occur every 5 
minutes.

• Performance information type and component ID fields. The left side of 
the dialog shows performance information types, selectable by radio 
button (Micro Status, Net Link Status, Trunk Status, Gateway 
Status, and Summary Status). Select one type of performance 
information to display at a time. 

The component ID field (Module or Dest Mem) becomes active for a 
selected performance information type. 

Enter the component ID or retrieve the component name from context by 
clicking Get Context. For DPN, only a PM or destination mnemonic 
name is required. Multiple displays for DPN are inherent and not 
triggered by a wildcard. The destination mnemonic is similar to an OA 
name, but allows identification of primary or backup. Note that if the 
“PM”, or “OA” prefix is missing, it is prefixed automatically to the 
component specification.

See “DPN-100 Metrics” (page 301).
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• Use Reauthenticate with CM to reauthenticate with the Connection 
Manager. This is useful when changing different components to different 
user privileges.

• Use OK to start the DPN Performance Viewer. Specify a DPN 
component name in the component ID field.

• Cancel closes the Setup dialog. If the Setup dialog is presented as the 
result of starting the DPN Performance Viewer, then the Performance 
Viewer is not started. If the Setup dialog results from a Change 
Parameters command, only that change operation is canceled.

Use the Performance Viewer Setup dialog to open the following types of 
DPN summary status displays (by clicking the appropriate radio button): 

• Micro Status. The format of the PM name is “PM/nodename”. 
Metrics: CPU Utilization (%), Free Heap (%), Free MSG (%), PPS Sent, 
PPS Received, PE Service. 

See also “Micro status” (page 301).

• Net Link Summary Status. An OA destination mnemonic must be 
supplied (for example, OA/name). 
Metrics: Netlink Utilization (%), Netlink Local Mnemonic, Netlink 
Remote Mnemonic. 

See “Net Link status” (page 302).

• Trunk Status. An OA destination mnemonic must be supplied (for 
example, OA/name). 

Note: NM trunk numbers are hexadecimal. 
Metrics: Trunk Utilization (%), Trunk Local Mnemonic, Trunk Remote 
Mnemonic. 

See “Trunk status” (page 303).

• Gateway Status. An OA destination mnemonic must be supplied (for 
example, OA/name). 
Metrics: Gateway Type, Gateway Call, Gateway Link Utilization (%), 
Gateway Pkt Sent, Gateway Pkt Received. 

See “Gateway status” (page 304).
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• Summary Status. An OA destination mnemonic must be supplied (for 
example, OA/name). 
Metrics: Bus Utilization (%), Common MSG (%). 

See “Summary status” (page 305).

PV Log File Name Entry dialog
The PV Log File Name Entry dialog requests a file name. The name entered 
into the text portion of the dialog specifies the file in which the DPN 
Performance Viewer dumps metric log information. 

If a log file has already been opened, its name appears in the dialog. Change 
this name if necessary. Click Start Log to begin collection into the log file. 

Change the default directory by double clicking on a directory name, or by 
single clicking and clicking Change Directory. 

The following commands are available in the PV Log File Name Entry 
dialog:

• Use Log Entire History from Beginning to write all performance 
metrics to the named file from the moment the DPN Performance Viewer 
is first started. The default value is Off. 

When set to Off, the DPN Performance Viewer records metrics from the 
next refresh to the point a which a user stops log collection through the 
File -> Stop Log menu. 

• Start Log opens a log file with the name specified in the selection text 
field. The dialog then closes. 

• Change Directory changes the current directory to the one specified in 
the directories list. 

PV Log View dialog
The PV Log View dialog displays the contents of the alarms as they are 
logged to a file. 
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The following commands are available from the PV Log View dialog:

• Use Show to refresh the contents of the dialog with the current content 
of the specified alarm file. 

• Use Pause to temporarily suspend display of incoming alarms. When the 
display is paused, a red border surrounds the alarm information and the 
label on the button changes to Resume. Click Resume to removes the red 
border and resume display of incoming alarms.

• Use Close to close the dialog.

Warning and error dialogs
If any of the following warning or error dialogs appear, take appropriate 
action.

PV Exit Warning dialog
Exiting the Performance Viewer finishes this session. Any log file in progress 
is saved and closed. 

• No, cancel exit cancels the exit operation and returns to the Performance 
Viewer. 

PV File Error dialog
A file operation error occurs on the log file. This error occurs when the 
specified ASCII log file can be written to (for example, the current user does 
not have write permission to the directory) or because the file is already 
present but does not have write permission. 

If a close file operation fails, the Performance Viewer assumes the log file is 
dead. Start another log. 

PV File Lock Error dialog
The specified file is locked. This results from another Performance Viewer 
currently using the named file for its log. Choose Stop log; the DPN 
Performance Viewer closes the log file and unlocks it. 

If the file is not in use, it may be incorrectly marked as locked. Delete a file 
called “<filename>.lock” located in the same directory as <filename>, 
probably in the home directory. 
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PV File Exists Warning dialog
The file in which to record the DPN Performance Viewer log already exists. 
Existing data in that file is lost. To keep the existing file, click No, keep the 
file, select Log to File, and specify a different file name. 

• Click Yes to delete the file and start a new log and overwrites the existing 
file. 

• Click No to keep the file and cancel the start log operation. 

No Component Error dialog
The specified component name may be incorrect or not supported by the DPN 
Performance Viewer for viewing metrics. For example, a CARD component 
is supported, whereas a SHELF component is not. If certain the component is 
supported, ensure that the component name is in correct syntax and try again 
using the Change Parameters option. If the condition persists, see the 
system administrator. 

PV IPC Error dialog 
The DPN Performance Viewer fails to establish a connection to the inter-
process communication server. Exit the DPN Performance Viewer. Start the 
process “mnsd” should be started before invoking the DPN Performance 
Viewer. 

Prober Busy Warning dialog
The lower layer devices are too busy to respond to the probe request within 
the specified refresh interval. As a result, some probe cycles may have been 
skipped. Increase the refresh interval using the Change Parameters option. 

Metric Database Error dialog
The target component does not have the specified probe attributes. Ensure 
that Nortel Networks checks the metric database.

Invalid Component Error dialog
The Invalid Component Error dialog is displayed for any of the following 
reasons:

• The specified component name is incorrect. Make sure the component 
name is in correct syntax and try again using the Change Parameters 
option. If the situation persists, see the system administrator. 
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• A component is missing, such as a card that does not exist, or a 
component is out of range. 

Insufficient Authentication Error dialog
To access the networks to gather metrics, the user requires specific security 
parameters. These parameters are provided when the CM window is open and 
requests group, ID, and password entries. 

This window may pop up when a component is changed (probably the same 
component tried) and the Reauthenticate with CM button is selected in the 
setup dialog. 

Device Error dialog
The specified component name does not exist in the current network view. 
Make sure the component name is correct and exists in the network view. Try 
again using the Change Parameters option. If the situation persists, see the 
system administrator. 

Device Timeout Error dialog
No response is available from the target component. Make sure the 
component is active and the X.25 connection to the network is not congested. 
Try again using the Change Parameters option. If the situation persists, see 
the system administrator. 

Prober Internal Error dialog
The Prober Internal Error dialog is displayed for any of the following 
reasons:

• The lower layer has errors. No more data may be displayed. 

• Check the OAM Log Display for detailed error information about 
Generic Prober (GP), the GMDR, or Fdtr. Verify the system 
configuration for connection between Preside Multiservice Data 
Manager and Passport. 

This error may be caused by the Passport component going down. Even 
when the component comes back up, probing does not take place unless 
the user completes a manual component restart using the Change 
Parameters option. 
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Try to solve this by reconnecting the DPN Performance Viewer using the 
Change Parameters option. If this fails, log out and log back in; this restarts 
a probe. If the situation persists, see the system administrator. 

Accumulator IPC Error
An attempt to connect to the server GMDR fails. Make sure the server GMDR 
is running on the local workstation or the workstation the LAN select to. 

Accumulator Lost Connection dialog
Communication with the server GMDR is severed. Make sure the server 
GMDR is running on the local workstation or the workstation the LAN select 
to. 

Invalid Module Name or Destination Mnemonic dialog
The specified destination mnemonic or module name is not reporting status 
records. Make sure the connection from Preside Multiservice Data Manager 
to the OA or from the OA to the reporting module is up. Try again using the 
Change Parameters option. If the persists, see the system administrator. 

Make sure the specified PM or destination mnemonic exists within the 
network view. 

Note: A refresh interval that is set too short may also cause this error. 
Make sure the refresh interval is set no smaller than the status probe 
interval of the switch. 

DPN Performance Viewer Procedures
Perform the following tasks with DPN Performance Viewer:

• “Starting the DPN Performance Viewer” (page 120)

• “Displaying component information” (page 121)

Starting the DPN Performance Viewer
Specify a DPN status display and a DPN module name or a reporting 
destination mnemonic (Dest Mnem). 

Note: The DPN destination mnemonic is not the OA name, but does 
allow more precise identification of an OA. For most setups, the primary 
OA and its destination mnemonic are the same.
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Starting the DPN Performance Viewer from the Performance 
toolset
1 In the application main window, select Performance ->DPN 

Performance Viewer.

The Performance Viewer Setup window opens.

2 To display performance information, choose one of the following:

a. For a DPN micro status display, click Micro Status and enter the PM 
to monitor.

b. For a DPN network link status display, click Net Link Status and 
enter the reporting Dest Mnem to monitor.

c. For a DPN trunk status display, click Trunk Status and enter the 
reporting Dest Mnem to monitor.

d. For a DPN gateway status display, click Gateway Status and enter 
the reporting Dest Mnem to monitor.

e. For a DPN summary status display, click Summary Status, and 
enter the reporting Dest Mnem to monitor.

Displaying component information
DPN Performance Viewer displays performance information about multiple 
DPN components.
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The DPN Performance Viewer gives multiple component displays only for 
the five different DPN status types (selected in the setup dialog). The 
components in the DPN displays represent the various components that the 
Dest Mnem is reporting.

Displaying DPN status information
1 Click one of the DPN status buttons.

2 Type the component name in the PM or Dest Mnem field beside the 
button for example, OA/BARNEY is a reporting Dest Mnem name): or 
click Context action. This places the current context into the active text 
field. Define a Dest Mnem (or PM) in context.

3 Move the slider control in the Refresh Interval (seconds) field to select 
a desired probe frequency for displaying data. The Refresh Interval has 
a 60-second default setting. Choose an interval between 60 and 600 
seconds (10 minutes).

Note:  An initial attempt occurs to get all the information at the start of the 
collection. After this attempt, the probe tries once every selected refresh 
interval. 

4 Click OK.

CAUTION
The refresh interval should be equal to or greater than the 
maximum NCS status probe interval for the whole 
network. If not, the accuracy of the DPN Performance 
Viewer is affected.
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The Performance Viewer window opens and the Performance Viewer 
Setup window closes.

This sample screen graphs the Trunk Utilization performance of DPN 
components under a Dest Mnem. The Performance Viewer used a 
refresh interval of 60 seconds and ran for about thirty minutes.

Controlling the graphic display
The Performance Viewer window contains several control areas. Use the 
mouse to activate a variety of display controls.
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Single component display information
The single component Performance Viewer window contains the following 
areas and controls: 

• a title bar at the top of the window showing the component name 

• a menu bar with File, Options, and Help menus

• a graphic display area with a moveable vertical History Line 

• a time scale and a horizontal scroll control below it 

• a textual display area with buttons to the left and a vertical scroll control 
to the right. The default for the metrics button is Off. Select the metrics 
to view as a graph.

Filtering information about a single component
1 Use the inner buttons at the bottom of the screen on the left-hand side to 

filter the display contents. Display graphs of CPU Utilization (%)and Msg 
Block Utilization (%) for card components. For trunk components, display 
Packets/sec from interface, Trunk Pks/sec from interface, Discarded 
Packets/sec, and Round trip delay/ms. For bus components, display Bus 
Utilization (%).

The DPN Performance Viewer reports the values obtained in the text 
display area on the right of the buttons and graphs these results in the 
graphic display area. The color of the button matches the line displayed 
in the graph. The endpoint of the graph line represents the latest value 
obtained and is updated according to the Refresh Interval selected in the 
Performance Viewer Setup Dialog.

2 Position the cursor in the graph display area and move the History Line 
to display values for a chosen moment of interest. Left click the mouse to 
move the History Line to the current cursor position. Use the left and right 
arrow keys to move the History line in increments of one data point.

The History Line moves to the selected point, and the values obtained 
for that period are displayed in the text display area.

Note:  The History Line cannot move to a point before the Performance 
Viewer start date and time or to a point beyond the current value. 

3 To view the maximum value for the period during which the Performance 
Viewer is active, click High Water Mark of the selected metric.

The History Line finds the High Water Mark and reports this value in the 
text display area.
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4 To change the nature of the DPN Performance Viewer display, use the 
Options menu. Change parameters to view the performance of another 
component after entering the component ID in the Performance Viewer 
Setup dialog. If necessary, reset the refresh interval to a different value. 

Note 1:  Changing components is identical to exiting the current 
Performance Viewer and starting a new one. All history for the previous 
Performance Viewer is lost and any log file output is stopped. When the 
refresh interval is changed, new history points line up based on the new 
refresh interval. This change can result in the graph being stretched or 
squeezed.

Note 2:  See Help for Change Parameters to find detailed component 
support information. 

5 Use the File menu to create and view Performance Viewer log files. Start 
log prompts for a name for the log file to create, then writes collected 
information to that log file. The log file is updated every time more 
information is collected, until Stop log, Change Parameters, or Exit is 
selected. Stop log stops output to the log file. View log retrieves and 
displays saved Performance Viewer log files.

Note:  If the selected filename is identical to a previously saved log file, 
the saved log file is overwritten with the latest performance information. 

Multiple component display information
The multiple component Performance Viewer window is similar to the 
single component window but has one additional display area. The top of the 
window contains different displays depending on the kind of multiple 
components on view. This area is always present when viewing Data Packet 
Network (DPN) status. 

Clicking one of the numbered radio button creates a display of that 
component’s performance in the graphic display area below. Any previous 
component display is replaced by the new selection.

For the DPN status displays, the multiple component area shows a list of all 
the PE’s, etc., that are report information through the specified Dest Mnem. 
Clicking an item in the list creates a display of that component’s performance 
in the graphic display area below. Any previous component display is 
replaced by the new selection.

Note: Down DPN components appear in the list with an orange 
background.
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Filtering information about multiple components
1 Use the inner buttons at the bottom of the screen to filter the display 

contents. Display graphs of CPU Utilization (%) and Msg Block Utilization 
(%) for any single card on the Passport shelf. 

The DPN Performance Viewer reports the values obtained in the text 
display area on the right of the buttons and graphs these results in the 
graphic display area above. The color of the button matches the line 
displayed in the graph or list. The endpoint of the graph line represents 
the latest value obtained and is updated according to the Refresh 
Interval defined in the Performance Viewer Setup Dialog. 

2 To see information on another component, click the numbered radio 
button or the list item that corresponds to that component at the top of the 
screen.

3 All other procedures and controls are identical to those described in steps 
2-5 in “Filtering information about a single component” (page 124).

Customizing DPN Performance Viewer default settings
To override the default settings, enter new values in the .Xdefaults file in the 
$HOME/MagellanNMS directory as shown in the table “Resources for 
customizing Performance Viewer default settings” (page 126).

Table 1
Resources for customizing Performance Viewer default settings

Resource Description Legal values

PV*historyLimit Specifies the number 
of data points the 
Performance Viewer 
can remember. This 
setting affects the size 
of the graphic display. 

The default value is
 1 000. Choose any 
value between 200 
and 10 000.

PV*logFile Is used to enter a 
default log filename 
whenever using the 
Start Log… option 
under the File menu. 

Choose any valid 
UNIX absolute path 
file. 
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For additional information on customization, see 241-6001-301 Preside 
MDM Customization Administrator Guide.

Understanding DPN Performance Viewer log files
The information collected by DPN Performance Viewer can be written to a 
log file. Log files use an ASCII format and can be viewed or machine read. 
For procedures about creating and viewing DPN Performance Viewer log 
files, see step 5 in “Filtering information about a single component” 
(page 124). 

Log file information uses the following syntax:

time : component : metric : value

time is the time stamp of the current line’s output in the format yyyy mm dd 
hh mm ss. The time is fetched from the Preside Multiservice Data Manager 
workstation clock at the moment the data is received.

component is a fully qualified component name. For example, PM/R34 PE/8

metric is the calculation defined in the metric database. For example, CPU 
Utilization (%).

PV*refreshInterval Sets the refresh 
frequency default. 

The default value is 
300 seconds; 
however, choose a 
setting between 10 
and 600 seconds (60 
and 600 seconds for 
DPN displays). 

PV*metricButton.set Is used to set the initial 
state of the metric 
buttons. 

The default is False, 
which means no 
graphs are initially 
displayed. 

Table 1 (Continued)
Resources for customizing Performance Viewer default settings

Resource Description Legal values
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value is the numeric or string result of the most recent calculation. For 
example, 42.

Here is an example of one line of output in a log file:

2002 01 31 15 52 51: PM/34 PE/8: CPU Utilization (%) : 0

Note: Colons are used to separate the fields and to improve machine 
readability. Do not use colons as part of the component identification or 
the metric name if machine readability is expected. 
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Passport performance metrics are generated by the Data Viewer and are 
detailed by component, in alphabetical order.

Note: Note: Do not use an equal sign “=” in the <metric name>. It may 
cause parsing errors.

Table 2
Component: EM/ AAL1CES/

Name Formula Meaning

Tx Cells per second (cellsTransmitted/NUM)                      
DELTA                      SECONDS                      
DIVIDE

Number of cells sent to the 
interface per second since the 
last probe.

Tx Cells since Baseline (cellsTransmitted/NUM)                      
BASELINEDELTA

Number of cells sent to the 
interface since the last 
baseline reset.

Rx Cells per second (cellsReceived/NUM)                      
DELTA                      SECONDS                      
DIVIDE

Number of cells received from 
the interface per second since 
the last  probe. 

Rx Cells since Baseline (cellsReceived/NUM)                      
BASELINEDELTA

Number of cells received from 
the interface since the last 
baseline reset.

Total Lost Cells (lostCells/NUM) Total number of cells lost 
since activation.

Total Buffer Underflows (bufferUnderflows/NUM) Total number of buffer 
underflows since activation.
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Total Buffer Overflows (bufferOverflows/NUM) Total number of buffer 
overflows since activation.

Reassembled Cells per 
second

(reassembledCells/NUM)                      
DELTA                      SECONDS                      
DIVIDE

Number of reassembled cells 
per second since the last 
probe.

Reassembled Cells since 
Baseline

(reassembledCells/NUM)                      
BASELINEDELTA

Number of reassembled cells 
since the last baseline reset.

Total Header Errors (headerErrors/NUM) Number of header errors 
accumulated.

Total Pointer Reframe 
Errors

(pointerReframes/NUM) Number of Pointer Reframes 
accumulated.

Total Pointer Parity Errors (pointerParityErrors/NUM) Number of Pointer Parity 
Errors accumulated.

Total AAL1 Sequence 
Errors

(aal1SequenceErrors/NUM) Number of Sequence Errors 
accumulated.

Total Misinserted Cells (misinsertedCells/NUM) Number of Misinserted Cells 
accumulated.

Table 2 (Continued)
Component: EM/ AAL1CES/

Name Formula Meaning
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Table 3
Component: EM/ ARTG PNNI

Name Formula Meaning

Routing Attempts (routingAttempts/NUM)                      
DELTA

Counts the calls routed. PNNI 
indicates the switch has PNNI 
routing capability.

Routing Attempts since 
Baseline

(routingAttempts/NUM)                      
BASELINEDELTA                      
(successfulRoutingAttempts/NUM)                      
BASELINEDELTA                      ADD

Counts the calls routed since 
the last baseline reset. PNNI 
indicates  the switch has 
PNNI routing capability.

Failed Routing Attempts (failedRoutingAttempts/NUM)                      
DELTA

Counts the calls which were 
not successfully routed. PNNI 
indicates the switch has PNNI 
routing capability.

Failed Routing Attempts 
since Baseline

(failedRoutingAttempts/NUM)                      
BASELINEDELTA

Counts the calls which were 
not successfully routed since 
the last baseline reset. PNNI 
indicates the switch has PNNI 
routing capability.

Calls Rerouted (alternateRoutingAttempts/NUM)                      
DELTA

Counts the calls that were 
routed an alternate route. 
PNNI indicates the switch has 
PNNI routing capability.

Calls Rerouted since 
Baseline

(alternateRoutingAttempts/NUM)                      
BASELINEDELTA

Counts the calls that were 
routed an alternate route 
since the last baseline reset. 
PNNI indicates the switch has 
PNNI routing capability.
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Table 4
Component: EM/ ATMIF/

Name Formula Meaning

K Tx Cells per minute (TransmittedCells/NUM)                      
DELTA                      (txCell/NUM)                      
DELTA                      ADD                      
SECONDS                      DIVIDE                      
6                      MULTIPLY                      
100                      DIVIDE

Kilocells sent per minute.

K Tx Cells since Baseline (TransmittedCells/NUM)                      
BASELINEDELTA                      
(txCell/NUM)                      
BASELINEDELTA                      ADD                      
1000                      DIVIDE

Kilocells sent since the last 
baseline reset.

K Rx Cells per minute (receivedCells/NUM)                      
DELTA                      (rxCell/NUM)                      
DELTA                      ADD                      
SECONDS                      DIVIDE                      
6                      MULTIPLY                      
100                      DIVIDE

Kilocells received per minute.

K Rx Cells since Baseline (receivedCells/NUM)                      
BASELINEDELTA                      
(rxCell/NUM)                      
BASELINEDELTA                      ADD                      
1000                      DIVIDE

Kilocells received since the 
last baseline reset.

Dropped Rx Cells (droppedRxCells/NUM)                      
DELTA

Cells dropped.

Dropped Rx Cells since 
Baseline

(droppedRxCells/NUM)                      
BASELINEDELTA

Cells dropped since the last 
baseline reset.

Tx LinkUtilization (txLinkUtilization/NUM) Indicates the current transmit 
traffic rate over the most 
recent minute.

Rx LinkUtilization (rxLinkUtilization/NUM) Indicates the current receive 
traffic rate over the most 
recent minute.
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Table 5
Component: EM/ ATMIF/ VCC/

Name Formula Meaning

K Tx Cells per minute (txCell/NUM)                      DELTA                      
SECONDS                      DIVIDE                      
6                      MULTIPLY                      
100                      DIVIDE

Kilocells sent per minute.

K Tx Cells since Baseline (txCell/NUM)                      
BASELINEDELTA                      1000                      
DIVIDE

Kilocells sent since the last 
baseline reset.

K Rx Cells per minute (rxCell/NUM)                      DELTA                      
SECONDS                      DIVIDE                      
6                      MULTIPLY                      
100                      DIVIDE

Kilocells received per minute.

K Rx Cells since Baseline (rxCell/NUM)                      
BASELINEDELTA                      1000                      
DIVIDE

Kilocells received since the 
last baseline reset.

Tx Cells CLP per second (txCellClp/NUM)                      DELTA                      
SECONDS                      DIVIDE

Cells sent at CLP.

Tx Cells CLP since 
Baseline

(txCellClp/NUM)                      
BASELINEDELTA

Cells sent at CLP since the 
last baseline reset.

Rx Cells CLP per second (rxCellClp/NUM)                      DELTA                      
SECONDS                      DIVIDE

Cells received at CLP.

Rx Cells CLP since 
Baseline

(rxCellClp/NUM)                      
BASELINEDELTA

Cells received at CLP since 
the last baseline reset.

Cell Transmit Discards (txDiscard/NUM)                      DELTA                      
(txCellDiscard/NUM)                      
DELTA                      ADD

Sent cells discarded.

Cell Transmit Discards 
since Baseline

(txDiscard/NUM)                      
BASELINEDELTA                      
(txCellDiscard/NUM)                      
BASELINEDELTA                      ADD

Sent cells discarded since the 
last baseline reset.
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Frame Transmit Discards (txDiscard/NUM)                      DELTA                      
(txFrameDiscard/NUM)                      
DELTA                      ADD

Send frames discarded.

Frame Transmit Discards 
since Baseline

(txDiscard/NUM)                      
BASELINEDELTA                      
(txFrameDiscard/NUM)                      
BASELINEDELTA                      ADD

Send frames discarded since 
the last baseline reset.

Cell Receive Discards (rxDiscard/NUM)                      DELTA                      
(rxCellDiscard/NUM)                      
DELTA                      ADD

Received cells discarded.

Cell Receive Discards 
since Baseline

(rxDiscard/NUM)                      
BASELINEDELTA                      
(rxCellDiscard/NUM)                      
BASELINEDELTA                      ADD

Received cells discarded 
since the last baseline reset.

Frame Receive Discards (rxDiscard/NUM)                      DELTA                      
(rxFrameDiscard/NUM)                      
DELTA                      ADD

Received frames discarded.

Frame Receive Discards 
since Baseline

(rxDiscard/NUM)                      
BASELINEDELTA                      
(rxFrameDiscard/NUM)                      
BASELINEDELTA                      ADD

Received frames discarded 
since the last baseline reset.

Cell Transmit Discards 
CLP

(txDiscardClp/NUM)                      
DELTA                      
(txCellDiscardClp/NUM)                      
DELTA                      ADD

Sent cells discarded at CLP.

Cell Transmit Discards 
CLP since Baseline

(txDiscardClp/NUM)                      
BASELINEDELTA                      
(txCellDiscardClp/NUM)                      
BASELINEDELTA                      ADD

Sent cells discarded at CLP 
since the last baseline reset.

Frame Transmit Discards 
CLP

(txDiscardClp/NUM)                      
DELTA                      
(txFrameDiscardClp/NUM)                      
DELTA                      ADD

Sent frames discarded at 
CLP.

Table 5 (Continued)
Component: EM/ ATMIF/ VCC/

Name Formula Meaning
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Frame Transmit Discards 
CLP since Baseline

(txDiscardClp/NUM)                      
BASELINEDELTA                      
(txFrameDiscardClp/NUM)                      
BASELINEDELTA                      ADD

Sent frames discarded at CLP 
since the last baseline reset.

Cell Receive Discards CLP (rxDiscardClp/NUM)                      
DELTA                      
(rxCellDiscardClp/NUM)                      
DELTA                      ADD

Received cells discarded at 
CLP.

Cell Receive Discards CLP 
since Baseline

(rxDiscardClp/NUM)                      
BASELINEDELTA                      
(rxCellDiscardClp/NUM)                      
BASELINEDELTA                      ADD

Received cells discarded at 
CLP since the last baseline 
reset.

Frame Receive Discards 
CLP

(rxDiscardClp/NUM)                      
DELTA                      
(rxFrameDiscardClp/NUM)                      
DELTA                      ADD

Received frames discarded at 
CLP.

Frame Receive Discards 
CLP since Baseline

(rxDiscardClp/NUM)                      
BASELINEDELTA                      
(rxFrameDiscardClp/NUM)                      
BASELINEDELTA                      ADD

Received frames discarded at 
CLP since the last baseline 
reset.

Transmit Discards (txDiscard/NUM)                      DELTA Sent cells discarded.

Transmit Discards since 
Baseline

(txDiscard/NUM)                      
BASELINEDELTA

Sent cells discarded since the 
last baseline reset.

Receive Discards (rxDiscard/NUM)                      DELTA Received cells discarded.

Receive Discards since 
Baseline

(rxDiscard/NUM)                      
BASELINEDELTA

Received cells discarded 
since the last baseline reset.

Transmit Discards CLP (txDiscardClp/NUM)                      
DELTA

Sent cells discarded at CLP.

Transmit Discards CLP 
since Baseline

(txDiscardClp/NUM)                      
BASELINEDELTA

Sent cells discarded at CLP 
since the last baseline reset.

Table 5 (Continued)
Component: EM/ ATMIF/ VCC/

Name Formula Meaning
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Receive Discards CLP (rxDiscardClp/NUM)                      
DELTA

Received cells discarded at 
CLP.

Receive Discards CLP 
since Baseline

(rxDiscardClp/NUM)                      
BASELINEDELTA

Received cells discarded at 
CLP since the last baseline 
reset.

Table 5 (Continued)
Component: EM/ ATMIF/ VCC/

Name Formula Meaning
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Table 6
Component: EM/ ATMIF/ VPC/

Name Formula Meaning

K Tx Cells per minute (txCell/NUM)                      DELTA                      
SECONDS                      DIVIDE                      
6                      MULTIPLY                      
100                      DIVIDE

Kilocells sent per minute.

K Tx Cells since Baseline (txCell/NUM)                      
BASELINEDELTA                      1000                      
DIVIDE

Kilocells sent since the last 
baseline reset.

K Rx Cells per minute (rxCell/NUM)                      DELTA                      
SECONDS                      DIVIDE                      
6                      MULTIPLY                      
100                      DIVIDE

Kilocells received per minute.

K Rx Cells since Baseline (rxCell/NUM)                      
BASELINEDELTA                      1000                      
DIVIDE

Kilocells received since the 
last baseline reset.

Tx Cells CLP per second (txCellClp/NUM)                      DELTA                      
SECONDS                      DIVIDE

Cells sent at CLP.

Tx Cells CLP since 
Baseline

(txCellClp/NUM)                      
BASELINEDELTA

Cells sent at CLP since the 
last baseline reset.

Rx Cells CLP per second (rxCellClp/NUM)                      DELTA                      
SECONDS                      DIVIDE

Cells received at CLP.

Rx Cells CLP since 
Baseline

(rxCellClp/NUM)                      
BASELINEDELTA

Cells received at CLP since 
the last baseline reset.

Cell Transmit Discards (txDiscard/NUM)                      DELTA                      
(txCellDiscard/NUM)                      
DELTA                      ADD

Sent cells discarded.

Cell Transmit Discards 
since Baseline

(txDiscard/NUM)                      
BASELINEDELTA                      
(txCellDiscard/NUM)                      
BASELINEDELTA                      ADD

Sent cells discarded since the 
last baseline reset.
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Frame Transmit Discards (txDiscard/NUM)                      DELTA                      
(txFrameDiscard/NUM)                      
DELTA                      ADD

Send frames discarded.

Frame Transmit Discards 
since Baseline

(txDiscard/NUM)                      
BASELINEDELTA                      
(txFrameDiscard/NUM)                      
BASELINEDELTA                      ADD

Send frames discarded since 
the last baseline reset.

Cell Receive Discards (rxDiscard/NUM)                      DELTA                      
(rxCellDiscard/NUM)                      
DELTA                      ADD

Received cells discarded.

Cell Receive Discards 
since Baseline

(rxDiscard/NUM)                      
BASELINEDELTA                      
(rxCellDiscard/NUM)                      
BASELINEDELTA                      ADD

Received cells discarded 
since the last baseline reset.

Frame Receive Discards (rxDiscard/NUM)                      DELTA                      
(rxFrameDiscard/NUM)                      
DELTA                      ADD

Received frames discarded.

Frame Receive Discards 
since Baseline

(rxDiscard/NUM)                      
BASELINEDELTA                      
(rxFrameDiscard/NUM)                      
BASELINEDELTA                      ADD

Received frames discarded 
since the last baseline reset.

Cell Transmit Discards 
CLP

(txDiscardClp/NUM)                      
DELTA                      
(txCellDiscardClp/NUM)                      
DELTA                      ADD

Sent cells discarded at CLP.

Cell Transmit Discards 
CLP since Baseline

(txDiscardClp/NUM)                      
BASELINEDELTA                      
(txCellDiscardClp/NUM)                      
BASELINEDELTA                      ADD

Sent cells discarded at CLP 
since the last baseline reset.

Frame Transmit Discards 
CLP

(txDiscardClp/NUM)                      
DELTA                      
(txFrameDiscardClp/NUM)                      
DELTA                      ADD

Sent frames discarded at 
CLP.

Table 6 (Continued)
Component: EM/ ATMIF/ VPC/

Name Formula Meaning
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Frame Transmit Discards 
CLP since Baseline

(txDiscardClp/NUM)                      
BASELINEDELTA                      
(txFrameDiscardClp/NUM)                      
BASELINEDELTA                      ADD

Sent frames discarded at CLP 
since the last baseline reset.

Cell Receive Discards CLP (rxDiscardClp/NUM)                      
DELTA                      
(rxCellDiscardClp/NUM)                      
DELTA                      ADD

Received cells discarded at 
CLP.

Cell Receive Discards CLP 
since Baseline

(rxDiscardClp/NUM)                      
BASELINEDELTA                      
(rxCellDiscardClp/NUM)                      
BASELINEDELTA                      ADD

Received cells discarded at 
CLP since the last baseline 
reset.

Frame Receive Discards 
CLP

(rxDiscardClp/NUM)                      
DELTA                      
(rxFrameDiscardClp/NUM)                      
DELTA                      ADD

Received frames discarded at 
CLP.

Frame Receive Discards 
CLP since Baseline

(rxDiscardClp/NUM)                      
BASELINEDELTA                      
(rxFrameDiscardClp/NUM)                      
BASELINEDELTA                      ADD

Received frames discarded at 
CLP since the last baseline 
reset.

Transmit Discards (txDiscard/NUM)                      DELTA Sent cells discarded.

Transmit Discards since 
Baseline

(txDiscard/NUM)                      
BASELINEDELTA

Sent cells discarded since the 
last baseline reset.

Receive Discards (rxDiscard/NUM)                      DELTA Received cells discarded.

Receive Discards since 
Baseline

(rxDiscard/NUM)                      
BASELINEDELTA

Received cells discarded 
since the last baseline reset.

Transmit Discards CLP (txDiscardClp/NUM)                      
DELTA

Sent cells discarded at CLP.

Transmit Discards CLP 
since Baseline

(txDiscardClp/NUM)                      
BASELINEDELTA

Sent cells discarded at CLP 
since the last baseline reset.

Table 6 (Continued)
Component: EM/ ATMIF/ VPC/

Name Formula Meaning
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Receive Discards CLP (rxDiscardClp/NUM)                      
DELTA

Received cells discarded at 
CLP.

Receive Discards CLP 
since Baseline

(rxDiscardClp/NUM)                      
BASELINEDELTA

Received cells discarded at 
CLP since the last baseline 
reset.

Table 6 (Continued)
Component: EM/ ATMIF/ VPC/

Name Formula Meaning

 (Sheet 4 of 4)
241-6001-031   15.1    



Appendix A Passport performance metrics   141
Table 7
Component: EM/ ATMIF/ VPT/

Name Formula Meaning

K Tx Cells per minute (txCell/NUM)                      DELTA                      
SECONDS                      DIVIDE                      
6                      MULTIPLY                      
100                      DIVIDE

Kilocells sent per minute.

K Tx Cells since Baseline (txCell/NUM)                      
BASELINEDELTA                      1000                      
DIVIDE

Kilocells sent since the last 
baseline reset.

K Rx Cells per minute (rxCell/NUM)                      DELTA                      
SECONDS                      DIVIDE                      
6                      MULTIPLY                      
100                      DIVIDE

Kilocells received per minute.

K Rx Cells since Baseline (rxCell/NUM)                      
BASELINEDELTA                      1000                      
DIVIDE

Kilocells received since the 
last baseline reset.

Tx Cells CLP per second (txCellClp/NUM)                      DELTA                      
SECONDS                      DIVIDE

Cells sent at CLP.

Tx Cells CLP since 
Baseline

(txCellClp/NUM)                      
BASELINEDELTA

Cells sent at CLP since the 
last baseline reset.

Rx Cells CLP per second (rxCellClp/NUM)                      DELTA                      
SECONDS                      DIVIDE

Cells received at CLP.

Rx Cells CLP since 
Baseline

(rxCellClp/NUM)                      
BASELINEDELTA

Cells received at CLP since 
the last baseline reset.

Cell Transmit Discards (txDiscard/NUM)                      DELTA                      
(txCellDiscard/NUM)                      
DELTA                      ADD

Sent cells discarded.

Cell Transmit Discards 
since Baseline

(txDiscard/NUM)                      
BASELINEDELTA                      
(txCellDiscard/NUM)                      
BASELINEDELTA                      ADD

Sent cells discarded since the 
last baseline reset.
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Frame Transmit Discards (txDiscard/NUM)                      DELTA                      
(txFrameDiscard/NUM)                      
DELTA                      ADD

Send frames discarded.

Frame Transmit Discards 
since Baseline

(txDiscard/NUM)                      
BASELINEDELTA                      
(txFrameDiscard/NUM)                      
BASELINEDELTA                      ADD

Send frames discarded since 
the last baseline reset.

Cell Receive Discards (rxDiscard/NUM)                      DELTA                      
(rxCellDiscard/NUM)                      
DELTA                      ADD

Received cells discarded.

Cell Receive Discards 
since Baseline

(rxDiscard/NUM)                      
BASELINEDELTA                      
(rxCellDiscard/NUM)                      
BASELINEDELTA                      ADD

Received cells discarded 
since the last baseline reset.

Frame Receive Discards (rxDiscard/NUM)                      DELTA                      
(rxFrameDiscard/NUM)                      
DELTA                      ADD

Received frames discarded.

Frame Receive Discards 
since Baseline

(rxDiscard/NUM)                      
BASELINEDELTA                      
(rxFrameDiscard/NUM)                      
BASELINEDELTA                      ADD

Received frames discarded 
since the last baseline reset.

Cell Transmit Discards 
CLP

(txDiscardClp/NUM)                      
DELTA                      
(txCellDiscardClp/NUM)                      
DELTA                      ADD

Sent cells discarded at CLP.

Cell Transmit Discards 
CLP since Baseline

(txDiscardClp/NUM)                      
BASELINEDELTA                      
(txCellDiscardClp/NUM)                      
BASELINEDELTA                      ADD

Sent cells discarded at CLP 
since the last baseline reset.

Frame Transmit Discards 
CLP

(txDiscardClp/NUM)                      
DELTA                      
(txFrameDiscardClp/NUM)                      
DELTA                      ADD

Sent frames discarded at 
CLP.

Table 7 (Continued)
Component: EM/ ATMIF/ VPT/

Name Formula Meaning
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Frame Transmit Discards 
CLP since Baseline

(txDiscardClp/NUM)                      
BASELINEDELTA                      
(txFrameDiscardClp/NUM)                      
BASELINEDELTA                      ADD

Sent frames discarded at CLP 
since the last baseline reset.

Cell Receive Discards CLP (rxDiscardClp/NUM)                      
DELTA                      
(rxCellDiscardClp/NUM)                      
DELTA                      ADD

Received cells discarded at 
CLP.

Cell Receive Discards CLP 
since Baseline

(rxDiscardClp/NUM)                      
BASELINEDELTA                      
(rxCellDiscardClp/NUM)                      
BASELINEDELTA                      ADD

Received cells discarded at 
CLP since the last baseline 
reset.

Frame Receive Discards 
CLP

(rxDiscardClp/NUM)                      
DELTA                      
(rxFrameDiscardClp/NUM)                      
DELTA                      ADD

Received frames discarded at 
CLP.

Frame Receive Discards 
CLP since Baseline

(rxDiscardClp/NUM)                      
BASELINEDELTA                      
(rxFrameDiscardClp/NUM)                      
BASELINEDELTA                      ADD

Received frames discarded at 
CLP since the last baseline 
reset.

Transmit Discards (txDiscard/NUM)                      DELTA Sent cells discarded.

Transmit Discards since 
Baseline

(txDiscard/NUM)                      
BASELINEDELTA

Sent cells discarded since the 
last baseline reset.

Receive Discards (rxDiscard/NUM)                      DELTA Received cells discarded.

Receive Discards since 
Baseline

(rxDiscard/NUM)                      
BASELINEDELTA

Received cells discarded 
since the last baseline reset.

Transmit Discards CLP (txDiscardClp/NUM)                      
DELTA

Sent cells discarded at CLP.

Transmit Discards CLP 
since Baseline

(txDiscardClp/NUM)                      
BASELINEDELTA

Sent cells discarded at CLP 
since the last baseline reset.

Table 7 (Continued)
Component: EM/ ATMIF/ VPT/

Name Formula Meaning
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Receive Discards CLP (rxDiscardClp/NUM)                      
DELTA

Received cells discarded at 
CLP.

Receive Discards CLP 
since Baseline

(rxDiscardClp/NUM)                      
BASELINEDELTA

Received cells discarded at 
CLP since the last baseline 
reset.

Table 7 (Continued)
Component: EM/ ATMIF/ VPT/

Name Formula Meaning
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Table 8
Component: EM/ ATMIF/ VPT/ VCC/

Name Formula Meaning

K Tx Cells per minute (txCell/NUM)                      DELTA                      
SECONDS                      DIVIDE                      
6                      MULTIPLY                      
100                      DIVIDE

Kilocells sent per minute.

K Tx Cells since Baseline (txCell/NUM)                      
BASELINEDELTA                      1000                      
DIVIDE

Kilocells sent since the last 
baseline reset.

K Rx Cells per minute (rxCell/NUM)                      DELTA                      
SECONDS                      DIVIDE                      
6                      MULTIPLY                      
100                      DIVIDE

Kilocells received per minute.

K Rx Cells since Baseline (rxCell/NUM)                      
BASELINEDELTA                      1000                      
DIVIDE

Kilocells received since the 
last baseline reset.

Tx Cells CLP per second (txCellClp/NUM)                      DELTA                      
SECONDS                      DIVIDE

Cells sent at CLP.

Tx Cells CLP since 
Baseline

(txCellClp/NUM)                      
BASELINEDELTA

Cells sent at CLP since the 
last baseline reset.

Rx Cells CLP per second (rxCellClp/NUM)                      DELTA                      
SECONDS                      DIVIDE

Cells received at CLP.

Rx Cells CLP since 
Baseline

(rxCellClp/NUM)                      
BASELINEDELTA

Cells received at CLP since 
the last baseline reset.

Cell Transmit Discards (txDiscard/NUM)                      DELTA                      
(txCellDiscard/NUM)                      
DELTA                      ADD

Sent cells discarded.

Cell Transmit Discards 
since Baseline

(txDiscard/NUM)                      
BASELINEDELTA                      
(txCellDiscard/NUM)                      
BASELINEDELTA                      ADD

Sent cells discarded since the 
last baseline reset.
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Frame Transmit Discards (txDiscard/NUM)                      DELTA                      
(txFrameDiscard/NUM)                      
DELTA                      ADD

Send frames discarded.

Frame Transmit Discards 
since Baseline

(txDiscard/NUM)                      
BASELINEDELTA                      
(txFrameDiscard/NUM)                      
BASELINEDELTA                      ADD

Send frames discarded since 
the last baseline reset.

Cell Receive Discards (rxDiscard/NUM)                      DELTA                      
(rxCellDiscard/NUM)                      
DELTA                      ADD

Received cells discarded.

Cell Receive Discards 
since Baseline

(rxDiscard/NUM)                      
BASELINEDELTA                      
(rxCellDiscard/NUM)                      
BASELINEDELTA                      ADD

Received cells discarded 
since the last baseline reset.

Frame Receive Discards (rxDiscard/NUM)                      DELTA                      
(rxFrameDiscard/NUM)                      
DELTA                      ADD

Received frames discarded.

Frame Receive Discards 
since Baseline

(rxDiscard/NUM)                      
BASELINEDELTA                      
(rxFrameDiscard/NUM)                      
BASELINEDELTA                      ADD

Received frames discarded 
since the last baseline reset.

Cell Transmit Discards 
CLP

(txDiscardClp/NUM)                      
DELTA                      
(txCellDiscardClp/NUM)                      
DELTA                      ADD

Sent cells discarded at CLP.

Cell Transmit Discards 
CLP since Baseline

(txDiscardClp/NUM)                      
BASELINEDELTA                      
(txCellDiscardClp/NUM)                      
BASELINEDELTA                      ADD

Sent cells discarded at CLP 
since the last baseline reset.

Frame Transmit Discards 
CLP

(txDiscardClp/NUM)                      
DELTA                      
(txFrameDiscardClp/NUM)                      
DELTA                      ADD

Sent frames discarded at 
CLP.

Table 8 (Continued)
Component: EM/ ATMIF/ VPT/ VCC/

Name Formula Meaning
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Frame Transmit Discards 
CLP since Baseline

(txDiscardClp/NUM)                      
BASELINEDELTA                      
(txFrameDiscardClp/NUM)                      
BASELINEDELTA                      ADD

Sent frames discarded at CLP 
since the last baseline reset.

Cell Receive Discards CLP (rxDiscardClp/NUM)                      
DELTA                      
(rxCellDiscardClp/NUM)                      
DELTA                      ADD

Received cells discarded at 
CLP.

Cell Receive Discards CLP 
since Baseline

(rxDiscardClp/NUM)                      
BASELINEDELTA                      
(rxCellDiscardClp/NUM)                      
BASELINEDELTA                      ADD

Received cells discarded at 
CLP since the last baseline 
reset.

Frame Receive Discards 
CLP

(rxDiscardClp/NUM)                      
DELTA                      
(rxFrameDiscardClp/NUM)                      
DELTA                      ADD

Received frames discarded at 
CLP.

Frame Receive Discards 
CLP since Baseline

(rxDiscardClp/NUM)                      
BASELINEDELTA                      
(rxFrameDiscardClp/NUM)                      
BASELINEDELTA                      ADD

Received frames discarded at 
CLP since the last baseline 
reset.

Transmit Discards (txDiscard/NUM)                      DELTA Sent cells discarded.

Transmit Discards since 
Baseline

(txDiscard/NUM)                      
BASELINEDELTA

Sent cells discarded since the 
last baseline reset.

Receive Discards (rxDiscard/NUM)                      DELTA Received cells discarded.

Receive Discards since 
Baseline

(rxDiscard/NUM)                      
BASELINEDELTA

Received cells discarded 
since the last baseline reset.

Transmit Discards CLP (txDiscardClp/NUM)                      
DELTA

Sent cells discarded at CLP.

Transmit Discards CLP 
since Baseline

(txDiscardClp/NUM)                      
BASELINEDELTA

Sent cells discarded at CLP 
since the last baseline reset.

Table 8 (Continued)
Component: EM/ ATMIF/ VPT/ VCC/

Name Formula Meaning
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Receive Discards CLP (rxDiscardClp/NUM)                      
DELTA

Received cells discarded at 
CLP.

Receive Discards CLP 
since Baseline

(rxDiscardClp/NUM)                      
BASELINEDELTA

Received cells discarded at 
CLP since the last baseline 
reset.

Table 8 (Continued)
Component: EM/ ATMIF/ VPT/ VCC/

Name Formula Meaning
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Table 9
Component: EM/ ATMMPE/ AC/

Name Formula Meaning

In Packets/sec (inPackets/NUM)                      DELTA                      
SECONDS                      DIVIDE

Counts the total number of 
packets received on this 
connection.

In Packets since Baseline (inPackets/NUM)                      
BASELINEDELTA

Counts the total number of 
packets received on this 
connection since the last 
baseline reset.

In Octects/sec (inOctets/NUM)                      DELTA                      
SECONDS                      DIVIDE

Counts the total number of 
octets received on this 
connection.

In Octects since Baseline (inOctets/NUM)                      
BASELINEDELTA

Counts the total number of 
octets received on this 
connection since the last 
baseline reset.

In UnknownProtos/sec (inUnknownProtos/NUM)                      
DELTA                      SECONDS                      
DIVIDE

Counts the total number of 
packets received on this 
connection which were 
discarded because they 
contained an unknown or 
unsupported protocol.

In UnknownProtos since 
Baseline

(inUnknownProtos/NUM)                      
BASELINEDELTA

Counts the total number of 
packets received on this 
connection which were 
discarded because they 
contained an unknown or 
unsupported protocol, since 
the last baseline reset.

In Errors/sec (inErrors/NUM)                      DELTA                      
SECONDS                      DIVIDE

Counts the total number of 
packets received on the 
connection which contained 
errors preventing them from 
being delivered to a higher-
layer protocol.
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In Errors since Baseline (inErrors/NUM)                      
BASELINEDELTA

Counts the total number of 
packets received on the 
connection which contained 
errors preventing them from 
being delivered to a higher-
layer protocol, since the last 
baseline reset.

Out Packets/sec (outPackets/NUM)                      
DELTA                      SECONDS                      
DIVIDE

outPackets

Out Packets since Baseline (outPackets/NUM)                      
BASELINEDELTA

outPackets since the last 
baseline reset.

Out Octects/sec (outOctets/NUM)                      DELTA                      
SECONDS                      DIVIDE

Counts the total number of 
octets sent on this 
connection.

Out Octects since Baseline (outOctets/NUM)                      
BASELINEDELTA

Counts the total number of 
octets sent on this connection 
since the last baseline reset.

Out Discards/sec (outDiscards/NUM)                      
DELTA                      SECONDS                      
DIVIDE

Counts the total number of 
packets which were 
supposed to be sent on this 
connection, but were 
discarded due to congestion 
or the connection being down.

Out Discards since 
Baseline

(outDiscards/NUM)                      
BASELINEDELTA

Counts the total number of 
packets which were 
supposed to be sent on this 
connection, but were 
discarded due to congestion 
or the connection being down, 
since the last baseline reset.

Table 9 (Continued)
Component: EM/ ATMMPE/ AC/

Name Formula Meaning
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Table 10
Component: EM/ BSSMIF/

Name Formula Meaning

txPackets (txPackets/NUM)                      DELTA The description for this metric 
is currently not defined.

txPackets since Baseline (txPackets/NUM)                      
BASELINEDELTA

The description for this metric 
is currently not define.

rxPackets (rxPackets/NUM)                      DELTA The description for this metric 
is currently not defined.

rxPackets since Baseline (rxPackets/NUM)                      
BASELINEDELTA

The description for this metric 
is currently not defined.

txPacketDiscards (txPacketDiscards/NUM)                      
DELTA

The description for this metric 
is currently not defined.

txPacketDiscards since 
Baseline

(txPacketDiscards/NUM)                      
BASELINEDELTA

The description for this metric 
is currently not defined.

rxPacketDiscards (rxPacketDiscards/NUM)                      
DELTA

The description for this metric 
is currently not defined.

rxPacketDiscards since 
Baseline

(rxPacketDiscards/NUM)                      
BASELINEDELTA

The description for this metric 
is currently not defined.
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Table 11
Component: EM/ BTDS/ FRAMER

Name Formula Meaning

Frames per second Sent (frmToIf/NUM)                      DELTA                      
SECONDS                      DIVIDE

Number of frames per second 
transmitted to the link 
interface by Framer, since 
last probe.

Frames Sent since 
Baseline

(frmToIf/NUM)                      
BASELINEDELTA

Number of frames transmitted 
to the link interface by 
Framer, since the last 
baseline reset.

Frames per second 
Received

(frmFromIf/NUM)                      DELTA                      
SECONDS                      DIVIDE

Number or frames per second 
received from the link 
interface by Framer, since 
last probe.

Frames Received since 
Baseline

(frmFromIf/NUM)                      
BASELINEDELTA

Number or frames received 
from the link interface by 
Framer, since the last 
baseline reset.

LRC Errors (lrcErrors/NUM)                      DELTA Number of frames received 
from the link interface with 
CRC errors, since last probe.

LRC Errors since Baseline (lrcErrors/NUM)                      
BASELINEDELTA

Number of frames received 
from the link interface with 
CRC errors, since the last 
baseline reset.

Frame Lost in Network (frmLostInNetwork/NUM)                      
DELTA

Number of frames the service 
did not receive from the 
network, since last probe.

Frame Lost in Network 
since Baseline

(frmLostInNetwork/NUM)                      
BASELINEDELTA

Number of frames the service 
did not receive from the 
network, since the last 
baseline reset.
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Frames Underruns (frmUnderRuns/NUM)                      
DELTA

Number of times a frame was 
needed but was not available 
because it was delayed too 
long in the network, since last 
probe.

Frames Underruns since 
Baseline

(frmUnderRuns/NUM)                      
BASELINEDELTA

Number of times a frame was 
needed but was not available 
because it was delayed too 
long in the network, since the 
last baseline reset.

Frame Dumped (frmDumped/NUM)                      
DELTA

Number of frames dumped 
because the local interface 
output queue was too large, 
since last probe.

Frame Dumped since 
Baseline

(frmDumped/NUM)                      
BASELINEDELTA

Number of frames dumped 
because the local interface 
output queue was too large, 
since the last baseline reset.

Table 11 (Continued)
Component: EM/ BTDS/ FRAMER

Name Formula Meaning
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Table 12
Component: EM/ BTS/ BTSIF/

Name Formula Meaning

txPackets (txPackets/NUM)                      DELTA The description for this metric 
is currently not defined.

txPackets since Baseline (txPackets/NUM)                      
BASELINEDELTA

The description for this metric 
is currently not defined.

rxPackets (rxPackets/NUM)                      DELTA The description for this metric 
is currently not defined.

rxPackets since Baseline (rxPackets/NUM)                      
BASELINEDELTA

The description for this metric 
is currently not defined.

txOctets (txOctets/NUM)                      DELTA The description for this metric 
is currently not defined.

txOctets since Baseline (txOctets/NUM)                      
BASELINEDELTA

The description for this metric 
is currently not defined.

rxOctets (rxOctets/NUM)                      DELTA The description for this metric 
is currently not defined.

rxOctets since Baseline (rxOctets/NUM)                      
BASELINEDELTA

The description for this metric 
is currently not defined.

txPacketDiscards (txPacketDiscards/NUM)                      
DELTA

The description for this metric 
is currently not defined.

txPacketDiscards since 
Baseline

(txPacketDiscards/NUM)                      
BASELINEDELTA

The description for this metric 
is currently not defined.

rxPacketDiscards (rxPacketDiscards/NUM)                      
DELTA

The description for this metric 
is currently not defined.

rxPacketDiscards since 
Baseline

(rxPacketDiscards/NUM)                      
BASELINEDELTA

The description for this metric 
is currently not defined.
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Table 13
Component: EM/ CIUIF/

Name Formula Meaning

txPackets (txPackets/NUM)                      DELTA The description for this metric 
is currently not defined.

txPackets since Baseline (txPackets/NUM)                      
BASELINEDELTA

The description for this metric 
is currently not defined.

rxPackets (rxPackets/NUM)                      DELTA The description for this metric 
is currently not defined.

rxPackets since Baseline (rxPackets/NUM)                      
BASELINEDELTA

The description for this metric 
is currently not defined.

txOctets (txOctets/NUM)                      DELTA The description for this metric 
is currently not defined.

txOctets since Baseline (txOctets/NUM)                      
BASELINEDELTA

The description for this metric 
is currently not defined.

rxOctets (rxOctets/NUM)                      DELTA The description for this metric 
is currently not defined.

rxOctets since Baseline (rxOctets/NUM)                      
BASELINEDELTA

The description for this metric 
is currently not defined.

txPacketDiscards (txPacketDiscards/NUM)                      
DELTA

The description for this metric 
is currently not defined.

txPacketDiscards since 
Baseline

(txPacketDiscards/NUM)                      
BASELINEDELTA

The description for this metric 
is currently not defined.

rxPacketDiscards (rxPacketDiscards/NUM)                      
DELTA

The description for this metric 
is currently not defined.

rxPacketDiscards since 
Baseline

(rxPacketDiscards/NUM)                      
BASELINEDELTA

The description for this metric 
is currently not defined.
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Table 14
Component: EM/ CRS

Name Formula Meaning

Redir Attempts / second (requestsReceived/NUM)                      
DELTA                      SECONDS                      
DIVIDE

Provides a set of alternate 
destinations for the original 
address.

Redir Attempts since 
Baseline

(requestsReceived/NUM)                      
BASELINEDELTA

Provides a set of alternate 
destinations for the original 
address since the last 
baseline reset.

Table 15
Component: EM/ DISCOIF/

Name Formula Meaning

txPackets (txPackets/NUM)                      DELTA The description for this metric 
is currently not defined.

txPackets since Baseline (txPackets/NUM)                      
BASELINEDELTA

The description for this metric 
is currently not defined.

rxPackets (rxPackets/NUM)                      DELTA The description for this metric 
is currently not defined.

rxPackets since Baseline (rxPackets/NUM)                      
BASELINEDELTA

The description for this metric 
is currently not defined.

txPacketDiscards (txPacketDiscards/NUM)                      
DELTA

The description for this metric 
is currently not defined.

txPacketDiscards since 
Baseline

(txPacketDiscards/NUM)                      
BASELINEDELTA

The description for this metric 
is currently not defined.

rxPacketDiscards (rxPacketDiscards/NUM)                      
DELTA

The description for this metric 
is currently not defined.

rxPacketDiscards since 
Baseline

(rxPacketDiscards/NUM)                      
BASELINEDELTA

The description for this metric 
is currently not defined.
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Table 16
Component: EM/ DLEP/ DS1/

Name Formula Meaning

CRC Errors (crcErrors/NUM)                      DELTA The description for this metric 
is currently not defined.

CRC Errors since Baseline (crcErrors/NUM)                      
BASELINEDELTA

The description for this metric 
is currently not defined.

Frame Errors (frmErrors/NUM)                      DELTA The description for this metric 
is currently not defined.

Frame Errors since 
Baseline

(frmErrors/NUM)                      
BASELINEDELTA

The description for this metric 
is currently not defined.

SLIP Errors (slipErrors/NUM)                      DELTA The description for this metric 
is currently not defined.

SLIP Errors since Baseline (slipErrors/NUM)                      
BASELINEDELTA

The description for this metric 
is currently not defined.

Table 17
Component: EM/ DLEP/ DS1/ CHAN/ CELL

Name Formula Meaning

Rx Cell Util (receiveCellUtilization/NUM) The description for this metric 
is currently not defined.

Tx Cell Util (transmitCellUtilization/NUM) The description for this metric 
is currently not defined.
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Table 18
Component: EM/ DPNGATE/

Name Formula Meaning

Packets/sec from Interface (pktFromIf/NUM)                      DELTA                      
SECONDS                      DIVIDE

Packets from interface per 
second.

Packets from Interface 
since Baseline

(pktFromIf/NUM)                      
BASELINEDELTA

Packets from interface since 
the last baseline reset.

Trunk Pks/s to Interface (trunkPktToIf/NUM)                      
DELTA                      SECONDS                      
DIVIDE

Trunk packets to interface per 
second.

Trunk Pks to Interface 
since Baseline

(trunkPktToIf/NUM)                      
BASELINEDELTA

Trunk packets to interface 
since the last baseline reset.

Trunk Pks/s from Interface (trunkPktFromIf/NUM)                      
DELTA                      SECONDS                      
DIVIDE

Trunk packets from interface 
per second.

Trunk Pks from Interface 
since Baseline

(trunkPktFromIf/NUM)                      
BASELINEDELTA

Trunk packets from interface 
since the last baseline reset.

Discarded packets/sec (discardUnforward/NUM)                      
DELTA                      SECONDS                      
DIVIDE

Discarded packets per 
second.

Discarded packets since 
Baseline

(discardUnforward/NUM)                      
BASELINEDELTA

Discarded packets since the 
last baseline reset.

Round trip delay (ms) (measuredRoundTripDelay/NUM) Round trip delay in 
millisecond measured by the 
DPN Gateway.
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Table 19
Component: EM/ DPNGATE/ UTP FRAMER

Name Formula Meaning

Frames per second to 
Interface

(frmToIf/NUM)                      DELTA                      
SECONDS                      DIVIDE

Frames sent per second.

Frames to Interface since 
Baseline

(frmToIf/NUM)                      
BASELINEDELTA

Frames sent since the last 
baseline reset.

Frames per second from 
Interface

(frmFromIf/NUM)                      DELTA                      
SECONDS                      DIVIDE

Frames received per second.

Frames from Interface 
since Baseline

(frmFromIf/NUM)                      
BASELINEDELTA

Frames received since the 
last baseline reset.

Outgoing Normal Link 
Utilization

(normPrioLinkUtilToIf/NUM) Normal traffic sending link 
utilization.

Incoming Normal Link 
Utilization

(normPrioLinkUtilFromIf/NUM) Normal traffic receiving link 
utilization.

Outgoing Priority Link 
Utilization

(highPrioLinkUtilToIf/NUM) Priority traffic sending link 
utilization.

Incoming Priority Link 
Utilization

(highPrioLinkUtilFromIf/NUM) Priority traffic receiving link 
utilization.

Octet Alignment Errors (nonOctetErrors/NUM)                      
DELTA

Number of non-octet aligned 
frames since last probe.

Octet Alignment Errors 
since Baseline

(nonOctetErrors/NUM)                      
BASELINEDELTA

Number of non-octet aligned 
frames since the last baseline 
reset.

Frame Length Errors (largeFrmErrors/NUM)                      
DELTA

Number of bad length frames 
since last probe.

Frame Length Errors since 
Baseline

(largeFrmErrors/NUM)                      
BASELINEDELTA

Number of bad length frames 
since the last baseline reset.

Frame Abort Errors (aborts/NUM)                      DELTA Number of aborted frames 
since last probe.

Frame Abort Errors since 
Baseline

(aborts/NUM)                      
BASELINEDELTA

Number of aborted frames 
since the last baseline reset.
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Table 20
Component: EM/ FRATM/ DLCI/

Name Formula Meaning

Frames per second 
Received

(frmFromIf/NUM)                      DELTA                      
SECONDS                      DIVIDE

Number of frames per second 
received from the interface 
since last probe.

Frames Received since 
Baseline

(frmFromIf/NUM)                      
BASELINEDELTA

Number of frames received 
from the interface since the 
last baseline reset.

DE Frames Received (deFrmFromIf/NUM)                      
DELTA

Number of frames received 
from the interface with the 
Discard Eligibility (DE) bit set 
since last probe.

DE Frames Received since 
Baseline

(deFrmFromIf/NUM)                      
BASELINEDELTA

Number of frames received 
from the interface with the 
Discard Eligibility (DE) bit set, 
since the last baseline reset.

Excess Frames Received (excessFrmFromIf/NUM)                      
DELTA

Number of frames, received 
from the interface with the 
Discard Eligibility (DE) bit 
clear, but subsequently set by 
the network due to rate 
enforcement, since the last 
probe.

Excess Frames Received 
since Baseline

(excessFrmFromIf/NUM)                      
BASELINEDELTA

Number of frames, received 
from the interface with the 
Discard Eligibility (DE) bit 
clear, but subsequently set by 
the network due to rate 
enforcement, since the last 
baseline reset.

Discard Excess Received 
per second

(discExcessFromIf/NUM)                      
DELTA                      SECONDS                      
DIVIDE

Number of frames discarded 
due to rate enforcement. 
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Discard Excess Received 
since Baseline

(discExcessFromIf/NUM)                      
BASELINEDELTA

Number of frames discarded 
due to rate enforcement, 
since the last baseline reset.

Discarded Frame A bit (discFrameAbit/NUM)                      
DELTA

Number of frames discarded 
at the Frame Relay Service 
due to an inactive PVC status 
in the direction toward the 
interworking function, since 
last probe.

Discarded Frame A bit 
since Baseline

(discFrameAbit/NUM)                      
BASELINEDELTA

Number of frames discarded 
at the Frame Relay Service 
due to an inactive PVC status 
in the direction toward the 
interworking function, since 
the last baseline reset.

Congested Frames 
Received Discarded

(discCongestedFromI/NUM)                      
DELTA

Number of frames discarded 
at the Frame Relay Service 
due to local congestion in the 
direction toward the 
interworking funcion, since 
last probe.

Congested Frames 
Received Discarded since 
Baseline

(discCongestedFromI/NUM)                      
BASELINEDELTA

Number of frames discarded 
at the Frame Relay Service 
due to local congestion in the 
direction toward the 
interworking funcion, since 
the last baseline reset.

Error short Frame 
Received

(errorShortFrmFromI/NUM)                      
DELTA

Number of frames received 
with 0 octets in the 
information field, since last 
probe.

Error short Frame 
Received since Baseline

(errorShortFrmFromIf/NUM)                      
BASELINEDELTA

Number of frames received 
with 0 octets in the 
information field, since the 
last baseline reset.

Table 20 (Continued)
Component: EM/ FRATM/ DLCI/

Name Formula Meaning
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Error Long Frame 
Received

(errorLongFrmFromIf/NUM)                      
DELTA

Number of frames received 
with the number of octets in 
the information field greater 
than the subscribed 
maximum, since last probe.

Error Long Frame 
Received since Baseline

(errorLongFrmFromIf/NUM)                      
BASELINEDELTA

Number of frames received 
with the number of octets in 
the information field greater 
than the subscribed 
maximum, since the last  
baseline reset.

Kilobytes Sent (bytesToIf/NUM)                      DELTA                      
1000                      DIVIDE

Number of bytes sent out to 
the interface, since last probe.

Kilobytes Sent since 
Baseline

(bytesToIf/NUM)                      
BASELINEDELTA                      1000                      
DIVIDE

Number of bytes sent out to 
the interface since the last 
baseline reset.

DE bytes (deBytesToIf/NUM)                      
DELTA

Number of bytes sent to the 
interface with Discard 
Eligibility (DE) bit set.

DE bytes since Baseline (deBytesToIf/NUM)                      
BASELINEDELTA

Number of bytes sent to the 
interface with Discard 
Eligibility (DE) bit set, since 
the last baseline reset.

Kilobytes Received (bytesFromIf/NUM)                      
DELTA                      1000                      
DIVIDE

Number of bytes received 
from the interface.

Kilobytes Received since 
Baseline

(bytesFromIf/NUM)                      
BASELINEDELTA                      1000                      
DIVIDE

Number of bytes received 
from the interface since the 
last baseline reset.

DE bytes received per 
second

(deBytesFromIf/NUM)                      
DELTA                      SECONDS                      
DIVIDE

Number of bytes per second 
received from the interface 
with Discard Eligibility (DE) bit 
set.

Table 20 (Continued)
Component: EM/ FRATM/ DLCI/

Name Formula Meaning
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DE bytes received since 
Baseline

(deBytesFromIf/NUM)                      
BASELINEDELTA

Number of bytes received 
from the interface with 
Discard Eligibility (DE) bit set, 
since the last baseline reset.

Excess bytes received per 
second

(excessBytesFromIf/NUM)                      
DELTA                      SECONDS                      
DIVIDE

Number of bytes per second 
received from the interface 
with the Discard Eligibility 
(DE) bit clear but 
sebsequently set by the 
network due to rate 
enforcement, since last 
probe.

Excess bytes received 
since Baseline

(excessBytesFromIf/NUM)                      
BASELINEDELTA

Number of bytes received 
from the interface with the 
Discard Eligibility (DE) bit 
clear but sebsequently set by 
the network due to  rate 
enforcement, since the last 
baseline reset.

Frame Discards for Rate 
Enforcement

(discExcessFromIfBy/NUM)                      
DELTA

Number of bytes discarded 
due to rate enforcement, 
since last probe.

Frame Discards for Rate 
Enforcement since 
Baseline

(discExcessFromIfBytes/NUM)                      
BASELINEDELTA

Number of bytes discarded 
due to rate enforcement since 
the last baseline reset.

Byte Discards due to A 
equals 0

(discByteAbit/NUM)                      
DELTA

Number of bytes discarded 
due to the A bit being turned 
off, since last probe.

Byte Discards due to A 
equals 0 since Baseline

(discByteAbit/NUM)                      
BASELINEDELTA

Number of bytes discarded 
due to the A bit being turned 
off since the  last baseline 
reset.

Table 20 (Continued)
Component: EM/ FRATM/ DLCI/

Name Formula Meaning
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Discarded congested 
received

(discCongestedFromI/NUM)                      
DELTA

Number of bytes discarded at 
the Frame Relay service due 
to local congestion in the 
direction toward the 
interworking function, since 
last probe.

Discarded congested 
received since Baseline

(discCongestedFromIfBytes/NUM)                      
BASELINEDELTA

Number of bytes discarded at 
the Frame Relay service due 
to local congestion in the 
direction toward the 
interworking function, since 
the last baseline reset.

DE Discarded congested 
received

(discDeCongestedFro/NUM)                      
DELTA

Number of bytes discarded 
with Discard Eligibility set due 
to local congestion in the 
direction toward the 
interworking fucntion, since 
last probe.

DE Discarded congested 
received since Baseline

(discDeCongestedFromIfBytes/
NUM)                      BASELINEDELTA

Number of bytes discarded 
with Discard Eligibility set due 
to local congestion in the 
direction toward the 
interworking fucntion, since 
the last baseline reset.

Error Long Bytes received (errorLongBytesFrom/NUM)                      
DELTA

Number of bytes received 
when the number of octets in 
the information  field is 
greater than the subscribed 
maximum, since last probe.

Error Long Bytes received 
since Baseline

(errorLongBytesFromIf/NUM)                      
BASELINEDELTA

Number of bytes received 
when the number of octets in 
the information  field is 
greater than the subscribed 
maximum, since the last 
baseline  reset.

Table 20 (Continued)
Component: EM/ FRATM/ DLCI/

Name Formula Meaning
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Total Ingress Bytes (totalIngressBytes/NUM)                      
DELTA

Total payload bytes in 
received from link since the 
start of interval.

Total Ingress Bytes since 
Baseline

(totalIngressBytes/NUM)                      
BASELINEDELTA

Total payload bytes in 
received from link since the 
last baseline reset.

Total Egress Bytes (totalEgressBytes/NUM)                      
DELTA

Total payload bytes sent to 
link since start of interval.

Total Egress Bytes since 
Baseline

(totalEgressBytes/NUM)                      
BASELINEDELTA

Total payload bytes sent to 
link since the last baseline 
reset.

EIR Ingress Bytes (eirIngressBytes/NUM)                      
DELTA

Total valid payload bytes in 
frames with Discard Eligibility 
(DE) bit  set to 1 received 
from link since start of 
interval.

EIR Ingress Bytes since 
Baseline

(eirIngressBytes/NUM)                      
BASELINEDELTA

Total valid payload bytes in 
frames with Discard Eligibility 
(DE) bit  set to 1 received 
from link, since the last 
baseline reset.

EIR Egress Bytes (eirEgressBytes/NUM)                      
DELTA

Total valid payload bytes in 
frames with Discard Eligibility 
(DE) bit  set sent to link since 
start of interval.

EIR Egress Bytes since 
Baseline

(eirEgressBytes/NUM)                      
BASELINEDELTA

Total valid payload bytes in 
frames with Discard Eligibility 
(DE) bit  set sent to link, since 
the last baseline reset.

Discarded Bytes (discardedBytes/NUM)                      
DELTA

Total payload bytes in invalid 
frames received from the link 
and siscarded at the DLCI 
since start of interval.

Table 20 (Continued)
Component: EM/ FRATM/ DLCI/

Name Formula Meaning
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Discarded Bytes since 
Baseline

(discardedBytes/NUM)                      
BASELINEDELTA

Total payload bytes in invalid 
frames received from the link 
and siscarded at the DLCI, 
since the last baseline reset.

Total Ingress frames (totalIngressFrames/NUM)                      
DELTA

Total number of frames 
received from the link since 
start of interval.

Total Ingress frames since 
Baseline

(totalIngressFrames/NUM)                      
BASELINEDELTA

Total number of frames 
received from the link since 
the last baseline  reset.

Total Egress frames (totalEgressFrames/NUM)                      
DELTA

Total number of frames sent 
to the link since the start of 
interval.

Total Egress frames since 
Baseline

(totalEgressFrames/NUM)                      
BASELINEDELTA

Total number of frames sent 
to the link since the last 
baseline reset.

EIR Ingress frames (eirIngressFrames/NUM)                      
DELTA

Number of valid frames with 
Discard Eligibility set to 1, 
received from link since start 
of interval.

EIR Ingress frames since 
Baseline

(eirIngressFrames/NUM)                      
BASELINEDELTA

Number of valid frames with 
Discard Eligibility set to 1, 
received from link, since the 
last baseline reset.

EIR Egress frames (eirEgressFrames/NUM)                      
DELTA

Number of frames with 
Discard Eligibility bit set sent 
to the link since start of 
interval.

EIR Egress frames since 
Baseline

(eirEgressFrames/NUM)                      
BASELINEDELTA

Number of frames with 
Discard Eligibility bit set sent 
to the link, since the last 
baseline reset.

Table 20 (Continued)
Component: EM/ FRATM/ DLCI/

Name Formula Meaning
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Discarded Frames (discardedFrames/NUM)                      
DELTA

Number of invalid frames 
received from the links and 
discarded at the  DLCI.

Discarded Frames since 
Baseline

(discardedFrames/NUM)                      
BASELINEDELTA

Number of invalid frames 
received from the links and 
discarded at the  DLCI, since 
the last baseline reset.

Table 20 (Continued)
Component: EM/ FRATM/ DLCI/

Name Formula Meaning
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Table 21
Component: EM/ FRATM/ FRAMER

Name Formula Meaning

Frames per second Sent (frmToIf/NUM)                      DELTA                      
SECONDS                      DIVIDE

The number of frames per 
second transmitted to the link 
interface by Framer since last 
probe.

Frames Sent since 
Baseline

(frmToIf/NUM)                      
BASELINEDELTA

The number of frames 
transmitted to the link 
interface by Framer since the 
last baseline reset.

Frames per second 
Received

(frmFromIf/NUM)                      DELTA                      
SECONDS                      DIVIDE

The number of frames 
received from the link 
interface by Framer since the 
last probe.

Frames Received since 
Baseline

(frmFromIf/NUM)                      
BASELINEDELTA

The number of frames 
received from the link 
interface by Framer since  the 
last baseline reset.

CRC Errors (crcErrors/NUM)                      DELTA Number of frames with CRC 
errors occurring in the receive 
direction from the link since 
the last probe.

CRC Errors since Baseline (crcErrors/NUM)                      
BASELINEDELTA

Number of frames with CRC 
errors occurring in the receive 
direction from the link, since 
the last baseline reset.

LRC Errors (lrcErrors/NUM)                      DELTA Number of frames with LRC 
errors occurring in the Tx link 
prior to transmission onto the 
link since the last probe.

LRC Errors since Baseline (lrcErrors/NUM)                      
BASELINEDELTA

Number of frames with LRC 
errors occurring in the Tx link 
prior to transmission onto the 
link, since the last baseline 
reset.
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Overruns (overruns/NUM)                      DELTA Number of frames received 
from the link for which 
overruns occurred since last 
probe.

Overruns since Baseline (overruns/NUM)                      
BASELINEDELTA

Number of frames received 
from the link for which 
overruns occurred, since the 
last baseline reset.

Underruns (underruns/NUM)                      DELTA Number of frames transmitted 
to the link for which underruns 
occurred since last probe.

Underruns since Baseline (underruns/NUM)                      
BASELINEDELTA

Number of frames transmitted 
to the link for which underruns 
occurred, since the last 
baseline reset.

Frame Length Errors (largeFrmErrors/NUM)                      
DELTA

Number of frames received 
that were too large since last 
probe.

Frame Length Errors since 
Baseline

(largeFrmErrors/NUM)                      
BASELINEDELTA

Number of frames received 
that were too large since the 
last baseline  reset.

Table 21 (Continued)
Component: EM/ FRATM/ FRAMER

Name Formula Meaning
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Table 22
Component: EM/ FRDTE/ DLCI/

Name Formula Meaning

Frames per second Sent (sentFrames/NUM)                      
DELTA                      SECONDS                      
DIVIDE

Frames sent per second.

Frames Sent since 
Baseline

(sentFrames/NUM)                      
BASELINEDELTA

Frames sent since the last 
baseline reset.

Frames per second 
Received

(receivedFrames/NUM)                      
DELTA                      SECONDS                      
DIVIDE

Frames received per second.

Frames Received since 
Baseline

(receivedFrames/NUM)                      
BASELINEDELTA

Frames received since the 
last baseline reset.

Kilobytes Sent (sentOctets/NUM)                      
DELTA                      1000                      
DIVIDE

KiloBytes sent since the last 
probe.

Kilobytes Sent since 
Baseline

(sentOctets/NUM)                      
BASELINEDELTA                      1000                      
DIVIDE

KiloBytes sent since the last 
baseline reset.

Kilobytes Received (receivedOctets/NUM)                      
DELTA                      1000                      
DIVIDE

KiloBytes received since the 
last probe.

Kilobytes Received since 
Baseline

(receivedOctets/NUM)                      
BASELINEDELTA                      1000                      
DIVIDE

KiloBytes received since the 
last baseline reset.

FECN Frames Received (receivedFECNs/NUM)                      
DELTA

Frames received with FECN 
bit set.

FECN Frames Received 
since Baseline

(receivedFECNs/NUM)                      
BASELINEDELTA

Frames received with FECN 
bit set since the last baseline 
reset.
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BECN Frames Received (receivedBECNs/NUM)                      
DELTA

Frames received with BECN 
bit set.

BECN Frames Received 
since Baseline

(receivedBECNs/NUM)                      
BASELINEDELTA

Frames received with BECN 
bit set since the last baseline 
reset.

Table 22 (Continued)
Component: EM/ FRDTE/ DLCI/

Name Formula Meaning
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Table 23
Component: EM/ FRDTE/ FRAMER

Name Formula Meaning

Frames per second Sent (frmToIf/NUM)                      DELTA                      
SECONDS                      DIVIDE

Frames sent per second.

Frames Sent since 
Baseline

(frmToIf/NUM)                      
BASELINEDELTA

Frames sent since the last 
baseline reset.

Frames per second 
Received

(frmFromIf/NUM)                      DELTA                      
SECONDS                      DIVIDE

Frames received per second.

Frames Received since 
Baseline

(frmFromIf/NUM)                      
BASELINEDELTA

Frames received since the 
last baseline reset.

Outgoing Normal Link 
Utilization

(normPrioLinkUtilToIf/NUM) Normal traffic sending link 
utilization.

Incoming Normal Link 
Utilization

(normPrioLinkUtilFromIf/NUM) Normal traffic receiving link 
utilization.

Octet Alignment Errors (nonOctetErrors/NUM)                      
DELTA

Number of non-octet aligned 
frames since last probe.

Octet Alignment Errors 
since Baseline

(nonOctetErrors/NUM)                      
BASELINEDELTA

Number of non-octet aligned 
frames since the last baseline 
reset.

Frame Length Errors (largeFrmErrors/NUM)                      
DELTA

Number of bad length frames 
since last probe.

Frame Length Errors since 
Baseline

(largeFrmErrors/NUM)                      
BASELINEDELTA

Number of bad length frames 
since the last baseline reset.

Frame Abort Errors (aborts/NUM)                      DELTA Number of aborted frames 
since last probe.

Frame Abort Errors since 
Baseline

(aborts/NUM)                      
BASELINEDELTA

Number of aborted frames 
since the last baseline reset.
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Table 24
Component: EM/ FRDTE/ VFRAMER

Name Formula Meaning

Frames per second Sent (frmToOtherVFramer/NUM)                      
DELTA                      SECONDS                      
DIVIDE

Frames sent per second.

Frames Sent since 
Baseline

(frmToOtherVFramer/NUM)                      
BASELINEDELTA

Frames sent since the last 
baseline reset.

Frames per second 
Received

(frmFromOtherVFramer/NUM)                      
DELTA                      SECONDS                      
DIVIDE

Frames received per second.

Frames Received since 
Baseline

(frmFromOtherVFramer/NUM)                      
BASELINEDELTA

Frames received since the 
last baseline reset.

Table 25
Component: EM/ FRNNI/

Name Formula Meaning

Frame Header Format 
Errors

(invalidHeaderFramesFromIf/
NUM)                      DELTA

Number of frames with invalid 
headers since last probe.

Frame Header Format 
Errors since Baseline

(invalidHeaderFramesFromIf/
NUM)                      BASELINEDELTA

Number of frames with invalid 
headers since the last 
baseline reset.

Unknown DLCI Errors (unknownDlciFramesFromIf/NUM)                      
DELTA

Number of frames with 
unknown DLCI since last 
probe.

Unknown DLCI Errors 
since Baseline

(unknownDlciFramesFromIf/NUM)                      
BASELINEDELTA

Number of frames with 
unknown DLCI since the last 
baseline reset.

Last Unknown DLCI (lastUnknownDlci/NUM) DLCI of the last unknown 
DLCI frame. 
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Frames To I/F (frmToIfByQueue[0]/NUM)                      
DELTA                      
(frmToIfByQueue[1]/NUM)                      
DELTA                      
(frmToIfByQueue[2]/NUM)                      
DELTA                      
(frmToIfByQueue[3]/NUM)                      
DELTA                      ADD                      
ADD                      ADD

Number of frames transmitted 
to the interface through all 
egress queues.

Frames To I/F since 
Baseline

(frmToIfByQueue[0]/NUM)                      
BASELINEDELTA                      
(frmToIfByQueue[1]/NUM)                      
BASELINEDELTA                      
(frmToIfByQueue[2]/NUM)                      
BASELINEDELTA                      
(frmToIfByQueue[3]/NUM)                      
BASELINEDELTA                      ADD                      
ADD                      ADD

Number of frames transmitted 
to the interface through all 
egress queues since the last 
baseline reset.

Octecs To I/F (octetToIfByQueue[0]/NUM)                      
DELTA                      
(octetToIfByQueue[1]/NUM)                      
DELTA                      
(octetToIfByQueue[2]/NUM)                      
DELTA                      
(octetToIfByQueue[3]/NUM)                      
DELTA                      ADD                      
ADD                      ADD

Number of octets transmitted 
to the interface through all 
egress queues.

Octecs To I/F since 
Baseline

(octetToIfByQueue[0]/NUM)                      
BASELINEDELTA                      
(octetToIfByQueue[1]/NUM)                      
BASELINEDELTA                      
(octetToIfByQueue[2]/NUM)                      
BASELINEDELTA                      
(octetToIfByQueue[3]/NUM)                      
BASELINEDELTA                      ADD                      
ADD                      ADD

Number of octets transmitted 
to the interface through all 
egress queues since the last 
baseline reset.

Table 25 (Continued)
Component: EM/ FRNNI/

Name Formula Meaning
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Table 26
Component: EM/ FRNNI/ DLCI/

Name Formula Meaning

Frames per second Sent (frmToIf/NUM)                      DELTA                      
SECONDS                      DIVIDE

Frames sent per second.

Frames Sent since 
Baseline

(frmToIf/NUM)                      
BASELINEDELTA

Frames sent since the last 
baseline reset.

Frames per second 
Received

(frmFromIf/NUM)                      DELTA                      
SECONDS                      DIVIDE

Frames received per second.

Frames Received since 
Baseline

(frmFromIf/NUM)                      
BASELINEDELTA

Frames received since the 
last baseline reset.

Kilobytes Sent (bytesToIf/NUM)                      DELTA                      
1000                      DIVIDE

KiloBytes sent since the last 
probe.

Kilobytes Sent since 
Baseline

(bytesToIf/NUM)                      
BASELINEDELTA                      1000                      
DIVIDE

KiloBytes sent since the last 
baseline reset.

Kilobytes Received (bytesFromIf/NUM)                      
DELTA                      1000                      
DIVIDE

KiloBytes received since the 
last probe.

Kilobytes Received since 
Baseline

(bytesFromIf/NUM)                      
BASELINEDELTA                      1000                      
DIVIDE

KiloBytes received since the 
last baseline reset.

Average Payload Size Sent (bytesToIf/NUM)                      DELTA                      
(frmToIf/NUM)                      DELTA                      
DIVIDE

Average size of frames in 
bytes sent out from the 
interface.

Average Payload Size Sent 
since Baseline

(bytesToIf/NUM)                      
BASELINEDELTA                      
(frmToIf/NUM)                      
BASELINEDELTA                      
DIVIDE

Average size of frames in 
bytes sent out from the 
interface since the  last 
baseline reset.

Average Payload Size 
Received

(bytesFromIf/NUM)                      
DELTA                      (frmFromIf/NUM)                      
DELTA                      DIVIDE

Average size of frames in 
bytes received from the 
interface.
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Average Payload Size 
Received since Baseline

(bytesFromIf/NUM)                      
BASELINEDELTA                      
(frmFromIf/NUM)                      
BASELINEDELTA                      
DIVIDE

Average size of frames in 
bytes received from the 
interface since the  last 
baseline reset.

Kilobits per second Sent (bytesToIf/NUM)                      DELTA                      
8                      MULTIPLY                      
SECONDS                      DIVIDE                      
1000                      DIVIDE

Kilobits per second sent.

Kilobits Sent since 
Baseline

(bytesToIf/NUM)                      
BASELINEDELTA                      8                      
MULTIPLY                      1000                      
DIVIDE

Kilobits sent since the last 
baseline reset.

Kilobits per second 
Received

(bytesFromIf/NUM)                      
DELTA                      8                      
MULTIPLY                      SECONDS                      
DIVIDE                      1000                      
DIVIDE

Kilobits per second received.

Kilobits Received since 
Baseline

(bytesFromIf/NUM)                      
BASELINEDELTA                      8                      
MULTIPLY                      1000                      
DIVIDE

Kilobits received since the 
last baseline reset.

Rx Utilization (% of CIR) (bytesFromIf/NUM)                      
DELTA                      8                      
MULTIPLY                      SECONDS                      
DIVIDE                      
(committedInformationRate/NUM)                      
PERCENT

Percentage of CIR used 
receiving.

Tx Bytes Discarded (discCongestedToIfBytes/NUM)                      
DELTA

Bytes sent dropped due to 
congestion.

Tx Bytes Discarded since 
Baseline

(discCongestedToIfBytes/NUM)                      
BASELINEDELTA

Bytes sent dropped due to 
congestion since the last 
baseline reset.

Table 26 (Continued)
Component: EM/ FRNNI/ DLCI/

Name Formula Meaning
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Rx Bytes Discarded (discExcessFromIfBytes/NUM)                      
DELTA                      (discByteAbit/
NUM)                      DELTA                      
ADD                      
(discCongestedFromIfBytes/NUM)                      
DELTA                      ADD                      
(errorLongBytesFromIf/NUM)                      
DELTA                      ADD

Bytes received dropped.

Rx Bytes Discarded since 
Baseline

(discExcessFromIfBytes/NUM)                      
BASELINEDELTA                      
(discByteAbit/NUM)                      
BASELINEDELTA                      ADD                      
(discCongestedFromIfBytes/NUM)                      
BASELINEDELTA                      ADD                      
(errorLongBytesFromIf/NUM)                      
BASELINEDELTA                      ADD

Bytes received dropped since 
the last baseline reset.

Frame Discards due to A 
equals 0

(discFrameAbit/NUM)                      
DELTA

Received frames discarded 
due to zero A bit.

Frame Discards due to A 
equals 0 since Baseline

(discFrameAbit/NUM)                      
BASELINEDELTA

Received frames discarded 
due to zero A bit since the last 
baseline reset.

Frame Discards due to 
Frame Error

(errorShortFrmFromIf/NUM)                      
DELTA                      
(errorLongFrmFromIf/NUM)                      
DELTA                      ADD

Received frames discarded 
due to length errors.

Frame Discards due to 
Frame Error since Baseline

(errorShortFrmFromIf/NUM)                      
BASELINEDELTA                      
(errorLongFrmFromIf/NUM)                      
BASELINEDELTA                      ADD

Received frames discarded 
due to length errors since the 
last baseline reset.

Frame Discards for Rate 
Enforcement

(discExcessFromIf/NUM)                      
DELTA

Received frames discarded 
by rate enforcement.

Frame Discards for Rate 
Enforcement since 
Baseline

(discExcessFromIf/NUM)                      
BASELINEDELTA

Received frames discarded 
by rate enforcement since the 
last baseline  reset.

Table 26 (Continued)
Component: EM/ FRNNI/ DLCI/

Name Formula Meaning
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Byte Discards due to A 
equals 0

(discByteAbit/NUM)                      
DELTA

Received Bytes discarded 
due to zero A bit. 

Byte Discards due to A 
equals 0 since Baseline

(discByteAbit/NUM)                      
BASELINEDELTA

Received Bytes discarded 
due to zero A bit since the last 
baseline reset.

Byte Discards due to 
Frame Error

(errorLongBytesFromIf/NUM)                      
DELTA

Received Bytes discarded 
due to frame length error.

Byte Discards due to 
Frame Error since Baseline

(errorLongBytesFromIf/NUM)                      
BASELINEDELTA

Received Bytes discarded 
due to frame length error 
since the last baseline reset.

Byte Discards for Rate 
Enforcement

(discExcessFromIfBytes/NUM)                      
DELTA

Received bytes discarded by 
rate enforcement.

Byte Discards for Rate 
Enforcement since 
Baseline

(discExcessFromIfBytes/NUM)                      
BASELINEDELTA

Received bytes discarded by 
rate enforcement since the 
last baseline reset.

FECN Frames Sent (fecnFrmToIf/NUM)                      
DELTA

Frames sent with FECN bit 
set.

FECN Frames Sent since 
Baseline

(fecnFrmToIf/NUM)                      
BASELINEDELTA

Frames sent with FECN bit 
set since the last baseline 
reset.

FECN Frames Received (fecnFrmFromIf/NUM)                      
DELTA

Frames received with FECN 
bit set.

FECN Frames Received 
since Baseline

(fecnFrmFromIf/NUM)                      
BASELINEDELTA

Frames received with FECN 
bit set since the last baseline 
reset.

BECN Frames Sent (becnFrmToIf/NUM)                      
DELTA

Frames sent with BECN bit 
set.

BECN Frames Sent since 
Baseline

(becnFrmToIf/NUM)                      
BASELINEDELTA

Frames sent with BECN bit 
set since the last baseline 
reset.

Table 26 (Continued)
Component: EM/ FRNNI/ DLCI/

Name Formula Meaning
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BECN Frames Received (becnFrmFromIf/NUM)                      
DELTA

Frames received with BECN 
bit set.

BECN Frames Received 
since Baseline

(becnFrmFromIf/NUM)                      
BASELINEDELTA

Frames received with BECN 
bit set since the last baseline 
reset.

DE Frames Sent (deFrmToIf/NUM)                      
DELTA

Frames sent with DE bit set.

DE Frames Sent since 
Baseline

(deFrmToIf/NUM)                      
BASELINEDELTA

Frames sent with DE bit set 
since the last baseline reset.

DE Frames Received (deFrmFromIf/NUM)                      
DELTA

Frames received with DE bit 
set.

DE Frames Received since 
Baseline

(deFrmFromIf/NUM)                      
BASELINEDELTA

Frames received with DE bit 
set since the last baseline 
reset.

Congested Frames Sent 
Discarded

(discCongestedToIf/NUM)                      
DELTA

Sent frames discarded due to 
congestion.

Congested Frames Sent 
Discarded since Baseline

(discCongestedToIf/NUM)                      
BASELINEDELTA

Sent frames discarded due to 
congestion since the last 
baseline reset.

Congested Frames 
Received Discarded

(discCongestedFromIf/NUM)                      
DELTA

Received frames discarded 
due to congestion.

Congested Frames 
Received Discarded since 
Baseline

(discCongestedFromIf/NUM)                      
BASELINEDELTA

Received frames discarded 
due to congestion since the 
last baseline reset.

Excess Frames Received (excessFrmFromIf/NUM)                      
DELTA

Number of excess frames.

Excess Frames Received 
since Baseline

(excessFrmFromIf/NUM)                      
BASELINEDELTA

Number of excess frames 
since the last baseline reset.

Table 26 (Continued)
Component: EM/ FRNNI/ DLCI/

Name Formula Meaning
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Table 27
Component: EM/ FRNNI/ FRAMER

Name Formula Meaning

Frames per second Sent (frmToIf/NUM)                      DELTA                      
SECONDS                      DIVIDE

Frames sent per second.

Frames Sent since 
Baseline

(frmToIf/NUM)                      
BASELINEDELTA

Frames sent since the last 
baseline reset.

Frames per second 
Received

(frmFromIf/NUM)                      DELTA                      
SECONDS                      DIVIDE

Frames received per second.

Frames Received since 
Baseline

(frmFromIf/NUM)                      
BASELINEDELTA

Frames received since the 
last baseline reset.

Outgoing Normal Link 
Utilization

(normPrioLinkUtilToIf/NUM) Normal traffic sending link 
utilization.

Incoming Normal Link 
Utilization

(normPrioLinkUtilFromIf/NUM) Normal traffic receiving link 
utilization.

Octet Alignment Errors (nonOctetErrors/NUM)                      
DELTA

Number of non-octet aligned 
frames since last probe.

Octet Alignment Errors 
since Baseline

(nonOctetErrors/NUM)                      
BASELINEDELTA

Number of non-octet aligned 
frames since the last baseline 
reset.

Frame Length Errors (largeFrmErrors/NUM)                      
DELTA

Number of bad length frames 
since last probe. 

Frame Length Errors since 
Baseline

(largeFrmErrors/NUM)                      
BASELINEDELTA

Number of bad length frames 
since the last baseline reset.

Frame Abort Errors (aborts/NUM)                      DELTA Number of aborted frames 
since last probe.

Frame Abort Errors since 
Baseline

(aborts/NUM)                      
BASELINEDELTA

Number of aborted frames 
since the last baseline reset.
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Table 28
Component: EM/ FRNNI/ LMI

Name Formula Meaning

Status Reports Tx (keepAliveStatusToIf/NUM)                      
DELTA                      (fullStatusToIf/
NUM)                      DELTA                      
ADD

Number of status reports sent 
since last probe.

Status Reports Tx since 
Baseline

(keepAliveStatusToIf/NUM)                      
BASELINEDELTA                      
(fullStatusToIf/NUM)                      
BASELINEDELTA                      ADD

Number of status reports sent 
since the last baseline reset.

Status Enquiries Rx (keepAliveSeFromIf/NUM)                      
DELTA                      
(fullStatEnqFromIf/NUM)                      
DELTA                      ADD

Number of status reports 
received since last probe.

Status Enquiries Rx since 
Baseline

(keepAliveSeFromIf/NUM)                      
BASELINEDELTA                      
(fullStatEnqFromIf/NUM)                      
BASELINEDELTA                      ADD

Number of status reports 
received since the last 
baseline reset.

Sequence Number 
Mismatches

(sequenceErrors/NUM) Number of Status enquiries 
with a sequence error.

Invalid Requests (unexpectedIes/NUM) Number of frames received 
with an unknown/unexpected 
IES.

Timeouts (pollingVerifTimeouts/NUM)                      
(noStatusReportCount/NUM)                      
ADD

Number of checkPointTimer 
expired.
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Table 29
Component: EM/ FRNNI/ VFRAMER

Name Formula Meaning

Frames per second Sent (frmToOtherVFramer/NUM)                      
DELTA                      SECONDS                      
DIVIDE

Frames sent per second.

Frames Sent since 
Baseline

(frmToOtherVFramer/NUM)                      
BASELINEDELTA

Frames sent since the last 
baseline reset.

Frames per second 
Received

(frmFromOtherVFramer/NUM)                      
DELTA                      SECONDS                      
DIVIDE

Frames received per second.

Frames Received since 
Baseline

(frmFromOtherVFramer/NUM)                      
BASELINEDELTA

Frames received since the 
last baseline reset.

Table 30
Component: EM/ FRUNI/

Name Formula Meaning

Frame Header Format 
Errors

(invalidHeaderFramesFromIf/
NUM)                      DELTA

Number of frames with invalid 
headers since last probe.

Frame Header Format 
Errors since Baseline

(invalidHeaderFramesFromIf/
NUM)                      BASELINEDELTA

Number of frames with invalid 
headers since the last 
baseline reset.

Unknown DLCI Errors (unknownDlciFramesFromIf/NUM)                      
DELTA

Number of frames with 
unknown DLCI since last 
probe.

Unknown DLCI Errors 
since Baseline

(unknownDlciFramesFromIf/NUM)                      
BASELINEDELTA

Number of frames with 
unknown DLCI since the last 
baseline reset.

Last Unknown DLCI (lastUnknownDlci/NUM) DLCI of the last unknown 
DLCI frame. 

 (Sheet 1 of 2)
241-6001-031   15.1    



Appendix A Passport performance metrics   183
Frames To I/F (frmToIfByQueue[0]/NUM)                      
DELTA                      
(frmToIfByQueue[1]/NUM)                      
DELTA                      
(frmToIfByQueue[2]/NUM)                      
DELTA                      
(frmToIfByQueue[3]/NUM)                      
DELTA                      ADD                      
ADD                      ADD

Number of frames transmitted 
to the interface through all 
egress queues.

Frames To I/F since 
Baseline

(frmToIfByQueue[0]/NUM)                      
BASELINEDELTA                      
(frmToIfByQueue[1]/NUM)                      
BASELINEDELTA                      
(frmToIfByQueue[2]/NUM)                      
BASELINEDELTA                      
(frmToIfByQueue[3]/NUM)                      
BASELINEDELTA                      ADD                      
ADD                      ADD

Number of frames transmitted 
to the interface through all 
egress queues since the last 
baseline reset.

Octecs To I/F (octetToIfByQueue[0]/NUM)                      
DELTA                      
(octetToIfByQueue[1]/NUM)                      
DELTA                      
(octetToIfByQueue[2]/NUM)                      
DELTA                      
(octetToIfByQueue[3]/NUM)                      
DELTA                      ADD                      
ADD                      ADD

Number of octets transmitted 
to the interface through all 
egress queues.

Octecs To I/F since 
Baseline

(octetToIfByQueue[0]/NUM)                      
BASELINEDELTA                      
(octetToIfByQueue[1]/NUM)                      
BASELINEDELTA                      
(octetToIfByQueue[2]/NUM)                      
BASELINEDELTA                      
(octetToIfByQueue[3]/NUM)                      
BASELINEDELTA                      ADD                      
ADD                      ADD

Number of octets transmitted 
to the interface through all 
egress queues since the last 
baseline reset.

Table 30 (Continued)
Component: EM/ FRUNI/

Name Formula Meaning
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Table 31
Component: EM/ FRUNI/ DLCI/

Name Formula Meaning

Frames per second Sent (frmToIf/NUM)                      DELTA                      
SECONDS                      DIVIDE

Frames sent per second.

Frames Sent since 
Baseline

(frmToIf/NUM)                      
BASELINEDELTA

Frames sent since the last 
baseline reset.

Frames per second 
Received

(frmFromIf/NUM)                      DELTA                      
SECONDS                      DIVIDE

Frames received per second.

Frames Received since 
Baseline

(frmFromIf/NUM)                      
BASELINEDELTA

Frames received since the 
last baseline reset.

Kilobytes Sent (bytesToIf/NUM)                      DELTA                      
1000                      DIVIDE

KiloBytes sent since the last 
probe.

Kilobytes Sent since 
Baseline

(bytesToIf/NUM)                      
BASELINEDELTA                      1000                      
DIVIDE

KiloBytes sent since the last 
baseline reset.

Kilobytes Received (bytesFromIf/NUM)                      
DELTA                      1000                      
DIVIDE

KiloBytes received since the 
last probe.

Kilobytes Received since 
Baseline

(bytesFromIf/NUM)                      
BASELINEDELTA                      1000                      
DIVIDE

KiloBytes received since the 
last baseline reset.

Average Payload Size Sent (bytesToIf/NUM)                      DELTA                      
(frmToIf/NUM)                      DELTA                      
DIVIDE

Average size of frames in 
bytes sent out from the 
interface.

Average Payload Size Sent 
since Baseline

(bytesToIf/NUM)                      
BASELINEDELTA                      
(frmToIf/NUM)                      
BASELINEDELTA                      
DIVIDE

Average size of frames in 
bytes sent out from the 
interface since the  last 
baseline reset.

Average Payload Size 
Received

(bytesFromIf/NUM)                      
DELTA                      (frmFromIf/NUM)                      
DELTA                      DIVIDE

Average size of frames in 
bytes received from the 
interface.
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Average Payload Size 
Received since Baseline

(bytesFromIf/NUM)                      
BASELINEDELTA                      
(frmFromIf/NUM)                      
BASELINEDELTA                      
DIVIDE

Average size of frames in 
bytes received from the 
interface since the  last 
baseline reset.

Kilobits per second Sent (bytesToIf/NUM)                      DELTA                      
8                      MULTIPLY                      
SECONDS                      DIVIDE                      
1000                      DIVIDE

Kilobits per second sent.

Kilobits Sent since 
Baseline

(bytesToIf/NUM)                      
BASELINEDELTA                      8                      
MULTIPLY                      1000                      
DIVIDE

Kilobits sent since the last 
baseline reset.

Kilobits per second 
Received

(bytesFromIf/NUM)                      
DELTA                      8                      
MULTIPLY                      SECONDS                      
DIVIDE                      1000                      
DIVIDE

Kilobits per second received.

Kilobits Received since 
Baseline

(bytesFromIf/NUM)                      
BASELINEDELTA                      8                      
MULTIPLY                      1000                      
DIVIDE

Kilobits received since the 
last baseline reset.

Rx Utilization (% of CIR) (bytesFromIf/NUM)                      
DELTA                      8                      
MULTIPLY                      SECONDS                      
DIVIDE                      
(committedInformationRate/NUM)                      
PERCENT

Percentage of CIR used 
receiving.

Tx Bytes Discarded (discCongestedToIfBytes/NUM)                      
DELTA

Bytes sent dropped due to 
congestion.

Tx Bytes Discarded since 
Baseline

(discCongestedToIfBytes/NUM)                      
BASELINEDELTA

Bytes sent dropped due to 
congestion since the last 
baseline reset.

Table 31 (Continued)
Component: EM/ FRUNI/ DLCI/

Name Formula Meaning
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Rx Bytes Discarded (discExcessFromIfBytes/NUM)                      
DELTA                      (discByteAbit/
NUM)                      DELTA                      
ADD                      
(discCongestedFromIfBytes/NUM)                      
DELTA                      ADD                      
(errorLongBytesFromIf/NUM)                      
DELTA                      ADD

Bytes received dropped.

Rx Bytes Discarded since 
Baseline

(discExcessFromIfBytes/NUM)                      
BASELINEDELTA                      
(discByteAbit/NUM)                      
BASELINEDELTA                      ADD                      
(discCongestedFromIfBytes/NUM)                      
BASELINEDELTA                      ADD                      
(errorLongBytesFromIf/NUM)                      
BASELINEDELTA                      ADD

Bytes received dropped since 
the last baseline reset.

Frame Discards due to A 
equals 0

(discFrameAbit/NUM)                      
DELTA

Received frames discarded 
due to zero A bit.

Frame Discards due to A 
equals 0 since Baseline

(discFrameAbit/NUM)                      
BASELINEDELTA

Received frames discarded 
due to zero A bit since the last 
baseline reset.

Frame Discards due to 
Frame Error

(errorShortFrmFromIf/NUM)                      
DELTA                      
(errorLongFrmFromIf/NUM)                      
DELTA                      ADD

Received frames discarded 
due to length errors.

Frame Discards due to 
Frame Error since Baseline

(errorShortFrmFromIf/NUM)                      
BASELINEDELTA                      
(errorLongFrmFromIf/NUM)                      
BASELINEDELTA                      ADD

Received frames discarded 
due to length errors since the 
last baseline reset.

Frame Discards for Rate 
Enforcement

(discExcessFromIf/NUM)                      
DELTA

Received frames discarded 
by rate enforcement.

Frame Discards for Rate 
Enforcement since 
Baseline

(discExcessFromIf/NUM)                      
BASELINEDELTA

Received frames discarded 
by rate enforcement since the 
last baseline  reset.

Table 31 (Continued)
Component: EM/ FRUNI/ DLCI/

Name Formula Meaning
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Byte Discards due to A 
equals 0

(discByteAbit/NUM)                      
DELTA

Received Bytes discarded 
due to zero A bit. 

Byte Discards due to A 
equals 0 since Baseline

(discByteAbit/NUM)                      
BASELINEDELTA

Received Bytes discarded 
due to zero A bit since the last 
baseline reset.

Byte Discards due to 
Frame Error

(errorLongBytesFromIf/NUM)                      
DELTA

Received Bytes discarded 
due to frame length error.

Byte Discards due to 
Frame Error since Baseline

(errorLongBytesFromIf/NUM)                      
BASELINEDELTA

Received Bytes discarded 
due to frame length error 
since the last baseline reset.

Byte Discards for Rate 
Enforcement

(discExcessFromIfBytes/NUM)                      
DELTA

Received bytes discarded by 
rate enforcement.

Byte Discards for Rate 
Enforcement since 
Baseline

(discExcessFromIfBytes/NUM)                      
BASELINEDELTA

Received bytes discarded by 
rate enforcement since the 
last baseline reset.

FECN Frames Sent (fecnFrmToIf/NUM)                      
DELTA

Frames sent with FECN bit 
set.

FECN Frames Sent since 
Baseline

(fecnFrmToIf/NUM)                      
BASELINEDELTA

Frames sent with FECN bit 
set since the last baseline 
reset.

FECN Frames Received (fecnFrmFromIf/NUM)                      
DELTA

Frames received with FECN 
bit set.

FECN Frames Received 
since Baseline

(fecnFrmFromIf/NUM)                      
BASELINEDELTA

Frames received with FECN 
bit set since the last baseline 
reset.

BECN Frames Sent (becnFrmToIf/NUM)                      
DELTA

Frames sent with BECN bit 
set.

BECN Frames Sent since 
Baseline

(becnFrmToIf/NUM)                      
BASELINEDELTA

Frames sent with BECN bit 
set since the last baseline 
reset.

Table 31 (Continued)
Component: EM/ FRUNI/ DLCI/

Name Formula Meaning
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BECN Frames Received (becnFrmFromIf/NUM)                      
DELTA

Frames received with BECN 
bit set.

BECN Frames Received 
since Baseline

(becnFrmFromIf/NUM)                      
BASELINEDELTA

Frames received with BECN 
bit set since the last baseline 
reset.

DE Frames Sent (deFrmToIf/NUM)                      
DELTA

Frames sent with DE bit set.

DE Frames Sent since 
Baseline

(deFrmToIf/NUM)                      
BASELINEDELTA

Frames sent with DE bit set 
since the last baseline reset.

DE Frames Received (deFrmFromIf/NUM)                      
DELTA

Frames received with DE bit 
set.

DE Frames Received since 
Baseline

(deFrmFromIf/NUM)                      
BASELINEDELTA

Frames received with DE bit 
set since the last baseline 
reset.

Congested Frames Sent 
Discarded

(discCongestedToIf/NUM)                      
DELTA

Sent frames discarded due to 
congestion.

Congested Frames Sent 
Discarded since Baseline

(discCongestedToIf/NUM)                      
BASELINEDELTA

Sent frames discarded due to 
congestion since the last 
baseline reset.

Congested Frames 
Received Discarded

(discCongestedFromIf/NUM)                      
DELTA

Received frames discarded 
due to congestion.

Congested Frames 
Received Discarded since 
Baseline

(discCongestedFromIf/NUM)                      
BASELINEDELTA

Received frames discarded 
due to congestion since the 
last baseline reset.

Excess Frames Received (excessFrmFromIf/NUM)                      
DELTA

Number of excess frames.

Excess Frames Received 
since Baseline

(excessFrmFromIf/NUM)                      
BASELINEDELTA

Number of excess frames 
since the last baseline reset.

Table 31 (Continued)
Component: EM/ FRUNI/ DLCI/

Name Formula Meaning
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Table 32
Component: EM/ FRUNI/ FRAMER

Name Formula Meaning

Frames per second Sent (frmToIf/NUM)                      DELTA                      
SECONDS                      DIVIDE

Frames sent per second.

Frames Sent since 
Baseline

(frmToIf/NUM)                      
BASELINEDELTA

Frames sent since the last 
baseline reset.

Frames per second 
Received

(frmFromIf/NUM)                      DELTA                      
SECONDS                      DIVIDE

Frames received per second.

Frames Received since 
Baseline

(frmFromIf/NUM)                      
BASELINEDELTA

Frames received since the 
last baseline reset.

Outgoing Normal Link 
Utilization

(normPrioLinkUtilToIf/NUM) Normal traffic sending link 
utilization.

Incoming Normal Link 
Utilization

(normPrioLinkUtilFromIf/NUM) Normal traffic receiving link 
utilization.

Octet Alignment Errors (nonOctetErrors/NUM)                      
DELTA

Number of non-octet aligned 
frames since last probe.

Octet Alignment Errors 
since Baseline

(nonOctetErrors/NUM)                      
BASELINEDELTA

Number of non-octet aligned 
frames since the last baseline 
reset.

Frame Length Errors (largeFrmErrors/NUM)                      
DELTA

Number of bad length frames 
since last probe. 

Frame Length Errors since 
Baseline

(largeFrmErrors/NUM)                      
BASELINEDELTA

Number of bad length frames 
since the last baseline reset.

Frame Abort Errors (aborts/NUM)                      DELTA Number of aborted frames 
since last probe.

Frame Abort Errors since 
Baseline

(aborts/NUM)                      
BASELINEDELTA

Number of aborted frames 
since the last baseline reset.
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Table 33
Component: EM/ FRUNI/ LMI

Name Formula Meaning

Status Reports Tx (keepAliveStatusToIf/NUM)                      
DELTA                      (fullStatusToIf/
NUM)                      DELTA                      
ADD

Number of status reports sent 
since last probe.

Status Reports Tx since 
Baseline

(keepAliveStatusToIf/NUM)                      
BASELINEDELTA                      
(fullStatusToIf/NUM)                      
BASELINEDELTA                      ADD

Number of status reports sent 
since the last baseline reset.

Status Enquiries Rx (keepAliveSeFromIf/NUM)                      
DELTA                      
(fullStatEnqFromIf/NUM)                      
DELTA                      ADD

Number of status reports 
received since last probe.

Status Enquiries Rx since 
Baseline

(keepAliveSeFromIf/NUM)                      
BASELINEDELTA                      
(fullStatEnqFromIf/NUM)                      
BASELINEDELTA                      ADD

Number of status reports 
received since the last 
baseline reset.

Sequence Number 
Mismatches

(sequenceErrors/NUM) Number of Status enquiries 
with a sequence error.

Invalid Requests (unexpectedIes/NUM) Number of frames received 
with an unknown/unexpected 
IES.

Timeouts (pollingVerifTimeouts/NUM)                      
(noStatusReportCount/NUM)                      
ADD

Number of checkPointTimer 
expired.
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Table 34
Component: EM/ FRUNI/ VFRAMER

Name Formula Meaning

Frames per second Sent (frmToOtherVFramer/NUM)                      
DELTA                      SECONDS                      
DIVIDE

Frames sent per second.

Frames Sent since 
Baseline

(frmToOtherVFramer/NUM)                      
BASELINEDELTA

Frames sent since the last 
baseline reset.

Frames per second 
Received

(frmFromOtherVFramer/NUM)                      
DELTA                      SECONDS                      
DIVIDE

Frames received per second.

Frames Received since 
Baseline

(frmFromOtherVFramer/NUM)                      
BASELINEDELTA

Frames received since the 
last baseline reset.

Table 35
Component: EM/ HTDS/ FRAMER

Name Formula Meaning

Frames per second Sent (frmToIf/NUM)                      DELTA                      
SECONDS                      DIVIDE

Number of frames per second 
transmitted to the link 
interface by Framer, since 
last probe.

Frames Sent since 
Baseline

(frmToIf/NUM)                      
BASELINEDELTA

Number of frames per second 
transmitted to the link 
interface by Framer, since the 
last baseline reset.

Frames per second 
Received

(frmFromIf/NUM)                      DELTA                      
SECONDS                      DIVIDE

Number of frames per second 
received from the link 
interface by Framer, since 
last probe.
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Frames Received since 
Baseline

(frmFromIf/NUM)                      
BASELINEDELTA

Number of frames received 
from the link interface by 
Framer, since the last 
baseline reset.

CRC Errors (crcErrors/NUM)                      DELTA Number of frames with CRC 
errors, since last probe.

CRC Errors since Baseline (crcErrors/NUM)                      
BASELINEDELTA

Number of frames with CRC 
errors since the last baseline 
reset.

LRC Errors (lrcErrors/NUM)                      DELTA Number of frames with LRC 
errors, since last probe.

LRC Errors since Baseline (lrcErrors/NUM)                      
BASELINEDELTA

Number of frames with LRC 
errors since the last baseline 
reset.

Overruns (overruns/NUM)                      DELTA Number of frames received 
from the link for which 
overruns occurred, since last 
probe.

Overruns since Baseline (overruns/NUM)                      
BASELINEDELTA

Number of frames received 
from the link for which 
overruns occurred, since the 
last baseline reset.

Underruns (underruns/NUM)                      DELTA Number of frames transmitted 
to the link for which underruns 
occurred, since last probe.

Underruns since Baseline (underruns/NUM)                      
BASELINEDELTA

Number of frames transmitted 
to the link for which underruns 
occurred, since the last 
baseline reset.

Table 35 (Continued)
Component: EM/ HTDS/ FRAMER

Name Formula Meaning
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Frame Length Errors (largeFrmErrors/NUM)                      
DELTA

Number of frames received 
that were too large, since last 
probe.

Frame Length Errors since 
Baseline

(largeFrmErrors/NUM)                      
BASELINEDELTA

Number of frames received 
that were too large since the 
last baseline  reset.

Table 35 (Continued)
Component: EM/ HTDS/ FRAMER

Name Formula Meaning
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Table 36
Component: EM/ ISSHOIF/

Name Formula Meaning

txPackets (txPackets/NUM)                      DELTA The description for this metric 
is currently not defined.

txPackets since Baseline (txPackets/NUM)                      
BASELINEDELTA

The description for this metric 
is currently not defined.

rxPackets (rxPackets/NUM)                      DELTA The description for this metric 
is currently not defined.

rxPackets since Baseline (rxPackets/NUM)                      
BASELINEDELTA

The description for this metric 
is currently not defined.

txPacketDiscards (txPacketDiscards/NUM)                      
DELTA

The description for this metric 
is currently not defined.

txPacketDiscards since 
Baseline

(txPacketDiscards/NUM)                      
BASELINEDELTA

The description for this metric 
is currently not defined.

rxPacketDiscards (rxPacketDiscards/NUM)                      
DELTA

The description for this metric 
is currently not defined.

rxPacketDiscards since 
Baseline

(rxPacketDiscards/NUM)                      
BASELINEDELTA

The description for this metric 
is currently not defined.

Table 37
Component: EM/ LA/ FRAMER

Name Formula Meaning

Bytes Received (rxBytes/NUM)                      DELTA The total number of bytes 
received since the last probe.

Bytes Received since 
Baseline

(rxBytes/NUM)                      
BASELINEDELTA

The total number of bytes 
received since the last 
baseline reset.

Frames Received (rxFrames/NUM)                      DELTA The total number of frames 
received since the last probe.
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Frames Received since 
Baseline

(rxFrames/NUM)                      
BASELINEDELTA

The total number of frames 
received since the last 
baseline reset.

Bytes Transmitted (txBytes/NUM)                      DELTA The total number of bytes 
transmitted since the last 
probe.

Bytes Transmitted since 
Baseline

(txBytes/NUM)                      
BASELINEDELTA

The total number of bytes 
transmitted since the last 
baseline reset.

Frames Transmitted (txFrames/NUM)                      DELTA The total number of frames 
transmitted since the last 
probe.

Frames Transmitted since 
Baseline

(txFrames/NUM)                      
BASELINEDELTA

The total number of frames 
transmitted since the last 
baseline reset.

Frames Transmit Discards (txDiscard/NUM)                      DELTA The total number of frames 
transmitted that are discarded 
since the last probe.

Frames Transmit Discards 
since Baseline

(txDiscard/NUM)                      
BASELINEDELTA

The total number of frames 
transmitted that are discarded 
since the last baseline reset.

Frames Receive Discards (rxDiscard/NUM)                      DELTA The total number of frames 
received that are discarded 
since the last probe.

Frames Receive Discards 
since Baseline

(rxDiscard/NUM)                      
BASELINEDELTA

The total number of frames 
received that are discarded 
since the last baseline reset.

Table 37 (Continued)
Component: EM/ LA/ FRAMER

Name Formula Meaning
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Frames Receive Errors (rxFrameError/NUM)                      
DELTA

The total number of frames 
received that are discarded 
due to frame error since the 
last probe.

Frames Receive Errors 
since Baseline

(rxFrameError/NUM)                      
BASELINEDELTA

The total number of frames 
received that are discarded 
due to frame error since the 
last baseline reset.

Table 37 (Continued)
Component: EM/ LA/ FRAMER

Name Formula Meaning
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Table 38
Component: EM/ LA/ STATS

Name Formula Meaning

Bytes Received (rxBytes/NUM)                      DELTA The total number of bytes 
received since the last probe.

Bytes Received since 
Baseline

(rxBytes/NUM)                      
BASELINEDELTA

The total number of bytes 
received since the last 
baseline reset.

Received Frames 
Discarded

(rxDiscFrames/NUM)                      
DELTA                      (rxDiscNetCong/
NUM)                      DELTA                      
ADD

The total number of frames 
received that were discarded 
since the last  probe.

Received Frames 
Discarded since Baseline

(rxDiscFrames/NUM)                      
BASELINEDELTA                      
(rxDiscNetCong/NUM)                      
BASELINEDELTA                      ADD

The total number of frames 
received that were discarded 
since the last baseline reset.

Frames Received (rxFrames/NUM)                      DELTA The total number of frames 
received since the last probe.

Frames Received since 
Baseline

(rxFrames/NUM)                      
BASELINEDELTA

The total number of frames 
received since the last 
baseline reset.

Bytes Transmitted (txBytes/NUM)                      DELTA The total number of bytes 
transmitted since the last 
probe.

Bytes Transmitted since 
Baseline

(txBytes/NUM)                      
BASELINEDELTA

The total number of bytes 
transmitted since the last 
baseline reset.

Transmitted Frames 
Discarded

(txDiscFrames/NUM)                      
DELTA                      (txDiscIfCong/
NUM)                      DELTA                      
ADD

The total number of frames 
transmitted that were 
discarded since  the last 
probe.

Transmitted Frames 
Discarded since Baseline

(txDiscFrames/NUM)                      
BASELINEDELTA                      
(txDiscIfCong/NUM)                      
BASELINEDELTA                      ADD

The total number of frames 
transmitted that were 
discarded since the last 
baseline reset.
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Frames Transmitted (txFrames/NUM)                      DELTA The total number of frames 
transmitted since the last 
probe.

Frames Transmitted since 
Baseline

(txFrames/NUM)                      
BASELINEDELTA

The total number of frames 
transmitted since the last 
baseline reset.

Table 38 (Continued)
Component: EM/ LA/ STATS

Name Formula Meaning
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Table 39
Component: EM/ LA/ VLAN/ STATS

Name Formula Meaning

Bytes Received (rxBytes/NUM)                      DELTA The total number of bytes 
received since the last probe.

Bytes Received since 
Baseline

(rxBytes/NUM)                      
BASELINEDELTA

The total number of bytes 
received since the last 
baseline reset.

Received Frames 
Discarded

(rxDiscFrames/NUM)                      
DELTA                      (rxDiscNetCong/
NUM)                      DELTA                      
ADD

The total number of frames 
received that were discarded 
since  the last probe.

Received Frames 
Discarded since Baseline

(rxDiscFrames/NUM)                      
BASELINEDELTA                      
(rxDiscNetCong/NUM)                      
BASELINEDELTA                      ADD

The total number of frames 
received that were discarded 
since the last baseline reset.

Frames Received (rxFrames/NUM)                      DELTA The total number of frames 
received since the last probe.

Frames Received since 
Baseline

(rxFrames/NUM)                      
BASELINEDELTA

The total number of frames 
received since the last 
baseline reset.

Bytes Transmitted (txBytes/NUM)                      DELTA The total number of bytes 
transmitted since the last 
probe.

Bytes Transmitted since 
Baseline

(txBytes/NUM)                      
BASELINEDELTA

The total number of bytes 
transmitted since the last 
baseline reset.

Transmitted Frames 
Discarded

(txDiscFrames/NUM)                      
DELTA                      (txDiscIfCong/
NUM)                      DELTA                      
ADD

The total number of frames 
transmitted that were 
discarded since  the last 
probe.

Transmitted Frames 
Discarded since Baseline

(txDiscFrames/NUM)                      
BASELINEDELTA                      
(txDiscIfCong/NUM)                      
BASELINEDELTA                      ADD

The total number of frames 
transmitted that were 
discarded since the last 
baseline reset.
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Frames Transmitted (txFrames/NUM)                      DELTA The total number of frames 
transmitted since the last 
probe.

Frames Transmitted since 
Baseline

(txFrames/NUM)                      
BASELINEDELTA

The total number of frames 
transmitted since the last 
baseline reset.

Table 39 (Continued)
Component: EM/ LA/ VLAN/ STATS

Name Formula Meaning
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Table 40
Component: EM/ LP/

Name Formula Meaning

CPU Utilization (%) (cpuUtil/NUM) CPU utilization.

Fast Ram Memory 
Utilization (%)

(memoryUsage[0]/NUM)                      
(memoryCapacity[0]/NUM)                      
PERCENT

Fast ram memory utilization.

Normal Ram Memory 
Utilization (%)

(memoryUsage[1]/NUM)                      
(memoryCapacity[1]/NUM)                      
PERCENT

Normal ram memory 
utilization.

Shared Ram Memory 
Utilization (%)

(memoryUsage[2]/NUM)                      
(memoryCapacity[2]/NUM)                      
PERCENT

Shared ram memory 
utilization.

Shared Msg Block 
Utilization (%)

(sharedMsgBlockUsage/NUM)                      
(sharedMsgBlockCapacity/NUM)                      
PERCENT

Shared message block 
utilization.

Local Msg Block Utilization 
(%)

(localMsgBlockUsage/NUM)                      
(localMsgBlockCapacity/NUM)                      
PERCENT

Local message block 
utilization.

Table 41
Component: EM/ LP/ ARU/

Name Formula Meaning

Tx Cell Block Util (%) (txCellBlockUsage/NUM)                      
(txCellBlockCapacity/NUM)                      
PERCENT

Sending cell block utilization.

Rx Cell Block Util (%) (rxCellBlockUsage/NUM)                      
(rxCellBlockCapacity/NUM)                      
PERCENT

Receiving cell block 
utilization.
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Tx Frame Block Util (%) (txFrameBlockUsage/NUM)                      
(txFrameBlockCapacity/NUM)                      
PERCENT

Sending frame block 
utilization.

Rx Frame Block Util (%) (rxFrameBlockUsage/NUM)                      
(rxFrameBlockCapacity/NUM)                      
PERCENT

Receiving frame block 
utilization.

Table 41 (Continued)
Component: EM/ LP/ ARU/

Name Formula Meaning
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Table 42
Component: EM/ LP/ DS1/

Name Formula Meaning

CRC Errors (crcErrors/NUM)                      DELTA Number of CRC errors since 
last probe.

CRC Errors since Baseline (crcErrors/NUM)                      
BASELINEDELTA

Number of CRC errors since 
the last baseline reset.

Frame Errors (frameErrors/NUM)                      
DELTA

Number of frame errors since 
last probe.

Frame Errors since 
Baseline

(frameErrors/NUM)                      
BASELINEDELTA                      
(frmErrors/NUM)                      
BASELINEDELTA                      ADD

Number of frame errors since 
the last baseline reset.

SLIP Errors (slipErrors/NUM)                      DELTA Number of SLIP errors since 
last probe.

SLIP Errors since Baseline (slipErrors/NUM)                      
BASELINEDELTA

Number of SLIP errors since 
the last baseline reset.

Table 43
Component: EM/ LP/ DS1/ CHAN/ CELL

Name Formula Meaning

Rx Cell Util (receiveCellUtilization/NUM) Ratio of number of valid 
assigned cells received on 
link to nominal capacity.

Tx Cell Util (transmitCellUtilization/NUM) Ratio of number of valid 
assigned cells transmitted on 
link to nominal capacity.
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Table 44
Component: EM/ LP/ DS3/

Name Formula Meaning

Line Failures (lineFailures/NUM)                      
DELTA

Number of line failures since 
last probe.

Line Failures since 
Baseline

(lineFailures/NUM)                      
BASELINEDELTA

Number of line failures since 
the last baseline reset.

Path Failures (pathFailures/NUM)                      
DELTA

Number of path failures since 
last probe.

Path Failures since 
Baseline

(pathFailures/NUM)                      
BASELINEDELTA

Number of path failures since 
the last baseline reset.

Table 45
Component: EM/ LP/ DS3/ CBIT

Name Formula Meaning

C bit Error Free Second (cbitErrorFreeSec/NUM)                      
DELTA

Number of seconds that the 
DS3 port has not suffered any 
C Bit errors.

C bit Error Free Second 
since Baseline

(cbitErrorFreeSec/NUM)                      
BASELINEDELTA

Number of seconds that the 
DS3 port has not suffered any 
C Bit errors, since the last 
baseline reset.

C bit code violations (cbitCodeViolations/NUM)                      
DELTA                      SECONDS                      
DIVIDE

Rate of C bit code violdations 
since last probe.

C bit code violations since 
Baseline

(cbitCodeViolations/NUM)                      
BASELINEDELTA

Number of C bit code 
violdations since the last 
baseline reset.

C bit Errors Second (cbitErroredSec/NUM)                      
DELTA

Number of seconds sufferred 
from C Bit Parity Errored.
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C bit Errors Second since 
Baseline

(cbitErroredSec/NUM)                      
BASELINEDELTA

Number of seconds sufferred 
from C Bit Parity Errored, 
since the last  baseline reset.

C bit Severe Error Second (cbitSevErroredSec/NUM)                      
DELTA

Number of seconds suffered 
C bit severe errors.

C bit Severe Error Second 
since Baseline

(cbitSevErroredSec/NUM)                      
BASELINEDELTA

Number of seconds suffered 
C bit severe errors, since the 
last baseline reset.

C bit Unavailable Second (cbitUnavailSec/NUM)                      
DELTA

Number of seconds which 
DS3 is unavailable.

C bit Unavailable Second 
since Baseline

(cbitUnavailSec/NUM)                      
BASELINEDELTA

Number of seconds which 
DS3 is unavailable since the 
last baseline reset.

Table 45 (Continued)
Component: EM/ LP/ DS3/ CBIT

Name Formula Meaning
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Table 46
Component: EM/ LP/ DS3/ CELL

Name Formula Meaning

Rx Cell Util (receiveCellUtilization/NUM) Ratio of number of valid 
assigned cells received on 
link to nominal capacity.

Tx Cell Util (transmitCellUtilization/NUM) Ratio of number of valid 
assigned cells transmitted on 
link to nominal capacity.

Table 47
Component: EM/ LP/ DS3/ DS1/ CHAN/ CELL

Name Formula Meaning

Rx Cell Util (receiveCellUtilization/NUM) Ratio of number of valid 
assigned cells received on 
link to nominal capacity.

Tx Cell Util (transmitCellUtilization/NUM) Ratio of number of valid 
assigned cells transmitted on 
link to nominal capacity.

Table 48
Component: EM/ LP/ E1/

Name Formula Meaning

CRC Errors (crcErrors/NUM)                      DELTA Number of CRC errors since 
last probe.

CRC Errors since Baseline (crcErrors/NUM)                      
BASELINEDELTA

Number of CRC errors since 
the last baseline reset.
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Frame Errors (frameErrors/NUM)                      
DELTA

Number of frame errors since 
last probe.

Frame Errors since 
Baseline

(frameErrors/NUM)                      
BASELINEDELTA                      
(frmErrors/NUM)                      
BASELINEDELTA                      ADD

Number of frame errors since 
the last baseline reset.

SLIP Errors (slipErrors/NUM)                      DELTA Number of SLIP errors since 
last probe.

SLIP Errors since Baseline (slipErrors/NUM)                      
BASELINEDELTA

Number of SLIP errors since 
the last baseline reset.

Table 48 (Continued)
Component: EM/ LP/ E1/

Name Formula Meaning
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Table 49
Component: EM/ LP/ E1/ CHAN/ CELL

Name Formula Meaning

Rx Cell Util (receiveCellUtilization/NUM) Ratio of number of valid 
assigned cells received on 
link to nominal capacity.

Tx Cell Util (transmitCellUtilization/NUM) Ratio of number of valid 
assigned cells transmitted on 
link to nominal capacity.

Table 50
Component: EM/ LP/ E3/

Name Formula Meaning

Line Failures (lineFailures/NUM)                      
DELTA

Number of line failures since 
last probe.

Line Failures since 
Baseline

(lineFailures/NUM)                      
BASELINEDELTA

Number of line failures since 
the last baseline reset.

Path Failures (pathFailures/NUM)                      
DELTA

Number of path failures since 
last probe.

Path Failures since 
Baseline

(pathFailures/NUM)                      
BASELINEDELTA

Number of path failures since 
the last baseline reset.
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Table 51
Component: EM/ LP/ E3/ CELL

Name Formula Meaning

Rx Cell Util (receiveCellUtilization/NUM) Ratio of number of valid 
assigned cells received on 
link to nominal capacity.

Tx Cell Util (transmitCellUtilization/NUM) Ratio of number of valid 
assigned cells transmitted on 
link to nominal capacity.

Table 52
Component: EM/ LP/ ENET/

Name Formula Meaning

Alignment Errors (alignmentErrors/NUM)                      
DELTA

Number of alignment errors 
since last probe.

Alignment Errors since 
Baseline

(alignmentErrors/NUM)                      
BASELINEDELTA

Number of alignment errors 
since the last baseline reset.

FCS Errors (fcsErrors/NUM)                      DELTA Number of FCS errors since 
last probe.

FCS Errors since Baseline (fcsErrors/NUM)                      
BASELINEDELTA

Number of FCS errors since 
the last baseline reset.

Single Collision Frames (singleCollisionFrames/NUM)                      
DELTA

Number of single frame 
collisions since last probe.

Single Collision Frames 
since Baseline

(singleCollisionFrames/NUM)                      
BASELINEDELTA

Number of single frame 
collisions since the last 
baseline reset.

Multiple Collision Frames (multipleCollisionFrames/NUM)                      
DELTA

Number of multiple frame 
collisions since last probe.
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Multiple Collision Frames 
since Baseline

(multipleCollisionFrames/NUM)                      
BASELINEDELTA

Number of multiple frame 
collisions since the last 
baseline reset.

SQE Test Errors (sqeTestErrors/NUM)                      
DELTA

Number of SQE test errors 
since last probe.

SQE Test Errors since 
Baseline

(sqeTestErrors/NUM)                      
BASELINEDELTA

Number of SQE test errors 
since the last baseline reset.

Deferred Transmissions (deferredTransmissions/NUM)                      
DELTA

Number of deferred 
transmissions since last 
probe.

Deferred Transmissions 
since Baseline

(deferredTransmissions/NUM)                      
BASELINEDELTA

Number of deferred 
transmissions since the last 
baseline reset.

Late Collisions (lateCollisions/NUM)                      
DELTA

Number of late collisions 
since last probe.

Late Collisions since 
Baseline

(lateCollisions/NUM)                      
BASELINEDELTA

Number of late collisions 
since the last baseline reset.

Excessive Collisions (excessiveCollisions/NUM)                      
DELTA

Number of excessive 
collisions since last probe.

Excessive Collisions since 
Baseline

(excessiveCollisions/NUM)                      
BASELINEDELTA

Number of excessive 
collisions since the last 
baseline reset.

MAC Transmit Errors (macTransmitErrors/NUM)                      
DELTA

Number of mac transmit 
errors since last probe.

MAC Transmit Errors since 
Baseline

(macTransmitErrors/NUM)                      
BASELINEDELTA

Number of mac transmit 
errors since the last baseline 
reset.

Carrier Sense Errors (carrierSenseErrors/NUM)                      
DELTA

Number of carrier sense 
errors since last probe.

Table 52 (Continued)
Component: EM/ LP/ ENET/

Name Formula Meaning
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Carrier Sense Errors since 
Baseline

(carrierSenseErrors/NUM)                      
BASELINEDELTA

Number of carrier sense 
errors since the last baseline 
reset.

Frame Size Errors (frameTooLongs/NUM)                      
DELTA

Number of frame size errors 
since last probe.

Frame Size Errors since 
Baseline

(frameTooLongs/NUM)                      
BASELINEDELTA

Number of frame size errors 
since the last baseline reset.

MAC Receive Errors (macReceiveErrors/NUM)                      
DELTA

Number of mac receive errors 
since last probe.

MAC Receive Errors since 
Baseline

(macReceiveErrors/NUM)                      
BASELINEDELTA

Number of mac receive errors 
since the last baseline reset.

Table 52 (Continued)
Component: EM/ LP/ ENET/

Name Formula Meaning
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Table 53
Component: EM/ LP/ ENG AALIST

Name Formula Meaning

Rx Alarm (alarmsRx/NUM) Number of active alarms 
received from the LP.

Discarded Alarm (alarmsDiscarded/NUM) Number of active alarms 
discarded from the LP.

Current List Size (currentListSize/NUM) Number of active alarms 
stored on this LP.

Peak List Size (peakListSize/NUM) Indicates the maximum 
number of active alarms 
received on the LP since it 
last came up.

Table 54
Component: EM/ LP/ ENG HGS

Name Formula Meaning

Hunts per second (huntAttempts/NUM)                      
DELTA                      SECONDS                      
DIVIDE

Number of hunt group hunt, 
since last probe.

Hunts since Baseline (huntAttempts/NUM)                      
BASELINEDELTA

Number of hunt group hunt 
since the last baseline reset.
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Table 55
Component: EM/ LP/ ETH/

Name Formula Meaning

Alignment Errors (alignmentErrors/NUM)                      
DELTA

Number of alignment errors 
since last probe.

Alignment Errors since 
Baseline

(alignmentErrors/NUM)                      
BASELINEDELTA

Number of alignment errors 
since the last baseline reset.

Single Collision Frames (singleCollisionFrames/NUM)                      
DELTA

Number of single frame 
collisions since last probe.

Single Collision Frames 
since Baseline

(singleCollisionFrames/NUM)                      
BASELINEDELTA

Number of single frame 
collisions since the last 
baseline reset.

Multiple Collision Frames (multipleCollisionFrames/NUM)                      
DELTA

Number of multiple frame 
collisions since last probe.

Multiple Collision Frames 
since Baseline

(multipleCollisionFrames/NUM)                      
BASELINEDELTA

Number of multiple frame 
collisions since the last 
baseline reset.

Late Collisions (lateCollisions/NUM)                      
DELTA

Number of late collisions 
since last probe.

Late Collisions since 
Baseline

(lateCollisions/NUM)                      
BASELINEDELTA

Number of late collisions 
since the last baseline reset.

Excessive Collisions (excessiveCollisions/NUM)                      
DELTA

Number of excessive 
collisions since last probe.

Excessive Collisions since 
Baseline

(excessiveCollisions/NUM)                      
BASELINEDELTA

Number of excessive 
collisions since the last 
baseline reset.

MAC Transmit Errors (macTransmitErrors/NUM)                      
DELTA

Number of mac transmit 
errors since last probe.

MAC Transmit Errors since 
Baseline

(macTransmitErrors/NUM)                      
BASELINEDELTA

Number of mac transmit 
errors since the last baseline 
reset.

Carrier Sense Errors (carrierSenseErrors/NUM)                      
DELTA

Number of carrier sense 
errors since last probe.
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Carrier Sense Errors since 
Baseline

(carrierSenseErrors/NUM)                      
BASELINEDELTA

Number of carrier sense 
errors since the last baseline 
reset.

MAC Receive Errors (macReceiveErrors/NUM)                      
DELTA

Number of mac receive errors 
since last probe.

MAC Receive Errors since 
Baseline

(macReceiveErrors/NUM)                      
BASELINEDELTA

Number of mac receive errors 
since the last baseline reset.

Frames Transmitted Ok (framesTransmittedOk/NUM)                      
DELTA

Number of frames transmitted 
Ok since last probe.

Frames Transmitted Ok 
since Baseline

(framesTransmittedOk/NUM)                      
BASELINEDELTA

Number of frames transmitted 
Ok since the last baseline 
reset.

Frames Received Ok (framesReceivedOk/NUM)                      
DELTA

Number of frames received 
Ok since last probe.

Frames Received Ok since 
Baseline

(framesReceivedOk/NUM)                      
BASELINEDELTA

Number of frames received 
Ok since the last baseline 
reset.

Octets Transmitted Ok (octetsTransmittedOk/NUM)                      
DELTA

Number of octets transmitted 
Ok since last probe.

Octets Transmitted Ok 
since Baseline

(octetsTransmittedOk/NUM)                      
BASELINEDELTA

Number of octets transmitted 
Ok since the last baseline 
reset.

Octets Received Ok (octetsReceivedOk/NUM)                      
DELTA

Number of octets received Ok 
since last probe.

Octets Received Ok since 
Baseline

(octetsReceivedOk/NUM)                      
BASELINEDELTA

Number of octets received Ok 
since the last baseline reset.

Undersize Frames (undersizeFrames/NUM)                      
DELTA

Number of undersize frames 
since last probe.

Undersize Frames since 
Baseline

(undersizeFrames/NUM)                      
BASELINEDELTA

Number of undersize frames 
since the last baseline reset.

Table 55 (Continued)
Component: EM/ LP/ ETH/

Name Formula Meaning

 (Sheet 2 of 3)
241-6001-031   15.1    



Appendix A Passport performance metrics   215
Fragments (fragments/NUM)                      DELTA Number of fragments since 
last probe.

Fragments since Baseline (fragments/NUM)                      
BASELINEDELTA

Number of fragments since 
the last baseline reset.

Frames Too Long (framesTooLong/NUM)                      
DELTA

Number of frames too long 
since last probe.

Frames Too Long since 
Baseline

(framesTooLong/NUM)                      
BASELINEDELTA

Number of frames too long 
since the last baseline reset.

Jabbers (jabbers/NUM)                      DELTA Number of jabbers since last 
probe.

Jabbers since Baseline (jabbers/NUM)                      
BASELINEDELTA

Number of jabbers since the 
last baseline reset.

FCS Errors (fcsErrors/NUM)                      DELTA Number of FCS errors since 
last probe.

FCS Errors since Baseline (fcsErrors/NUM)                      
BASELINEDELTA

Number of FCS errors since 
the last baseline reset.

Symbol Errors (symbolErrors/NUM)                      
DELTA

Number of symbol errors 
since last probe.

Symbol Errors since 
Baseline

(symbolErrors/NUM)                      
BASELINEDELTA

Number of symbol errors 
since the last baseline reset.

Pause Frames Received (pauseFramesReceived/NUM)                      
DELTA

Number of pause frames 
received since last probe.

Pause Frames Received 
since Baseline

(pauseFramesReceived/NUM)                      
BASELINEDELTA

Number of pause frames 
received since the last 
baseline reset.

Table 55 (Continued)
Component: EM/ LP/ ETH/

Name Formula Meaning
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Table 56
Component: EM/ LP/ ETH100/

Name Formula Meaning

Alignment Errors (alignmentErrors/NUM)                      
DELTA

Alignment Errors.

Alignment Errors since 
Baseline

(alignmentErrors/NUM)                      
BASELINEDELTA

Alignment Errors since last 
baseline reset.

Carrier Sense Errors (carrierSenseErrors/NUM)                      
DELTA

Carrier Sense Errors.

Carrier Sense Errors since 
Baseline

(carrierSenseErrors/NUM)                      
BASELINEDELTA

Carrier Sense Errors since 
last baseline reset.

Deferred Transmissions (deferredTransmissions/NUM)                      
DELTA

Deferred Transmissions.

Deferred Transmissions 
since Baseline

(deferredTransmissions/NUM)                      
BASELINEDELTA

Deferred Transmissions 
since last baseline reset.

Excessive Collisions (excessiveCollisions/NUM)                      
DELTA

Excessive Collisions.

Excessive Collisions since 
Baseline

(excessiveCollisions/NUM)                      
BASELINEDELTA

Excessive Collisions since 
last baseline reset.

FCS Errors (fcsErrors/NUM)                      DELTA FCS Errors.

FCS Errors since Baseline (fcsErrors/NUM)                      
BASELINEDELTA

FCS Errors since last 
baseline reset.

Frames Too Long (frameTooLongs/NUM)                      
DELTA

Frames Too Long.

Frames Too Long since 
Baseline

(frameTooLongs/NUM)                      
BASELINEDELTA

Frames Too Long since last 
baseline reset.

Frames Received Ok (framesReceivedOk/NUM)                      
DELTA

Frames Received Ok.

Frames Received Ok since 
Baseline

(framesReceivedOk/NUM)                      
BASELINEDELTA

Frames Received Ok since 
last baseline reset.

Frames Transmitted Ok (framesTransmittedOk/NUM)                      
DELTA

Frames Transmitted Ok.
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Frames Transmitted Ok 
since Baseline

(framesTransmittedOk/NUM)                      
BASELINEDELTA

Frames Transmitted Ok since 
last baseline reset.

Late Collisions (lateCollisions/NUM)                      
DELTA

Late Collisions.

Late Collisions since 
Baseline

(lateCollisions/NUM)                      
BASELINEDELTA

Late Collisions since last 
baseline reset.

Mac Receive Errors (macReceiveErrors/NUM)                      
DELTA

Mac Receive Errors.

Mac Receive Errors since 
Baseline

(macReceiveErrors/NUM)                      
BASELINEDELTA

Mac Receive Errors since last 
baseline reset.

Mac Transmit Errors (macTransmitErrors/NUM)                      
DELTA

Mac Transmit Errors.

Mac Transmit Errors since 
Baseline

(macTransmitErrors/NUM)                      
BASELINEDELTA

Mac Transmit Errors since 
last baseline reset.

Multiple Collision Frames (multipleCollisionFrames/NUM)                      
DELTA

Multiple Collision Frames.

Multiple Collision Frames 
since Baseline

(multipleCollisionFrames/NUM)                      
BASELINEDELTA

Multiple Collision Frames 
since last baseline reset.

Octets Received Ok (octetsReceivedOk/NUM)                      
DELTA

Octets Received Ok.

Octets Received Ok since 
Baseline

(octetsReceivedOk/NUM)                      
BASELINEDELTA

Octets Received Ok since last 
baseline reset.

Octets Transmitted Ok (octetsTransmittedOk/NUM)                      
DELTA

Octets Transmitted Ok.

Octets Transmitted Ok 
since Baseline

(octetsTransmittedOk/NUM)                      
BASELINEDELTA

Octets Transmitted Ok since 
last baseline reset.

Received Frames Into 
Router Br

(receivedFramesIntoRouterBr/
NUM)                      DELTA

Received Frames Into Router 
Br.

Received Frames Into 
Router Br since Baseline

(receivedFramesIntoRouterBr/
NUM)                      BASELINEDELTA

Received Frames Into Router 
Br since last baseline reset.

Table 56 (Continued)
Component: EM/ LP/ ETH100/

Name Formula Meaning
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Received Octets Into 
Router Br

(receivedOctetsIntoRouterBr/NUM)                      
DELTA

Received Octets Into Router 
Br.

Received Octets Into 
Router Br since Baseline

(receivedOctetsIntoRouterBr/NUM)                      
BASELINEDELTA

Received Octets Into Router 
Br since last baseline reset.

Single Collision Frames (singleCollisionFrames/NUM)                      
DELTA

Single Collision Frames.

Single Collision Frames 
since Baseline

(singleCollisionFrames/NUM)                      
BASELINEDELTA

Single Collision Frames since 
last baseline reset.

SQE Test Errors (sqeTestErrors/NUM)                      
DELTA

SQE Test Errors.

SQE Test Errors since 
Baseline

(sqeTestErrors/NUM)                      
BASELINEDELTA

SQE Test Errors since last 
baseline reset.

Undersize Frames (undersizeFrames/NUM)                      
DELTA

Undersize Frames.

Undersize Frames since 
Baseline

(undersizeFrames/NUM)                      
BASELINEDELTA

Undersize Frames since last 
baseline reset.

Table 56 (Continued)
Component: EM/ LP/ ETH100/

Name Formula Meaning
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Table 57
Component: EM/ LP/

Name Formula Meaning

Rx Cell Util (receiveCellUtilization/NUM) Ratio of number of valid 
assigned cells received on 
link to nominal capacity.

Tx Cell Util (transmitCellUtilization/NUM) Ratio of number of valid 
assigned cells transmitted on 
link to nominal capacity.

Failures (failures/NUM)                      DELTA Number of failures that the 
link has experienced during 
link addition  or normal 
operation.

Failures since Baseline (failures/NUM)                      
BASELINEDELTA

Number of failures that the 
link has experienced during 
link addition  or normal 
operation, since the last 
baseline reset.

Table 58
Component: EM/ LP/ JT2/ CELL

Name Formula Meaning

Rx Cell Util (receiveCellUtilization/NUM) Ratio of number of valid 
assigned cells received on 
link to nominal capacity.

Tx Cell Util (transmitCellUtilization/NUM) Ratio of number of valid 
assigned cells transmitted on 
link to nominal capacity.
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Table 59
Component: EM/ LP/ LAG/

Name Formula Meaning

Failures (failures/NUM)                      DELTA This attribute counts the 
complete failures.

Received Frame Octets (rxFrameOctets/NUM)                      
DELTA

This attribute counts the valid 
user frames, in octets, 
received on the .

Transmitted Frame Octets (txFrameOctets/NUM)                      
DELTA

This attribute counts the valid 
packets transmitted on the .

Received Frame Packets (rxFramePackets/NUM)                      
DELTA

This attribute counts the valid 
packets received on the .

Transmitted Frame 
Packets

(txFramePackets/NUM)                      
DELTA

This attribute indicates the 
total number of valid packets 
transmitted on the .

Received Frame Discards (rxFrameDiscards/NUM)                      
DELTA

This attribute counts the 
discarded user frames after 
they were received on the .

Transmitted Frame 
Discards

(txFrameDiscards/NUM)                      
DELTA

This attribute counts the 
discarded user frames during 
transmission on the .

Received Frame Errors (rxFrameErrors/NUM)                      
DELTA

This attribute counts the 
invalid user frames received 
on the .

Transmitted Frame Errors (txFrameErrors/NUM)                      
DELTA

This attribute counts the 
invalid user frames 
transmitted on the .

Failures since Baseline (failures/NUM)                      
BASELINEDELTA

This attribute counts the 
complete failures since last 
baseline reset.

Received Frame Octets 
since Baseline

(rxFrameOctets/NUM)                      
BASELINEDELTA

This attribute counts the valid 
user frames, in octets, 
received on the  since last 
baseline reset.
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Transmitted Frame Octets 
since Baseline

(txFrameOctets/NUM)                      
BASELINEDELTA

This attribute counts the valid 
packets transmitted on the  
since last baseline reset.

Received Frame Packets 
since Baseline

(rxFramePackets/NUM)                      
BASELINEDELTA

This attribute counts the valid 
packets received on the  
since last baseline reset.

Transmitted Frame 
Packets since Baseline

(txFramePackets/NUM)                      
BASELINEDELTA

This attribute indicates the 
total number of valid packets 
transmitted on the  since last 
baseline reset.

Received Frame Discards 
since Baseline

(rxFrameDiscards/NUM)                      
BASELINEDELTA

This attribute counts the 
discarded user frames after 
they were received on the  
since last baseline reset.

Transmitted Frame 
Discards since Baseline

(txFrameDiscards/NUM)                      
BASELINEDELTA

This attribute counts the 
discarded user frames during 
transmission on the  since last 
baseline reset.

Received Frame Errors 
since Baseline

(rxFrameErrors/NUM)                      
BASELINEDELTA

This attribute counts the 
invalid user frames received 
on the  since last baseline 
reset.

Transmitted Frame Errors 
since Baseline

(txFrameErrors/NUM)                      
BASELINEDELTA

This attribute counts the 
invalid user frames 
transmitted on the  since last 
baseline reset.

Table 59 (Continued)
Component: EM/ LP/ LAG/

Name Formula Meaning
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Table 60
Component: EM/ LP/ LAG/ LK/

Name Formula Meaning

Failures (failures/NUM)                      DELTA This attribute counts the 
complete failures.

Received LACP (rxLacp/NUM)                      DELTA This attribute counts LACP 
frames received from the 
remote end system.

Transmitted LACP (txLacp/NUM)                      DELTA This attribute counts the 
LACP frames transmitted 
from the near end system.

Received Invalid LACP (rxInvalidLacp/NUM)                      
DELTA

This attribute counts the 
invalid LACP frames received 
from the remote end system.

Received Marker (rxMarker/NUM)                      DELTA This attribute counts the 
Marker frames received from 
the remote end system.

Transmitted Marker (txMarker/NUM)                      DELTA This attribute counts the 
Marker frames transmitted 
from the near end system.

Received Invalid Marker (rxInvalidMarker/NUM)                      
DELTA

This attribute counts the 
invalid Marker frames 
received from the remote end 
system.

Failures since Baseline (failures/NUM)                      
BASELINE                      DELTA

This attribute counts the 
complete failures since last 
baseline reset.

Received LACP since 
Baseline

(rxLacp/NUM)                      
BASELINEDELTA

This attribute counts LACP 
frames received from the 
remote end system since last 
baseline reset.

Transmitted LACP since 
Baseline

(txLacp/NUM)                      
BASELINEDELTA

This attribute counts the 
LACP frames transmitted 
from the near end system 
since last baseline reset.
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Received Invalid LACP 
since Baseline

(rxInvalidLacp/NUM)                      
BASELINEDELTA

This attribute counts the 
invalid LACP frames received 
from the remote end system 
since last baseline reset.

Received Marker since 
Baseline

(rxMarker/NUM)                      
BASELINEDELTA

This attribute counts the 
Marker frames received from 
the remote end system since 
last baseline reset.

Transmitted Marker since 
Baseline

(txMarker/NUM)                      
BASELINEDELTA

This attribute counts the 
Marker frames transmitted 
from the near end system 
since last baseline reset.

Received Invalid Marker 
since Baseline

(rxInvalidMarker/NUM)                      
BASELINEDELTA

This attribute counts the 
invalid Marker frames 
received from the remote end 
system since last baseline 
reset.

Table 60 (Continued)
Component: EM/ LP/ LAG/ LK/

Name Formula Meaning
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Table 61
Component: EM/ LP/ SDH/

Name Formula Meaning

Error Free Sec (errorFreeSec/NUM)                      
DELTA

Number of seconds that the 
Sonet/Sdh component has 
been in a near error-free 
state.

Error Free Sec since 
Baseline

(errorFreeSec/NUM)                      
BASELINEDELTA

Number of seconds that the 
Sonet/Sdh component has 
been in a near error-free 
state, since the last baseline 
reset.

Section Code Violations (sectCodeViolations/NUM)                      
DELTA

Total number of Section Code 
Violations. 

Section Code Violations 
since Baseline

(sectCodeViolations/NUM)                      
BASELINEDELTA

Total number of Section Code 
Violations, since the last 
baseline reset.

Section Error Sec (sectErroredSec/NUM)                      
DELTA

Total number of Section Error 
Seconds.

Section Error Sec since 
Baseline

(sectErroredSec/NUM)                      
BASELINEDELTA

Total number of Section Error 
Seconds, since the last 
baseline reset.

Section Severe Error Sec (sectSevErroredSec/NUM)                      
DELTA

Total number of Section 
Severely Errored Seconds.

Section Severe Error Sec 
since Baseline

(sectSevErroredSec/NUM)                      
BASELINEDELTA

Total number of Section 
Severely Errored Seconds, 
since the last baseline reset.

Section Los Sec (sectLosSec/NUM)                      
DELTA

Total number of section LOS 
seconds.

Section Los Sec since 
Baseline

(sectLosSec/NUM)                      
BASELINEDELTA

Total number of section LOS 
seconds, since the last 
baseline reset.
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Section Severe Error 
Frame Sec

(sectSevErroredFrmSec/NUM)                      
DELTA

Total number of Section 
Severely Errored Frame 
Seconds.

Section Severe Error 
Frame Sec since Baseline

(sectSevErroredFrmSec/NUM)                      
BASELINEDELTA

Total number of Section 
Severely Errored Frame 
Seconds, since the last 
baseline reset.

Section Failures (sectFailures/NUM)                      
DELTA

Total number of times a 
section failure (LOS or LOF) 
occurs.

Section Failures since 
Baseline

(sectFailures/NUM)                      
BASELINEDELTA

Total number of times a 
section failure (LOS or LOF) 
occurs since the  last baseline 
reset.

Line Code Violations (lineCodeViolations/NUM)                      
DELTA

Total number of Line Code 
Violations. 

Line Code Violations since 
Baseline

(lineCodeViolations/NUM)                      
BASELINEDELTA

Total number of Line Code 
Violations since the last 
baseline reset.

Line Errored Sec (lineErroredSec/NUM)                      
DELTA

Total number of Line Errored 
Seconds.

Line Errored Sec since 
Baseline

(lineErroredSec/NUM)                      
BASELINEDELTA

Total number of Line Errored 
Seconds since the last 
baseline reset.

Line Severe Errored Sec (lineSevErroredSec/NUM)                      
DELTA

Total number of Line Severely 
Errored Seconds.

Line Severe Errored Sec 
since Baseline

(lineSevErroredSec/NUM)                      
BASELINEDELTA

Total number of Line Severely 
Errored Seconds since the 
last baseline  reset.

Line Ais Sec (lineAisSec/NUM) Total number of Line AIS 
Seconds. 

Table 61 (Continued)
Component: EM/ LP/ SDH/

Name Formula Meaning
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Line Unavailable Sec (lineUnavailSec/NUM) Total number of one-second 
intervals for which the STS 
line is unavailable.

Line Failures (lineFailures/NUM)                      
DELTA

Total number of times that a 
line failure (L-AIS) occurs.

Line Failures since 
Baseline

(lineFailures/NUM)                      
BASELINEDELTA

Total number of times that a 
line failure (L-AIS) occurs, 
since the last baseline reset.

Table 61 (Continued)
Component: EM/ LP/ SDH/

Name Formula Meaning
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Table 62
Component: EM/ LP/ SDH/ PATH/

Name Formula Meaning

Path Error Free Sec (pathErrorFreeSec/NUM)                      
DELTA

Number of seconds that the 
Sonet/SDH/ PATH 
component has been in a 
near error-free state.

Path Error Free Sec since 
Baseline

(pathErrorFreeSec/NUM)                      
BASELINEDELTA

Number of seconds that the 
Sonet/SDH/ PATH 
component has been in a 
near error-free state, since 
the last baseline reset.

Path Code Violations (pathCodeViolations/NUM)                      
DELTA

Number of path code 
violations.

Path Code Violations since 
Baseline

(pathCodeViolations/NUM)                      
BASELINEDELTA

Number of path code 
violations since the last 
baseline reset.

Path Errored Sec (pathErroredSec/NUM)                      
DELTA

Number of path errored 
seconds.

Path Errored Sec since 
Baseline

(pathErroredSec/NUM)                      
BASELINEDELTA

Number of path errored 
seconds, since the last 
baseline reset.

Path Severe Errored Sec (pathSevErroredSec/NUM)                      
DELTA

Number of path severe 
errored seconds.

Path Severe Errored Sec 
since Baseline

(pathSevErroredSec/NUM)                      
BASELINEDELTA

Number of path severe 
errored seconds, since the 
last baseline reset.

Path Ais Lop Sec (pathAisLopSec/NUM)                      
DELTA

Number of path AIS and LOP 
seconds.

Path Ais Lop Sec since 
Baseline

(pathAisLopSec/NUM)                      
BASELINEDELTA

Number of path AIS and LOP 
seconds, since the last 
baseline reset.
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Path Unavailable Sec (pathUnavailSec/NUM)                      
DELTA

Number of one-second 
intervals for which the STS/
STM path is unavailable.

Path Unavailable Sec since 
Baseline

(pathUnavailSec/NUM)                      
BASELINEDELTA

Number of one-second 
intervals for which the STS/
STM path is unavailable, 
since the last baseline reset.

Table 62 (Continued)
Component: EM/ LP/ SDH/ PATH/

Name Formula Meaning
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Table 63
Component: EM/ LP/ SDH/ PATH/ CELL

Name Formula Meaning

Rx Cell Util (receiveCellUtilization/NUM) Ratio of number of valid 
assigned cells received on 
link to nominal capacity.

Tx Cell Util (transmitCellUtilization/NUM) Ratio of number of valid 
assigned cells transmitted on 
link to nominal capacity.

Table 64
Component: EM/ LP/ SONET/

Name Formula Meaning

Error Free Sec (errorFreeSec/NUM)                      
DELTA

Number of seconds that the 
Sonet/Sdh component has 
been in a near error-free 
state.

Error Free Sec since 
Baseline

(errorFreeSec/NUM)                      
BASELINEDELTA

Number of seconds that the 
Sonet/Sdh component has 
been in a near error-free 
state, since the last baseline 
reset.

Section Code Violations (sectCodeViolations/NUM)                      
DELTA

Total number of Section Code 
Violations. 

Section Code Violations 
since Baseline

(sectCodeViolations/NUM)                      
BASELINEDELTA

Total number of Section Code 
Violations since the last 
baseline reset.

Section Error Sec (sectErroredSec/NUM)                      
DELTA

Total number of Section Error 
Seconds.

 (Sheet 1 of 3)
Preside MDM Performance Management  User Guide   15.1



230   Appendix A Passport performance metrics
Section Error Sec since 
Baseline

(sectErroredSec/NUM)                      
BASELINEDELTA

Total number of Section Error 
Seconds since the last 
baseline reset.

Section Severe Error Sec (sectSevErroredSec/NUM)                      
DELTA

Total number of Section 
Severely Errored Seconds.

Section Severe Error Sec 
since Baseline

(sectSevErroredSec/NUM)                      
BASELINEDELTA

Total number of Section 
Severely Errored Seconds 
since the last baseline reset.

Section Los Sec (sectLosSec/NUM)                      
DELTA

Total number of section LOS 
seconds.

Section Los Sec since 
Baseline

(sectLosSec/NUM)                      
BASELINEDELTA

Total number of section LOS 
seconds since the last 
baseline reset.

Section Severe Error 
Frame Sec

(sectSevErroredFrmSec/NUM)                      
DELTA

Total number of Section 
Severely Errored Frame 
Seconds.

Section Severe Error 
Frame Sec since Baseline

(sectSevErroredFrmSec/NUM)                      
BASELINEDELTA

Total number of Section 
Severely Errored Frame 
Seconds since the last  
baseline reset.

Section Failures (sectFailures/NUM)                      
DELTA

Total number of times a 
section failure (LOS or LOF) 
occurs.

Section Failures since 
Baseline

(sectFailures/NUM)                      
BASELINEDELTA

Total number of times a 
section failure (LOS or LOF) 
occurs since the  last baseline 
reset.

Line Code Violations (lineCodeViolations/NUM)                      
DELTA

Total number of Line Code 
Violations. 

Line Code Violations since 
Baseline

(lineCodeViolations/NUM)                      
BASELINEDELTA

Total number of Line Code 
Violations since the last 
baseline reset.

Table 64 (Continued)
Component: EM/ LP/ SONET/

Name Formula Meaning
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Line Errored Sec (lineErroredSec/NUM)                      
DELTA

Total number of Line Errored 
Seconds.

Line Errored Sec since 
Baseline

(lineErroredSec/NUM)                      
BASELINEDELTA

Total number of Line Errored 
Seconds since the last 
baseline reset.

Line Severe Errored Sec (lineSevErroredSec/NUM)                      
DELTA

Total number of Line Severely 
Errored Seconds.

Line Severe Errored Sec 
since Baseline

(lineSevErroredSec/NUM)                      
BASELINEDELTA

Total number of Line Severely 
Errored Seconds since the 
last baseline  reset.

Line Ais Sec (lineAisSec/NUM)                      
DELTA

Total number of Line AIS 
Seconds. 

Line Ais Sec since Baseline (lineAisSec/NUM)                      
BASELINEDELTA

Total number of Line AIS 
Seconds since the last 
baseline reset.

Line Unavailable Sec (lineUnavailSec/NUM)                      
DELTA

Total number of one-second 
intervals for which the STS 
line is unavailable.

Line Unavailable Sec since 
Baseline

(lineUnavailSec/NUM)                      
BASELINEDELTA

Total number of one-second 
intervals for which the STS 
line is unavailable, since the 
last baseline reset.

Line Failures (lineFailures/NUM)                      
DELTA

Total number of times that a 
line failure (L-AIS) occurs.

Line Failures since 
Baseline

(lineFailures/NUM)                      
BASELINEDELTA

Total number of times that a 
line failure (L-AIS) occurs, 
since the last baseline reset.

Table 64 (Continued)
Component: EM/ LP/ SONET/

Name Formula Meaning
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Table 65
Component: EM/ LP/ SONET/ PATH/

Name Formula Meaning

Path Error Free Sec (pathErrorFreeSec/NUM)                      
DELTA

Number of seconds that the 
Sonet/SDH/ PATH 
component has been in a 
near error-free state.

Path Error Free Sec since 
Baseline

(pathErrorFreeSec/NUM)                      
BASELINEDELTA

Number of seconds that the 
Sonet/SDH/ PATH 
component has been in a 
near error-free state, since 
the last baseline reset.

Path Code Violations (pathCodeViolations/NUM)                      
DELTA

Number of path code 
violations.

Path Code Violations since 
Baseline

(pathCodeViolations/NUM)                      
BASELINEDELTA

Number of path code 
violations since the last 
baseline reset.

Path Errored Sec (pathErroredSec/NUM)                      
DELTA

Number of path errored 
seconds.

Path Errored Sec since 
Baseline

(pathErroredSec/NUM)                      
BASELINEDELTA

Number of path errored 
seconds, since the last 
baseline reset.

Path Severe Errored Sec (pathSevErroredSec/NUM)                      
DELTA

Number of path severe 
errored seconds.

Path Severe Errored Sec 
since Baseline

(pathSevErroredSec/NUM)                      
BASELINEDELTA

Number of path severe 
errored seconds, since the 
last baseline reset.

Path Ais Lop Sec (pathAisLopSec/NUM)                      
DELTA

Number of path AIS and LOP 
seconds.

Path Ais Lop Sec since 
Baseline

(pathAisLopSec/NUM)                      
BASELINEDELTA

Number of path AIS and LOP 
seconds, since the last 
baseline reset.
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Path Unavailable Sec (pathUnavailSec/NUM)                      
DELTA

Number of one-second 
intervals for which the STS/
STM path is unavailable.

Path Unavailable Sec since 
Baseline

(pathUnavailSec/NUM)                      
BASELINEDELTA

Number of one-second 
intervals for which the STS/
STM path is unavailable, 
since the last baseline reset.

Table 65 (Continued)
Component: EM/ LP/ SONET/ PATH/

Name Formula Meaning
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Table 66
Component: EM/ LP/ SONET/ PATH/ CELL

Name Formula Meaning

Rx Cell Util (receiveCellUtilization/NUM) Ratio of number of valid 
assigned cells received on 
link to nominal capacity.

Tx Cell Util (transmitCellUtilization/NUM) Ratio of number of valid 
assigned cells transmitted on 
link to nominal capacity.

Table 67
Component: EM/ MPANL/

Name Formula Meaning

Frames per second Sent (frmToIf/NUM)                      DELTA                      
SECONDS                      DIVIDE

Number of frames sent per 
second since last probe.

Frames Sent since 
Baseline

(frmToIf/NUM)                      
BASELINEDELTA

Number of frames sent since 
the last baseline reset.

Frames per second 
Received

(frmFromIf/NUM)                      DELTA                      
SECONDS                      DIVIDE

Number of frames received 
per second since last probe.

Frames Received since 
Baseline

(frmFromIf/NUM)                      
BASELINEDELTA

Number of frames received 
since the last baseline reset.

Kilobytes per second Sent (octetToIf/NUM)                      DELTA                      
SECONDS                      DIVIDE                      
1000                      DIVIDE

Number of kilobytes sent per 
second since last probe.

Kilobytes Sent since 
Baseline

(octetToIf/NUM)                      
BASELINEDELTA                      1000                      
DIVIDE

Number of kilobytes sent 
since the last baseline reset.

Kilobytes per second 
Received

(octetFromIf/NUM)                      
DELTA                      SECONDS                      
DIVIDE                      1000                      
DIVIDE

Number of kilobytes received 
per second since last probe.
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Kilobytes Received since 
Baseline

(octetFromIf/NUM)                      
BASELINEDELTA                      1000                      
DIVIDE

Number of kilobytes received 
since the last baseline reset.

Frame Header Format 
Errors

(invalidHeaderFramesFromIf/
NUM)                      DELTA

Number of frames with invalid 
headers since last probe.

Frame Header Format 
Errors since Baseline

(invalidHeaderFramesFromIf/
NUM)                      BASELINEDELTA

Number of frames with invalid 
headers since the last 
baseline reset.

Unknown DLCI Errors (unknownDlciFramesFromIf/NUM)                      
DELTA

Number of frames with 
unknown DLCI since last 
probe.

Unknown DLCI Errors 
since Baseline

(unknownDlciFramesFromIf/NUM)                      
BASELINEDELTA

Number of frames with 
unknown DLCI since the last 
baseline reset.

Last Unknown DLCI (lastUnknownDlci/NUM) DLCI of the last unknown 
DLCI frame. 

Table 67 (Continued)
Component: EM/ MPANL/

Name Formula Meaning
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Table 68
Component: EM/ MPANL/ FRAMER

Name Formula Meaning

Frames per second Sent (frmToIf/NUM)                      DELTA                      
SECONDS                      DIVIDE

Frames sent per second.

Frames per second Sent 
since Baseline

(frmToIf/NUM)                      
BASELINEDELTA

Frames sent since the last 
baseline reset.

Frames per second 
Received

(frmFromIf/NUM)                      DELTA                      
SECONDS                      DIVIDE

Frames received per second.

Frames Received since 
Baseline

(frmFromIf/NUM)                      
BASELINEDELTA

Frames received since the 
last baseline reset.

Outgoing Normal Link 
Utilization

(normPrioLinkUtilToIf/NUM) Normal traffic sending link 
utilization.

Incoming Normal Link 
Utilization

(normPrioLinkUtilFromIf/NUM) Normal traffic receiving link 
utilization.

Octet Alignment Errors (nonOctetErrors/NUM)                      
DELTA

Number of non-octet aligned 
frames since last probe.

Octet Alignment Errors 
since Baseline

(nonOctetErrors/NUM)                      
BASELINEDELTA

Number of non-octet aligned 
frames since the last baseline 
reset.

Frame Length Errors (largeFrmErrors/NUM)                      
DELTA

Number of bad length frames 
since last probe. 

Frame Length Errors since 
Baseline

(largeFrmErrors/NUM)                      
BASELINEDELTA

Number of bad length frames 
since the last baseline reset.

Frame Abort Errors (aborts/NUM)                      DELTA Number of aborted frames 
since last probe.

Frame Abort Errors since 
Baseline

(aborts/NUM)                      
BASELINEDELTA

Number of aborted frames 
since the last baseline reset.
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Table 69
Component: EM/ MPANL/ SIGMPANL

Name Formula Meaning

Protocol Errors (protocolErrors/NUM)                      
DELTA

Number of protocol error 
reports sent since last probe.

Protocol Errors since 
Baseline

(protocolErrors/NUM)                      
BASELINEDELTA

Number of protocol error 
reports sent since the last 
baseline reset.

SAP 0 Commands Sent (sap0CommandsTx/NUM)                      
DELTA

Number of SAP-0 commands 
sent since last probe.

SAP 0 Commands Sent 
since Baseline

(sap0CommandsTx/NUM)                      
BASELINEDELTA

Number of SAP-0 commands 
sent since the last baseline 
reset.

SAP 0 Commands 
Received

(sap0CommandsRx/NUM)                      
DELTA

Number of SAP-0 commands 
received since last probe.

SAP 0 Commands 
Received since Baseline

(sap0CommandsRx/NUM)                      
BASELINEDELTA

Number of SAP-0 commands 
received since the last 
baseline reset.

SAP X Commands Sent (sapXCommandsTx/NUM)                      
DELTA

Number of SAP X commands 
sent since last probe.

SAP X Commands Sent 
since Baseline

(sapXCommandsTx/NUM)                      
BASELINEDELTA

Number of SAP X commands 
sent since the last baseline 
reset.

SAP X Commands 
Received

(sapXCommandsRx/NUM)                      
DELTA

Number of SAP X commands 
receivd since last probe.

SAP X Commands 
Received since Baseline

(sapXCommandsRx/NUM)                      
BASELINEDELTA

Number of SAP X commands 
receivd since the last baseline 
reset.
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Table 70
Component: EM/ PCGTL/ NSE/

Name Formula Meaning

Oct From Sgsn (octetsFromSgsn/NUM)                      
DELTA                      SECONDS                      
DIVIDE

The description for this metric 
is currently not defined.

Oct From Sgsn since 
Baseline

(octetsFromSgsn/NUM)                      
BASELINEDELTA

The description for this metric 
is currently not defined.

Oct To Sgsn (octetsToSgsn/NUM)                      
DELTA                      SECONDS                      
DIVIDE

The description for this metric 
is currently not defined.

Oct To Sgsn since Baseline (octetsToSgsn/NUM)                      
BASELINEDELTA

The description for this metric 
is currently not defined.

Table 71
Component: EM/ PPP/ FRAMER

Name Formula Meaning

Frames per second Sent (frmToIf/NUM)                      DELTA                      
SECONDS                      DIVIDE

Frames sent per second.

Frames Sent since 
Baseline

(frmToIf/NUM)                      
BASELINEDELTA

Frames sent since the last 
baseline reset.

Frames per second 
Received

(frmFromIf/NUM)                      DELTA                      
SECONDS                      DIVIDE

Frames received per second.

Frames Received since 
Baseline

(frmFromIf/NUM)                      
BASELINEDELTA

Frames received since the 
last baseline reset.

Outgoing Normal Link 
Utilization

(normPrioLinkUtilToIf/NUM) Normal traffic sending link 
utilization.

Incoming Normal Link 
Utilization

(normPrioLinkUtilFromIf/NUM) Normal traffic receiving link 
utilization.

 (Sheet 1 of 2)
241-6001-031   15.1    



Appendix A Passport performance metrics   239
Octet Alignment Errors (nonOctetErrors/NUM)                      
DELTA

Number of non-octet aligned 
frames since last probe.

Octet Alignment Errors 
since Baseline

(nonOctetErrors/NUM)                      
BASELINEDELTA

Number of non-octet aligned 
frames since the last baseline 
reset.

Frame Length Errors (largeFrmErrors/NUM)                      
DELTA

Number of bad length frames 
since last probe.

Frame Length Errors since 
Baseline

(largeFrmErrors/NUM)                      
BASELINEDELTA

Number of bad length frames 
since the last baseline reset.

Frame Abort Errors (aborts/NUM)                      DELTA Number of aborted frames 
since last probe.

Frame Abort Errors since 
Baseline

(aborts/NUM)                      
BASELINEDELTA

Number of aborted frames 
since the last baseline reset.

Table 71 (Continued)
Component: EM/ PPP/ FRAMER

Name Formula Meaning
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Table 72
Component: EM/ RTR/

Name Formula Meaning

Input Datagrams Received (inReceives/NUM)                      
DELTA

The number of input 
datagrams received from the 
interfaces, including those 
received in error since the last 
probe.

Input Datagrams Received 
since Baseline

(inReceives/NUM)                      
BASELINEDELTA

The number of input 
datagrams received from the 
interfaces, including those 
received in error since the last 
baseline reset.

Invalid Address Errors 
Discarded

(inAddrErrors/NUM)                      
DELTA

The number of input 
datagrams discarded due to 
errors such as invalid 
address, unsupported 
address class since the last 
probe.

Invalid Address Errors 
Discarded since Baseline

(inAddrErrors/NUM)                      
BASELINEDELTA

The number of input 
datagrams discarded due to 
errors such as invalid 
address, unsupported 
address class since the last 
baseline reset.

Invalid Header Errors 
Discarded

(inHdrErrors/NUM)                      
DELTA

The number of input 
datagrams discarded due to 
errors in their IP headers, 
including bad checksums, 
version number mismatch, 
other format errors, time-to-
live exceeded, errors 
discovered in processing their 
IP options, etc since the last 
probe.
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Invalid Header Errors 
Discarded since Baseline

(inHdrErrors/NUM)                      
BASELINEDELTA

The number of input 
datagrams discarded due to 
errors in their IP headers, 
including bad checksums, 
version number mismatch, 
other format errors, time-to-
live exceeded, errors 
discovered in processing their 
IP options, etc since the last 
baseline reset.

Input Datagrams Discarded (inDiscards/NUM)                      
DELTA

The number of input 
datagrams for which no 
problems were encountered 
to prevent their continued 
processing, but which were 
discarded due to the lack of 
buffers since the last probe. 
This does not include any 
datagram discarded while 
awaiting for re-asembly.

Input Datagrams Discarded 
since Baseline

(inDiscards/NUM)                      
BASELINEDELTA

The number of input 
datagrams for which no 
problems were encountered 
to prevent their continued 
processing, but which were 
discarded due to the lack of 
buffers since the last baseline 
reset. This does not include 
any datagram discarded 
while awaiting for re-asembly.

Input Datagrams Delivered (inDelivers/NUM)                      DELTA The number of input 
datagrams successfully 
delivered to IP user- protocols 
(including ICMP) since the 
last probe.

Table 72 (Continued)
Component: EM/ RTR/

Name Formula Meaning
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Input Datagrams Delivered 
since Baseline

(inDelivers/NUM)                      
BASELINEDELTA

The number of input 
datagrams successfully 
delivered to IP user- protocols 
(including ICMP) since the 
last baseline reset.

Out Requests (outRequests/NUM)                      
DELTA

The number of datagrams 
which local IP user-protocols 
(including ICMP) supplied to 
IP in requests for 
transmission since the last 
probe.

Out Requests since 
Baseline

(outRequests/NUM)                      
BASELINEDELTA

The number of datagrams 
which local IP user-protocols 
(including ICMP)  supplied to 
IP in requests for 
transmission since the last 
baseline reset.

Out Discards (outDiscards/NUM)                      
DELTA

The number of outbound 
datagrams that were 
discarded due to the lack of 
buffers since the last probe.

Out Discards since 
Baseline

(outDiscards/NUM)                      
BASELINEDELTA

The number of outbound 
datagrams that were 
discarded due to the lack of 
buffers since the last baseline 
reset.

No Route Out Discards (outNoRoutes/NUM)                      
DELTA

The number of outbound 
datagrams discarded 
because no route could be 
found to transmit them to their 
destination since the last 
probe.

Table 72 (Continued)
Component: EM/ RTR/

Name Formula Meaning
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No Route Out Discards 
since Baseline

(outNoRoutes/NUM)                      
BASELINEDELTA

The number of outbound 
datagrams discarded 
because no route could be 
found to transmit them to their 
destination since the last 
baseline reset.

Routing Discards (routingDiscards/NUM)                      
DELTA

The number of routing entries 
which were chosen to be 
discarded even though they 
are valid since the last probe.

Routing Discards since 
Baseline

(routingDiscards/NUM)                      
BASELINEDELTA

The number of routing entries 
which were chosen to be 
discarded even though they 
are valid since the last 
baseline reset.

Table 72 (Continued)
Component: EM/ RTR/

Name Formula Meaning
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Table 73
Component: EM/ RTR/ IF/

Name Formula Meaning

In Octets (ifInOctets/NUM)                      DELTA Number of octets received on 
the interface, including 
framing characters, in 32-bit.

In Octets since Baseline (ifInOctets/NUM)                      
BASELINEDELTA

Number of octets received on 
the interface, including 
framing characters, since the 
last baseline reset, in 32-bit.

In Octets (64-bit) (ifHCInOctets/NUM)                      
DELTA

Number of octets received on 
the interface, including 
framing characters, in 64-bit.

In Octets since Baseline 
(64-bit)

(ifHCInOctets/NUM)                      
BASELINEDELTA

Number of octets received on 
the interface, including 
framing characters, since the 
last baseline reset, in 64-bit.

Out Octets (ifOutOctets/NUM)                      
DELTA

Number of octets transmitted 
out the interface, including 
framing characters, in 32-bit.

Out Octets since Baseline (ifOutOctets/NUM)                      
BASELINEDELTA

Number of octets transmitted 
out the interface, including 
framing characters, since the 
last baseline reset, in 32-bit.

Out Octets (64-bit) (ifHCOutOctets/NUM)                      
DELTA

Number of octets transmitted 
out the interface, including 
framing characters, in 64-bit.

Out Octets since Baseline 
(64-bit)

(ifHCOutOctets/NUM)                      
BASELINEDELTA

Number of octets transmitted 
out the interface, including 
framing characters, since the 
last baseline reset, in 64-bit.
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In Discards (ifInDiscards/NUM)                      
DELTA

Number of inbound packets 
discarded even though no 
errors detected. Prevents the 
packets from being delivered 
to a higher layer protocol.

In Discards since Baseline (ifInDiscards/NUM)                      
BASELINEDELTA

Number of inbound packets 
discarded even though no 
errors detected since the last 
baseline reset. Prevents the 
packets from being delivered 
to a higher layer protocol.

Out Discards (ifOutDiscards/NUM)                      
DELTA

Number of outbound packets 
discarded even though no 
errors detected. Prevents the 
packets from being 
transmitted.

Out Discards since 
Baseline

(ifOutDiscards/NUM)                      
BASELINEDELTA

Number of outbound packets 
discarded even though no 
errors detected since the last 
baseline reset. Prevents the 
packets from being 
transmitted.

In Ucast Pkts (ifInUcastPkts/NUM)                      
DELTA

Number of subnetwork-
unicast packets delivered to a 
higher layer protocol, in 32-
bit.

In Ucast Pkts since 
Baseline

(ifInUcastPkts/NUM)                      
BASELINEDELTA

Number of subnetwork-
unicast packets delivered to a 
higher layer protocol since the 
last baseline reset, in 32-bit.

In Ucast Pkts (64-bit) (ifHCInUcastPkts/NUM)                      
DELTA

Number of subnetwork-
unicast packets delivered to a 
higher layer protocol, in 64-
bit.

Table 73 (Continued)
Component: EM/ RTR/ IF/

Name Formula Meaning
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In Ucast Pkts since 
Baseline (64-bit)

(ifHCInUcastPkts/NUM)                      
BASELINEDELTA

Number of subnetwork-
unicast packets delivered to a 
higher layer protocol since the 
last baseline reset, in 64-bit.

Out Ucast Pkts (ifOutUcastPkts/NUM)                      
DELTA

Number of packets the higher 
level protocols request to be 
transmitted to a subnetwork-
unicast address. Includes 
discarded and unsent 
packets, in 32-bit.

Out Ucast Pkts since 
Baseline

(ifOutUcastPkts/NUM)                      
BASELINEDELTA

Number of packets the higher 
level protocols request to be 
transmitted to a subnetwork-
unicast address, since the 
last baseline reset. Includes 
discarded and unsent 
packets, in 32-bit.

Out Ucast Pkts (64-bit) (ifHCOutUcastPkts/NUM)                      
DELTA

Number of packets the higher 
level protocols request to be 
transmitted to a subnetwork-
unicast address. Includes 
discarded and unsent 
packets, in 64-bit.

Out Ucast Pkts since 
Baseline (64-bit)

(ifHCOutUcastPkts/NUM)                      
BASELINEDELTA

Number of packets the higher 
level protocols request to be 
transmitted to a subnetwork-
unicast address, since the 
last baseline reset. Includes 
discarded and unsent 
packets, in 64-bit.

In NUcast Pkts (ifInNuCastPkts/NUM)                      
DELTA

Number of non-unicast 
packets delivered to a higher 
layer protocol.

Table 73 (Continued)
Component: EM/ RTR/ IF/

Name Formula Meaning
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In NUcast Pkts since 
Baseline

(ifInNuCastPkts/NUM)                      
BASELINEDELTA

Number of non-unicast 
packets delivered to a higher 
layer protocol, since the last 
baseline reset.

Out NUcast Pkts (ifOutNuCastPkts/NUM)                      
DELTA

Number of packets the higher 
level protocols request to be 
transmitted to a non-unicast 
address. Includes discarded 
and unsent packets.

Out NUcast Pkts since 
Baseline

(ifOutNuCastPkts/NUM)                      
BASELINEDELTA

Number of packets the higher 
level protocols request to be 
transmitted to a non-unicast 
address, since the last 
baseline reset. Includes 
discarded and unsent 
packets.

Table 73 (Continued)
Component: EM/ RTR/ IF/

Name Formula Meaning
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Table 74
Component: EM/ RTR/ IF/ LDPIF

Name Formula Meaning

In Octets Received (inOctets/NUM)                      DELTA The number of octets 
received from terminating or 
incoming tandem MPLS data 
traffic since the last probe.

In Octets Received since 
Baseline

(inOctets/NUM)                      
BASELINEDELTA

The number of octets 
received from terminating or 
incoming tandem MPLS data 
traffic since the last baseline 
reset.

In Frames Received (inFrames/NUM)                      DELTA The number of frames 
received from terminating or 
incoming tandem MPLS data 
traffic since the last probe.

In Frames Received since 
Baseline

(inFrames/NUM)                      
BASELINEDELTA

The number of frames 
received from terminating or 
incoming tandem MPLS data 
traffic since the last baseline 
reset.

In Frames Discarded (inFramesDiscards/NUM)                      
DELTA

The number of frames 
received but discarded from 
terminating or incoming 
tandem MPLS data traffic 
since the last probe.

In Frames Discarded since 
Baseline

(inFramesDiscards/NUM)                      
BASELINEDELTA

The number of frames 
received but discarded from 
terminating or incoming 
tandem MPLS data traffic 
since the last baseline reset.

Out Octets Received (outOctets/NUM)                      DELTA The number of octets 
transmitted for originating or 
outgoing transit MPLS data 
since the last probe.
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Out Octets Received since 
Baseline

(outOctets/NUM)                      
BASELINEDELTA

The number of octets 
transmitted for originating or 
outgoing transit MPLS data 
since the last baseline reset.

Out Frames Transmitted (outFrames/NUM)                      
DELTA

The total number frames of  
transmitted since the last 
probe.

Out Frames Transmitted 
since Baseline

(outFrames/NUM)                      
BASELINEDELTA

The total number of frames 
transmitted since the last 
baseline reset.

Out Frames Discarded (outFramesDiscards/NUM)                      
DELTA

The total number frames of  
transmitted that were 
discarded since the last 
probe.

Out Frames Discarded 
since Baseline

(outFramesDiscards/NUM)                      
BASELINEDELTA

The total number of frames 
transmitted that were 
discarded since the last 
baseline reset.

Table 74 (Continued)
Component: EM/ RTR/ IF/ LDPIF

Name Formula Meaning
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Table 75
Component: EM/ RTR/ VRF/

Name Formula Meaning

Input Datagrams Received (inReceives/NUM)                      
DELTA

The number of input 
datagrams received from the 
interfaces, including those 
received in error since the last 
probe.

Input Datagrams Received 
since Baseline

(inReceives/NUM)                      
BASELINEDELTA

The number of input 
datagrams received from the 
interfaces, including those 
received in error since the last 
baseline reset.

Invalid Address Errors 
Discarded

(inAddrErrors/NUM)                      
DELTA

The number of input 
datagrams discarded due to 
errors such as invalid 
address, unsupported 
address class since the last 
probe.

Invalid Address Errors 
Discarded since Baseline

(inAddrErrors/NUM)                      
BASELINEDELTA

The number of input 
datagrams discarded due to 
errors such as invalid 
address, unsupported 
address class since the last 
baseline reset.

Invalid Header Errors 
Discarded

(inHdrErrors/NUM)                      
DELTA

The number of input 
datagrams discarded due to 
errors in their IP headers, 
including bad checksums, 
version number mismatch, 
other format errors, time-to-
live exceeded, errors 
discovered in processing their 
IP options, etc since the last 
probe.
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Invalid Header Errors 
Discarded since Baseline

(inHdrErrors/NUM)                      
BASELINEDELTA

The number of input 
datagrams discarded due to 
errors in their IP headers, 
including bad checksums, 
version number mismatch, 
other format errors, time-to-
live exceeded, errors 
discovered in processing their 
IP options, etc since the last 
baseline reset.

Input Datagrams Discarded (inDiscards/NUM)                      
DELTA

The number of input 
datagrams for which no 
problems were encountered 
to prevent their continued 
processing, but which were 
discarded due to the lack of 
buffers since the last probe. 
This does not include any 
datagram discarded while 
awaiting for re-asembly.

Input Datagrams Discarded 
since Baseline

(inDiscards/NUM)                      
BASELINEDELTA

The number of input 
datagrams for which no 
problems were encountered 
to prevent their continued 
processing, but which were 
discarded due to the lack of 
buffers since the last baseline 
reset. This does not include 
any datagram discarded 
while awaiting for re-asembly.

Input Datagrams Delivered (inDelivers/NUM)                      DELTA The number of input 
datagrams successfully 
delivered to IP user- protocols 
(including ICMP) since the 
last probe.

Table 75 (Continued)
Component: EM/ RTR/ VRF/

Name Formula Meaning
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Input Datagrams Delivered 
since Baseline

(inDelivers/NUM)                      
BASELINEDELTA

The number of input 
datagrams successfully 
delivered to IP user- protocols 
(including ICMP) since the 
last baseline reset.

Out Requests (outRequests/NUM)                      
DELTA

The number of datagrams 
which local IP user-protocols 
(including ICMP) supplied to 
IP in requests for 
transmission since the last 
probe.

Out Requests since 
Baseline

(outRequests/NUM)                      
BASELINEDELTA

The number of datagrams 
which local IP user-protocols 
(including ICMP)  supplied to 
IP in requests for 
transmission since the last 
baseline reset.

Out Discards (outDiscards/NUM)                      
DELTA

The number of outbound 
datagrams that were 
discarded due to the lack of 
buffers since the last probe.

Out Discards since 
Baseline

(outDiscards/NUM)                      
BASELINEDELTA

The number of outbound 
datagrams that were 
discarded due to the lack of 
buffers since the last baseline 
reset.

No Route Out Discards (outNoRoutes/NUM)                      
DELTA

The number of outbound 
datagrams discarded 
because no route could be 
found to transmit them to their 
destination since the last 
probe.

Table 75 (Continued)
Component: EM/ RTR/ VRF/

Name Formula Meaning
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No Route Out Discards 
since Baseline

(outNoRoutes/NUM)                      
BASELINEDELTA

The number of outbound 
datagrams discarded 
because no route could be 
found to transmit them to their 
destination since the last 
baseline reset.

Routing Discards (routingDiscards/NUM)                      
DELTA

The number of routing entries 
which were chosen to be 
discarded even though they 
are valid since the last probe.

Routing Discards since 
Baseline

(routingDiscards/NUM)                      
BASELINEDELTA

The number of routing entries 
which were chosen to be 
discarded even though they 
are valid since the last 
baseline reset.

Table 75 (Continued)
Component: EM/ RTR/ VRF/

Name Formula Meaning
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Table 76
Component: EM/ RTR/ VRF/ IF/

Name Formula Meaning

In Octets (ifInOctets/NUM)                      DELTA Number of octets received on 
the interface, including 
framing characters, in 32-bit.

In Octets since Baseline (ifInOctets/NUM)                      
BASELINEDELTA

Number of octets received on 
the interface, including 
framing characters, since the 
last baseline reset, in 32-bit.

In Octets (64-bit) (ifHCInOctets/NUM)                      
DELTA

Number of octets received on 
the interface, including 
framing characters, in 64-bit.

In Octets since Baseline 
(64-bit)

(ifHCInOctets/NUM)                      
BASELINEDELTA

Number of octets received on 
the interface, including 
framing characters, since the 
last baseline reset, in 64-bit.

Out Octets (ifOutOctets/NUM)                      
DELTA

Number of octets transmitted 
out the interface, including 
framing characters, in 32-bit.

Out Octets since Baseline (ifOutOctets/NUM)                      
BASELINEDELTA

Number of octets transmitted 
out the interface, including 
framing characters, since the 
last baseline reset, in 32-bit.

Out Octets (64-bit) (ifHCOutOctets/NUM)                      
DELTA

Number of octets transmitted 
out the interface, including 
framing characters, in 64-bit.

Out Octets since Baseline 
(64-bit)

(ifHCOutOctets/NUM)                      
BASELINEDELTA

Number of octets transmitted 
out the interface, including 
framing characters, since the 
last baseline reset, in 64-bit.
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In Discards (ifInDiscards/NUM)                      
DELTA

Number of inbound packets 
discarded even though no 
errors detected. Prevents the 
packets from being delivered 
to a higher layer protocol.

In Discards since Baseline (ifInDiscards/NUM)                      
BASELINEDELTA

Number of inbound packets 
discarded even though no 
errors detected since the last 
baseline reset. Prevents the 
packets from being delivered 
to a higher layer protocol.

Out Discards (ifOutDiscards/NUM)                      
DELTA

Number of outbound packets 
discarded even though no 
errors detected. Prevents the 
packets from being 
transmitted.

Out Discards since 
Baseline

(ifOutDiscards/NUM)                      
BASELINEDELTA

Number of outbound packets 
discarded even though no 
errors detected since the last 
baseline reset. Prevents the 
packets from being 
transmitted.

In Ucast Pkts (ifInUcastPkts/NUM)                      
DELTA

Number of subnetwork-
unicast packets delivered to a 
higher layer protocol, in 32-
bit.

In Ucast Pkts since 
Baseline

(ifInUcastPkts/NUM)                      
BASELINEDELTA

Number of subnetwork-
unicast packets delivered to a 
higher layer protocol since the 
last baseline reset, in 32-bit.

In Ucast Pkts (64-bit) (ifHCInUcastPkts/NUM)                      
DELTA

Number of subnetwork-
unicast packets delivered to a 
higher layer protocol, in 64-
bit.

Table 76 (Continued)
Component: EM/ RTR/ VRF/ IF/

Name Formula Meaning
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In Ucast Pkts since 
Baseline (64-bit)

(ifHCInUcastPkts/NUM)                      
BASELINEDELTA

Number of subnetwork-
unicast packets delivered to a 
higher layer protocol since the 
last baseline reset, in 64-bit.

Out Ucast Pkts (ifOutUcastPkts/NUM)                      
DELTA

Number of packets the higher 
level protocols request to be 
transmitted to a subnetwork-
unicast address. Includes 
discarded and unsent 
packets, in 32-bit.

Out Ucast Pkts since 
Baseline

(ifOutUcastPkts/NUM)                      
BASELINEDELTA

Number of packets the higher 
level protocols request to be 
transmitted to a subnetwork-
unicast address, since the 
last baseline reset. Includes 
discarded and unsent 
packets, in 32-bit.

Out Ucast Pkts (64-bit) (ifHCOutUcastPkts/NUM)                      
DELTA

Number of packets the higher 
level protocols request to be 
transmitted to a subnetwork-
unicast address. Includes 
discarded and unsent 
packets, in 64-bit.

Out Ucast Pkts since 
Baseline (64-bit)

(ifHCOutUcastPkts/NUM)                      
BASELINEDELTA

Number of packets the higher 
level protocols request to be 
transmitted to a subnetwork-
unicast address, since the 
last baseline reset. Includes 
discarded and unsent 
packets, in 64-bit.

In NUcast Pkts (ifInNuCastPkts/NUM)                      
DELTA

Number of non-unicast 
packets delivered to a higher 
layer protocol.

Table 76 (Continued)
Component: EM/ RTR/ VRF/ IF/

Name Formula Meaning
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In NUcast Pkts since 
Baseline

(ifInNuCastPkts/NUM)                      
BASELINEDELTA

Number of non-unicast 
packets delivered to a higher 
layer protocol, since the last 
baseline reset.

Out NUcast Pkts (ifOutNuCastPkts/NUM)                      
DELTA

Number of packets the higher 
level protocols request to be 
transmitted to a non-unicast 
address. Includes discarded 
and unsent packets.

Out NUcast Pkts since 
Baseline

(ifOutNuCastPkts/NUM)                      
BASELINEDELTA

Number of packets the higher 
level protocols request to be 
transmitted to a non-unicast 
address, since the last 
baseline reset. Includes 
discarded and unsent 
packets.

Table 76 (Continued)
Component: EM/ RTR/ VRF/ IF/

Name Formula Meaning
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Table 77
Component: EM/ RTR/ VRF/ IF/ ATMMPE AC/

Name Formula Meaning

In Packets/sec (inPackets/NUM)                      DELTA                      
SECONDS                      DIVIDE

Counts the total number of 
packets received on this 
connection.

In Packets since Baseline (inPackets/NUM)                      
BASELINEDELTA

Counts the total number of 
packets received on this 
connection since the last 
baseline reset.

In Octects/sec (inOctets/NUM)                      DELTA                      
SECONDS                      DIVIDE

Counts the total number of 
octets received on this 
connection.

In Octects since Baseline (inOctets/NUM)                      
BASELINEDELTA

Counts the total number of 
octets received on this 
connection since the last 
baseline reset.

In UnknownProtos/sec (inUnknownProtos/NUM)                      
DELTA                      SECONDS                      
DIVIDE

Counts the total number of 
packets received on this 
connection which were 
discarded because they 
contained an unknown or 
unsupported protocol.

In UnknownProtos since 
Baseline

(inUnknownProtos/NUM)                      
BASELINEDELTA

Counts the total number of 
packets received on this 
connection which were 
discarded because they 
contained an unknown or 
unsupported protocol, since 
the last baseline reset.

In Errors/sec (inErrors/NUM)                      DELTA                      
SECONDS                      DIVIDE

Counts the total number of 
packets received on the 
connection which contained 
errors preventing them from 
being delivered to a higher-
layer protocol.
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In Errors since Baseline (inErrors/NUM)                      
BASELINEDELTA

Counts the total number of 
packets received on the 
connection which contained 
errors preventing them from 
being delivered to a higher-
layer protocol, since the last 
baseline reset.

Out Packets/sec (outPackets/NUM)                      
DELTA                      SECONDS                      
DIVIDE

outPackets

Out Packets since Baseline (outPackets/NUM)                      
BASELINEDELTA

outPackets since the last 
baseline reset.

Out Octects/sec (outOctets/NUM)                      DELTA                      
SECONDS                      DIVIDE

Counts the total number of 
octets sent on this 
connection.

Out Octects since Baseline (outOctets/NUM)                      
BASELINEDELTA

Counts the total number of 
octets sent on this connection 
since the last baseline reset.

Out Discards/sec (outDiscards/NUM)                      
DELTA                      SECONDS                      
DIVIDE

Counts the total number of 
packets which were 
supposed to be sent on this 
connection, but were 
discarded due to congestion 
or the connection being down.

Out Discards since 
Baseline

(outDiscards/NUM)                      
BASELINEDELTA

Counts the total number of 
packets which were 
supposed to be sent on this 
connection, but were 
discarded due to congestion 
or the connection being down, 
since the last baseline reset.

Table 77 (Continued)
Component: EM/ RTR/ VRF/ IF/ ATMMPE AC/

Name Formula Meaning
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Table 78
Component: EM/ RTR/ VRF/ IF/ ES METER/

Name Formula Meaning

Packets Received (packetsReceived/NUM)                      
DELTA

This attribute counts the 
number of packets received 
on an interface

Octets Received (octetsReceived/NUM)                      
DELTA

This attribute counts the 
number of octets received on 
an interface

EIR Packets Received (eirPacketsReceived/NUM)                      
DELTA

This attribute counts the 
number of octets received on 
an interface that have only 
EIR rate enforced by this 
traffic meter.

EIR Octets Received (eirOctetsReceived/NUM)                      
DELTA

This attribute counts the 
number of octets received on 
an interface that have only 
EIR rate enforced by this 
traffic meter.

Packets Remarked (packetsRemarked/NUM)                      
DELTA

This attribute counts the 
number of packets that have 
exceeded the CIR rate and 
have been re-marked by this 
traffic meter.

Octets Remarked (octetsRemarked/NUM)                      
DELTA

This attribute counts the 
number of octets that have 
exceeded the CIR rate and 
have been re-marked by this 
traffic meter.

Packets Discarded (packetsDiscarded/NUM)                      
DELTA

This attribute counts the 
number of packets discarded 
by this traffic policer.

Octets Discarded (octetsDiscarded/NUM)                      
DELTA

This attribute counts the 
number of octets discarded 
by this traffic policer.
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Committed Information 
Rate

(committedInformationRate/NUM) This attribute indicates the 
Committed Information Rate 
(cir) in bits per second.

Excess Information Rate (excessInformationRate/NUM) This attribute indicates the 
Excess Information Rate (eir) 
in bits per second.

Committed Burst Size (committedBurstSize/NUM) This attribute specifies the 
committed burst size (bc) in 
bits.

Excess Burst Size (excessBurstSize/NUM) This attribute specifies the 
excess burst size (be) in bits.

Measurment Interval (measurmentInterval/NUM) This attribute specifies the 
time interval (in milliseconds) 
over which rates and burst 
sizes are measured.

Packets Received since 
Baseline

(packetsReceived/NUM)                      
BASELINEDELTA

This attribute counts the 
number of packets received 
on an interface since last 
baseline reset 

Octets Received since 
Baseline

(octetsReceived/NUM)                      
BASELINEDELTA

This attribute counts the 
number of octets received on 
an interface since last 
baseline reset 

EIR Packets Received 
since Baseline

(eirPacketsReceived/NUM)                      
BASELINEDELTA

This attribute counts the 
number of octets received on 
an interface that have only 
EIR rate enforced by this 
traffic meter since last 
baseline reset 

Table 78 (Continued)
Component: EM/ RTR/ VRF/ IF/ ES METER/

Name Formula Meaning
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EIR Octets Received since 
Baseline since Baseline

(eirOctetsReceived/NUM)                      
BASELINEDELTA

This attribute counts the 
number of octets received on 
an interface that have only 
EIR rate enforced by this 
traffic meter since last 
baseline reset 

Packets Remarked since 
Baseline

(packetsRemarked/NUM)                      
BASELINEDELTA

This attribute counts the 
number of packets that have 
exceeded the CIR rate and 
have been re-marked by this 
traffic meter since last 
baseline reset 

Octets Remarked since 
Baseline

(octetsRemarked/NUM)                      
BASELINEDELTA

This attribute counts the 
number of octets that have 
exceeded the CIR rate and 
have been re-marked by this 
traffic meter since last 
baseline reset 

Packets Discarded since 
Baseline

(packetsDiscarded/NUM)                      
BASELINEDELTA

This attribute counts the 
number of packets discarded 
by this traffic policer since last 
baseline reset 

Octets Discarded since 
Baseline

(octetsDiscarded/NUM)                      
BASELINEDELTA

This attribute counts the 
number of octets discarded 
by this traffic policer since last 
baseline reset 

Table 78 (Continued)
Component: EM/ RTR/ VRF/ IF/ ES METER/

Name Formula Meaning
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Table 79
Component: EM/ RTR/ VRF/ IF/ IS METER/

Name Formula Meaning

Packets Received (packetsReceived/NUM)                      
DELTA

This attribute counts the 
number of packets received 
on an interface

Octets Received (octetsReceived/NUM)                      
DELTA

This attribute counts the 
number of octets received on 
an interface

EIR Packets Received (eirPacketsReceived/NUM)                      
DELTA

This attribute counts the 
number of octets received on 
an interface that have only 
EIR rate enforced by this 
traffic meter.

EIR Octets Received (eirOctetsReceived/NUM)                      
DELTA

This attribute counts the 
number of octets received on 
an interface that have only 
EIR rate enforced by this 
traffic meter.

Packets Remarked (packetsRemarked/NUM)                      
DELTA

This attribute counts the 
number of packets that have 
exceeded the CIR rate and 
have been re-marked by this 
traffic meter.

Octets Remarked (octetsRemarked/NUM)                      
DELTA

This attribute counts the 
number of octets that have 
exceeded the CIR rate and 
have been re-marked by this 
traffic meter.

Packets Discarded (packetsDiscarded/NUM)                      
DELTA

This attribute counts the 
number of packets discarded 
by this traffic policer.

Octets Discarded (octetsDiscarded/NUM)                      
DELTA

This attribute counts the 
number of octets discarded 
by this traffic policer.
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Committed Information 
Rate

(committedInformationRate/NUM) This attribute indicates the 
Committed Information Rate 
(cir) in bits per second.

Excess Information Rate (excessInformationRate/NUM) This attribute indicates the 
Excess Information Rate (eir) 
in bits per second.

Committed Burst Size (committedBurstSize/NUM) This attribute specifies the 
committed burst size (bc) in 
bits.

Excess Burst Size (excessBurstSize/NUM) This attribute specifies the 
excess burst size (be) in bits.

Measurment Interval (measurmentInterval/NUM) This attribute specifies the 
time interval (in milliseconds) 
over which rates and burst 
sizes are measured.

Packets Received since 
Baseline

(packetsReceived/NUM)                      
BASELINEDELTA

This attribute counts the 
number of packets received 
on an interface since last 
baseline reset 

Octets Received since 
Baseline

(octetsReceived/NUM)                      
BASELINEDELTA

This attribute counts the 
number of octets received on 
an interface since last 
baseline reset 

EIR Packets Received 
since Baseline

(eirPacketsReceived/NUM)                      
BASELINEDELTA

This attribute counts the 
number of octets received on 
an interface that have only 
EIR rate enforced by this 
traffic meter since last 
baseline reset 

Table 79 (Continued)
Component: EM/ RTR/ VRF/ IF/ IS METER/

Name Formula Meaning
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EIR Octets Received since 
Baseline since Baseline

(eirOctetsReceived/NUM)                      
BASELINEDELTA

This attribute counts the 
number of octets received on 
an interface that have only 
EIR rate enforced by this 
traffic meter since last 
baseline reset 

Packets Remarked since 
Baseline

(packetsRemarked/NUM)                      
BASELINEDELTA

This attribute counts the 
number of packets that have 
exceeded the CIR rate and 
have been re-marked by this 
traffic meter since last 
baseline reset 

Octets Remarked since 
Baseline

(octetsRemarked/NUM)                      
BASELINEDELTA

This attribute counts the 
number of octets that have 
exceeded the CIR rate and 
have been re-marked by this 
traffic meter since last 
baseline reset 

Packets Discarded since 
Baseline

(packetsDiscarded/NUM)                      
BASELINEDELTA

This attribute counts the 
number of packets discarded 
by this traffic policer since last 
baseline reset 

Octets Discarded since 
Baseline

(octetsDiscarded/NUM)                      
BASELINEDELTA

This attribute counts the 
number of octets discarded 
by this traffic policer since last 
baseline reset 

Table 79 (Continued)
Component: EM/ RTR/ VRF/ IF/ IS METER/

Name Formula Meaning
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Table 80
Component: EM/ SHELF BUS/

Name Formula Meaning

Bus Utilization (%) (utilization/NUM) Bus utilization.

Table 81
Component: EM/ SHELF BUS/ TEST

Name Formula Meaning

self test result(0) (selfTestResults[0]/NUM) Verifies the operation of a 
bus.

self test result(15) (selfTestResults[15]/NUM) Verifies the operation of a 
bus.

clock source test 
result(0..0)

(clockSourceTestResults[0,0]/
NUM)

Verifies the operation of a 
bus.

clock source test 
result(0..15)

(clockSourceTestResults[1,15]/
NUM)

Verifies the operation of a 
bus.

Table 82
Component: EM/ SHELF CARD/

Name Formula Meaning

CPU Utilization (%) (cpuUtil/NUM) Card CPU utilization.

Fast Ram Memory 
Utilization (%)

(memoryUsage[0]/NUM)                      
(memoryCapacity[0]/NUM)                      
PERCENT

Fast ram memory utilization.

Normal Ram Memory 
Utilization (%)

(memoryUsage[1]/NUM)                      
(memoryCapacity[1]/NUM)                      
PERCENT

Normal ram memory 
utilization.
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Shared Ram Memory 
Utilization (%)

(memoryUsage[2]/NUM)                      
(memoryCapacity[2]/NUM)                      
PERCENT

Shared ram memory 
utilization.

Shared Msg Block 
Utilization (%)

(sharedMsgBlockUsage/NUM)                      
(sharedMsgBlockCapacity/NUM)                      
PERCENT

Shared message block 
utilization.

Local Msg Block Utilization 
(%)

(localMsgBlockUsage/NUM)                      
(localMsgBlockCapacity/NUM)                      
PERCENT

Local message block 
utilization.

Table 82 (Continued)
Component: EM/ SHELF CARD/

Name Formula Meaning
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Table 83
Component: EM/ SHELF FABRICCARD/

Name Formula Meaning

Bus Utilization (%) (utilization/NUM) Estimates the current fabric 
utilization.

Table 84
Component: EM/ TRK/

Name Formula Meaning

Packets/sec from Interface (pktFromIf/NUM)                      DELTA                      
SECONDS                      DIVIDE

Packets from interface per 
second.

Packets from Interface 
since Baseline

(pktFromIf/NUM)                      
BASELINEDELTA

Packets from interface since 
the last baseline reset.

Trunk Pks/s to Interface (trunkPktToIf/NUM)                      
DELTA                      SECONDS                      
DIVIDE

Trunk packets to interface per 
second.

Trunk Pks to Interface 
since Baseline

(trunkPktToIf/NUM)                      
BASELINEDELTA

Trunk packets to interface 
since the last baseline reset.

Trunk Pks/s from Interface (trunkPktFromIf/NUM)                      
DELTA                      SECONDS                      
DIVIDE

Trunk packets from interface 
per second.

Trunk Pks from Interface 
since Baseline

(trunkPktFromIf/NUM)                      
BASELINEDELTA

Trunk packets from interface 
since the last baseline reset.

Discarded packets/sec (discardUnforward/NUM)                      
DELTA                      SECONDS                      
DIVIDE

Discarded packets per 
second.

Discarded packets since 
Baseline

(discardUnforward/NUM)                      
BASELINEDELTA

Discarded packets since the 
last baseline reset.
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Round trip delay (ms / 10) (measuredRoundTripDelay/NUM) Round trip delay in 
millisecond measured by the 
trunk or DPN Gateway.

Packet/sec from Interface 
EP equals 0

(pktFromIfByPrio[0]/NUM)                      
DELTA                      SECONDS                      
DIVIDE

Packets with priority 0 from 
interface per second.

Packet from Interface EP 
equals 0 since Baseline

(pktFromIfByPrio[0]/NUM)                      
BASELINEDELTA

Packets with priority 0 from 
interface since the last 
baseline reset.

Packet/sec from Interface 
EP equals 1

(pktFromIfByPrio[1]/NUM)                      
DELTA                      SECONDS                      
DIVIDE

Packets with priority 1 from 
interface per second.

Packet from Interface EP 
equals 1 since Baseline

(pktFromIfByPrio[1]/NUM)                      
BASELINEDELTA

Packets with priority 1 from 
interface since the last 
baseline reset.

Packet/sec from Interface 
EP equals 2

(pktFromIfByPrio[2]/NUM)                      
DELTA                      SECONDS                      
DIVIDE

Packets with priority 2 from 
interface per second.

Packet from Interface EP 
equals 2 since Baseline

(pktFromIfByPrio[2]/NUM)                      
BASELINEDELTA

Packets with priority 2 from 
interface since the last 
baseline reset.

Discarded Packet/sec from 
IF EP equals 0

(discPktFromIfByPrio[0]/NUM)                      
DELTA                      SECONDS                      
DIVIDE

Discarded packets with 
priority 0 from interface per 
second.

Discarded Packet from IF 
EP equals 0 since Baseline

(discPktFromIfByPrio[0]/NUM)                      
BASELINEDELTA

Discarded packets with 
priority 0 from interface since 
the last baseline reset.

Discarded Packet/sec from 
IF EP equals 1

(discPktFromIfByPrio[1]/NUM)                      
DELTA                      SECONDS                      
DIVIDE

Discarded packets with 
priority 1 from interface per 
second.

Discarded Packet from IF 
EP equals 1 since Baseline

(discPktFromIfByPrio[1]/NUM)                      
BASELINEDELTA

Discarded packets with 
priority 1 from interface since 
the last baseline reset.

Table 84 (Continued)
Component: EM/ TRK/

Name Formula Meaning
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Discarded Packet/sec from 
IF EP equals 2

(discPktFromIfByPrio[2]/NUM)                      
DELTA                      SECONDS                      
DIVIDE

Discarded packets with 
priority 2 from interface per 
second.

Discarded Packet from IF 
EP equals 2 since Baseline

(discPktFromIfByPrio[2]/NUM)                      
BASELINEDELTA

Discarded packets with 
priority 2 from interface since 
the last baseline reset.

Octets/sec from Interface 
EP equals 0

(octetFromIfByPrio[0]/NUM)                      
DELTA                      SECONDS                      
DIVIDE

Octets with priority 0 from 
interface per second.

Octets from Interface EP 
equals 0 since Baseline

(octetFromIfByPrio[0]/NUM)                      
BASELINEDELTA

Octets with priority 0 from 
interface since the last 
baseline reset.

Octets/sec from Interface 
EP equals 1

(octetFromIfByPrio[1]/NUM)                      
DELTA                      SECONDS                      
DIVIDE

Octets with priority 1 from 
interface per second.

Octets from Interface EP 
equals 1 since Baseline

(octetFromIfByPrio[1]/NUM)                      
BASELINEDELTA

Octets with priority 1 from 
interface since the last 
baseline reset.

Octets/sec from Interface 
EP equals 2

(octetFromIfByPrio[2]/NUM)                      
DELTA                      SECONDS                      
DIVIDE

Octets with priority 2 from 
interface per second.

Octets from Interface EP 
equals 2 since Baseline

(octetFromIfByPrio[2]/NUM)                      
BASELINEDELTA

Octets with priority 2 from 
interface since the last 
baseline reset.

Utilization (utilization/NUM) Average trunk utilization.

Table 84 (Continued)
Component: EM/ TRK/

Name Formula Meaning
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Table 85
Component: EM/ TRK/ ATM

Name Formula Meaning

Last Calculated Vcc 
Utilization

(lastCalculatedVccUtilization/NUM) Last Calculated Vcc 
Utilization.

Last Calculated TxVcc 
Utilization

(lastCalculatedTxVccUtilization/
NUM)

Last Calculated TxVcc 
Utilization.

Table 86
Component: EM/ TRK/ UNACKED FRAMER

Name Formula Meaning

Frames per second from 
Interface

(frmFromIf/NUM)                      DELTA                      
SECONDS                      DIVIDE

Frames received per second.

Frames from Interface 
since Baseline

(frmFromIf/NUM)                      
BASELINEDELTA

Frames received since the 
last baseline reset.

Outgoing Normal Link 
Utilization

(normPrioLinkUtilToIf/NUM) Normal traffic sending link 
utilization.

Incoming Normal Link 
Utilization

(normPrioLinkUtilFromIf/NUM) Normal traffic receiving link 
utilization.

Outgoing Priority Link 
Utilization

(highPrioLinkUtilToIf/NUM) Priority traffic sending link 
utilization.

Incoming Priority Link 
Utilization

(highPrioLinkUtilFromIf/NUM) Priority traffic receiving link 
utilization.

Octet Alignment Errors (nonOctetErrors/NUM)                      
DELTA

Number of non-octet aligned 
frames since last probe.

Octet Alignment Errors 
since Baseline

(nonOctetErrors/NUM)                      
BASELINEDELTA

Number of non-octet aligned 
frames since the last baseline 
reset.

Frame Length Errors (largeFrmErrors/NUM)                      
DELTA

Number of bad length frames 
since last probe.
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Frame Length Errors since 
Baseline

(largeFrmErrors/NUM)                      
BASELINEDELTA

Number of bad length frames 
since the last baseline reset.

Frame Abort Errors (aborts/NUM)                      DELTA Number of aborted frames 
since last probe.

Frame Abort Errors since 
Baseline

(aborts/NUM)                      
BASELINEDELTA

Number of aborted frames 
since the last baseline reset.

Table 86 (Continued)
Component: EM/ TRK/ UNACKED FRAMER

Name Formula Meaning
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Table 87
Component: EM/ TRK/ UTP FRAMER

Name Formula Meaning

Frames per second to 
Interface

(frmToIf/NUM)                      DELTA                      
SECONDS                      DIVIDE

Frames sent per second.

Frames to Interface since 
Baseline

(frmToIf/NUM)                      
BASELINEDELTA

Frames sent since the last 
baseline reset.

Frames per second from 
Interface

(frmFromIf/NUM)                      DELTA                      
SECONDS                      DIVIDE

Frames received per second.

Frames from Interface 
since Baseline

(frmFromIf/NUM)                      
BASELINEDELTA

Frames received since the 
last baseline reset.

Outgoing Normal Link 
Utilization

(normPrioLinkUtilToIf/NUM) Normal traffic sending link 
utilization.

Incoming Normal Link 
Utilization

(normPrioLinkUtilFromIf/NUM) Normal traffic receiving link 
utilization.

Outgoing Priority Link 
Utilization

(highPrioLinkUtilToIf/NUM) Priority traffic sending link 
utilization.

Incoming Priority Link 
Utilization

(highPrioLinkUtilFromIf/NUM) Priority traffic receiving link 
utilization.

Octet Alignment Errors (nonOctetErrors/NUM)                      
DELTA

Number of non-octet aligned 
frames since last probe.

Octet Alignment Errors 
since Baseline

(nonOctetErrors/NUM)                      
BASELINEDELTA

Number of non-octet aligned 
frames since the last baseline 
reset.

Frame Length Errors (largeFrmErrors/NUM)                      
DELTA

Number of bad length frames 
since last probe.

Frame Length Errors since 
Baseline

(largeFrmErrors/NUM)                      
BASELINEDELTA

Number of bad length frames 
since the last baseline reset.

Frame Abort Errors (aborts/NUM)                      DELTA Number of aborted frames 
since last probe.

Frame Abort Errors since 
Baseline

(aborts/NUM)                      
BASELINEDELTA

Number of aborted frames 
since the last baseline reset.
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Table 88
Component: EM/ VR/ IFTABLEENTRY/

Name Formula Meaning

comp Name (componentName/STR) Provides a component name 
associated with the IFentry.

In Octets (ifInOctets/NUM)                      DELTA Number of octets received on 
the interface, including 
framing characters.

In Octets since Baseline (ifInOctets/NUM)                      
BASELINEDELTA

Number of octets received on 
the interface, including 
framing characters, since the 
last baseline reset.

Out Octets (ifOutOctets/NUM)                      
DELTA

Number of octets transmitted 
out the interface, including 
framing characters.

Out Octets since Baseline (ifOutOctets/NUM)                      
BASELINEDELTA

Number of octets transmitted 
out the interface, including 
framing characters, since the 
last baseline reset.

In Discards (ifInDiscards/NUM)                      
DELTA

Number of inbound packets 
discarded even though no 
errors detected. Prevents the 
packets from being delivered 
to a higher layer protocol.

In Discards since Baseline (ifInDiscards/NUM)                      
BASELINEDELTA

Number of inbound packets 
discarded even though no 
errors detected since the last 
baseline reset. Prevents the 
packets from being delivered 
to a higher layer protocol.

Out Discards (ifOutDiscards/NUM)                      
DELTA

Number of outbound packets 
discarded even though no 
errors detected. Prevents the 
packets from being 
transmitted.
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Out Discards since 
Baseline

(ifOutDiscards/NUM)                      
BASELINEDELTA

Number of outbound packets 
discarded even though no 
errors detected since the last 
baseline reset. Prevents the 
packets from being 
transmitted.

In Ucast Pkts (ifInUcastPkts/NUM)                      
DELTA

Number of subnetwork-
unicast packets delivered to a 
higher layer protocol.

In Ucast Pkts since 
Baseline

(ifInUcastPkts/NUM)                      
BASELINEDELTA

Number of subnetwork-
unicast packets delivered to a 
higher layer protocol since the 
last baseline reset.

Out Ucast Pkts (ifOutUcastPkts/NUM)                      
DELTA

Number of packets the higher 
level protocols request to be 
transmitted to a subnetwork-
unicast address. Includes 
discarded and unsent 
packets.

Out Ucast Pkts since 
Baseline

(ifOutUcastPkts/NUM)                      
BASELINEDELTA

Number of packets the higher 
level protocols request to be 
transmitted to a subnetwork-
unicast address, since the 
last baseline reset. Includes 
discarded and unsent 
packets.

In NUcast Pkts (ifInNuCastPkts/NUM)                      
DELTA

Number of non-unicast 
packets delivered to a higher 
layer protocol.

In NUcast Pkts since 
Baseline

(ifInNuCastPkts/NUM)                      
BASELINEDELTA

Number of non-unicast 
packets delivered to a higher 
layer protocol, since the last 
baseline reset.

Table 88 (Continued)
Component: EM/ VR/ IFTABLEENTRY/

Name Formula Meaning
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Out NUcast Pkts (ifOutNuCastPkts/NUM)                      
DELTA

Number of packets the higher 
level protocols request to be 
transmitted to a non-unicast 
address. Includes discarded 
and unsent packets.

Out NUcast Pkts since 
Baseline

(ifOutNuCastPkts/NUM)                      
BASELINEDELTA

Number of packets the higher 
level protocols request to be 
transmitted to a non-unicast 
address, since the last 
baseline reset. Includes 
discarded and unsent 
packets.

In Octets (64-bit) (ifHCInOctets/NUM)                      
DELTA

Number of octets received on 
the interface, including 
framing characters, in 64-bit.

In Octets since Baseline 
(64-bit)

(ifHCInOctets/NUM)                      
BASELINEDELTA

Number of octets received on 
the interface, including 
framing characters, since the 
last baseline reset, in 64-bit.

Out Octets (64-bit) (ifHCOutOctets/NUM)                      
DELTA

Number of octets transmitted 
out the interface, including 
framing characters, in 64-bit.

Out Octets since Baseline 
(64-bit)

(ifHCOutOctets/NUM)                      
BASELINEDELTA

Number of octets transmitted 
out the interface, including 
framing characters, since the 
last baseline reset, in 64-bit.

In Ucast Pkts (64-bit) (ifHCInUcastPkts/NUM)                      
DELTA

Number of subnetwork-
unicast packets delivered to a 
higher layer protocol, in 64-
bit.

In Ucast Pkts since 
Baseline (64-bit)

(ifHCInUcastPkts/NUM)                      
BASELINEDELTA

Number of subnetwork-
unicast packets delivered to a 
higher layer protocol since the 
last baseline reset, in 64-bit.

Table 88 (Continued)
Component: EM/ VR/ IFTABLEENTRY/

Name Formula Meaning
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Out Ucast Pkts (64-bit) (ifHCOutUcastPkts/NUM)                      
DELTA

Number of packets the higher 
level protocols request to be 
transmitted to a subnetwork-
unicast address. Includes 
discarded and unsent 
packets, in 64-bit.

Out Ucast Pkts since 
Baseline (64-bit)

(ifHCOutUcastPkts/NUM)                      
BASELINEDELTA

Number of packets the higher 
level protocols request to be 
transmitted to a subnetwork-
unicast address, since the 
last baseline reset. Includes 
discarded and unsent 
packets, in 64-bit.

Table 88 (Continued)
Component: EM/ VR/ IFTABLEENTRY/

Name Formula Meaning
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Table 89
Component: EM/ VR/ IP

Name Formula Meaning

Input Datagrams Received (inReceives/NUM)                      
DELTA

The number of input 
datagrams received from the 
interfaces, including those 
received in error since the last 
probe.

Input Datagrams Received 
since Baseline

(inReceives/NUM)                      
BASELINEDELTA

The number of input 
datagrams received from the 
interfaces, including those 
received in error since the last 
baseline reset.

Invalid Address Errors 
Discarded

(inAddrErrors/NUM)                      
DELTA

The number of input 
datagrams discarded due to 
errors such as  invalid 
address, unsupported 
address class since the last 
probe.

Invalid Address Errors 
Discarded since Baseline

(inAddrErrors/NUM)                      
BASELINEDELTA

The number of input 
datagrams discarded due to 
errors such as  invalid 
address, unsupported 
address class since the last 
baseline reset.

Invalid Header Errors 
Discarded

(inHdrErrors/NUM)                      
DELTA

The number of input 
datagrams discarded due to 
errors in their IP headers, 
including bad checksums, 
version number mismatch, 
other format errors, time-to-
live exceeded, errors 
discovered in processing their 
IP options, etc since the last 
probe.
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Invalid Header Errors 
Discarded since Baseline

(inHdrErrors/NUM)                      
BASELINEDELTA

The number of input 
datagrams discarded due to 
errors in their IP headers, 
including bad checksums, 
version number mismatch, 
other format errors, time-to-
live exceeded, errors 
discovered in processing their 
IP options, etc since the last 
baseline reset.

Input Datagrams Discarded (inDiscards/NUM)                      
DELTA

The number of input 
datagrams for which no 
problems were encountered 
to prevent their continued 
processing, but which were 
discarded due to  the lack of 
buffers since the last probe. 
This does not include any 
datagram discarded while 
awaiting for re-asembly.

Input Datagrams Discarded 
since Baseline

(inDiscards/NUM)                      
BASELINEDELTA

The number of input 
datagrams for which no 
problems were encountered 
to prevent their continued 
processing, but which were 
discarded due to  the lack of 
buffers since the last baseline 
reset. This does not include 
any datagram discarded 
while awaiting for re-asembly.

Input Datagrams Delivered (inDelivers/NUM)                      DELTA The number of input 
datagrams successfully 
delivered to IP user- protocols 
(including ICMP) since the 
last probe.

Table 89 (Continued)
Component: EM/ VR/ IP

Name Formula Meaning
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Input Datagrams Delivered 
since Baseline

(inDelivers/NUM)                      
BASELINEDELTA

The number of input 
datagrams successfully 
delivered to IP user- protocols 
(including ICMP) since the 
last baseline reset.

Out Requests (outRequests/NUM)                      
DELTA

The number of datagrams 
which local IP user-protocols 
(including ICMP) supplied to 
IP in requests for 
transmission since the last 
probe.

Out Requests since 
Baseline

(outRequests/NUM)                      
BASELINEDELTA

The number of datagrams 
which local IP user-protocols 
(including ICMP)  supplied to 
IP in requests for 
transmission since the last 
baseline reset.

Out Discards (outDiscards/NUM)                      
DELTA

The number of outbound 
datagrams that were 
discarded due to the lack of 
buffers since the last probe.

Out Discards since 
Baseline

(outDiscards/NUM)                      
BASELINEDELTA

The number of outbound 
datagrams that were 
discarded due to the lack of 
buffers since the last baseline 
reset.

No Route Out Discards (outNoRoutes/NUM)                      
DELTA

The number of outbound 
datagrams discarded 
because no route could be 
found to transmit them to their 
destination since the last 
probe.

Table 89 (Continued)
Component: EM/ VR/ IP

Name Formula Meaning
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No Route Out Discards 
since Baseline

(outNoRoutes/NUM)                      
BASELINEDELTA

The number of outbound 
datagrams discarded 
because no route could be 
found to transmit them to their 
destination since the last 
baseline reset.

Routing Discards (routingDiscards/NUM)                      
DELTA

The number of routing entries 
which were chosen to be 
discarded even though they 
are valid since the last probe.

Routing Discards since 
Baseline

(routingDiscards/NUM)                      
BASELINEDELTA

The number of routing entries 
which were chosen to be 
discarded even though they 
are valid since the last 
baseline reset.

Table 89 (Continued)
Component: EM/ VR/ IP

Name Formula Meaning
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Table 90
Component: EM/ VR/ IP RTD VCGDESTADDR/

Name Formula Meaning

Minimum Round Trip Delay (minRoundTripDelay/NUM) Minimum round trip delay 
measured in the last 
monitoring session.

Maximum Round Trip 
Delay

(maxRoundTripDelay/NUM) Maximum round trip delay 
measured in the last 
monitoring session.

Average Round Trip Delay (avgRoundTripDelay/NUM) Average round trip delay 
calculated in the last 
monitoring session.

RTD Frame Transmitted (framesTransmitted/NUM) The number of RTD frames 
transmitted to this remote 
destination address.

RTD Frame Received (framesReceived/NUM) The number of RTD frames 
received.

Last Monitoring Time (time/STR) The start time of the latest 
RTD session.

Table 91
Component: EM/ VR/ PP/ IPPORT ES METER/

Name Formula Meaning

Packets Received (packetsReceived/NUM)                      
DELTA

This attribute counts the 
number of packets received 
on an interface

Octets Received (octetsReceived/NUM)                      
DELTA

This attribute counts the 
number of octets received on 
an interface
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EIR Packets Received (eirPacketsReceived/NUM)                      
DELTA

This attribute counts the 
number of octets received on 
an interface that have only 
EIR rate enforced by this 
traffic meter.

EIR Octets Received (eirOctetsReceived/NUM)                      
DELTA

This attribute counts the 
number of octets received on 
an interface that have only 
EIR rate enforced by this 
traffic meter.

Packets Remarked (packetsRemarked/NUM)                      
DELTA

This attribute counts the 
number of packets that have 
exceeded the CIR rate and 
have been re-marked by this 
traffic meter.

Octets Remarked (octetsRemarked/NUM)                      
DELTA

This attribute counts the 
number of octets that have 
exceeded the CIR rate and 
have been re-marked by this 
traffic meter.

Packets Discarded (packetsDiscarded/NUM)                      
DELTA

This attribute counts the 
number of packets discarded 
by this traffic policer.

Octets Discarded (octetsDiscarded/NUM)                      
DELTA

This attribute counts the 
number of octets discarded 
by this traffic policer.

Committed Information 
Rate

(committedInformationRate/NUM) This attribute indicates the 
Committed Information Rate 
(cir) in bits per second.

Excess Information Rate (excessInformationRate/NUM) This attribute indicates the 
Excess Information Rate (eir) 
in bits per second.

Table 91 (Continued)
Component: EM/ VR/ PP/ IPPORT ES METER/

Name Formula Meaning
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Committed Burst Size (committedBurstSize/NUM) This attribute specifies the 
committed burst size (bc) in 
bits.

Excess Burst Size (excessBurstSize/NUM) This attribute specifies the 
excess burst size (be) in bits.

Measurment Interval (measurmentInterval/NUM) This attribute specifies the 
time interval (in milliseconds) 
over which rates and burst 
sizes are measured.

Packets Received since 
Baseline

(packetsReceived/NUM)                      
BASELINEDELTA

This attribute counts the 
number of packets received 
on an interface since last 
baseline reset 

Octets Received since 
Baseline

(octetsReceived/NUM)                      
BASELINEDELTA

This attribute counts the 
number of octets received on 
an interface since last 
baseline reset 

EIR Packets Received 
since Baseline

(eirPacketsReceived/NUM)                      
BASELINEDELTA

This attribute counts the 
number of octets received on 
an interface that have only 
EIR rate enforced by this 
traffic meter since last 
baseline reset 

EIR Octets Received since 
Baseline since Baseline

(eirOctetsReceived/NUM)                      
BASELINEDELTA

This attribute counts the 
number of octets received on 
an interface that have only 
EIR rate enforced by this 
traffic meter since last 
baseline reset 

Table 91 (Continued)
Component: EM/ VR/ PP/ IPPORT ES METER/

Name Formula Meaning
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Packets Remarked since 
Baseline

(packetsRemarked/NUM)                      
BASELINEDELTA

This attribute counts the 
number of packets that have 
exceeded the CIR rate and 
have been re-marked by this 
traffic meter since last 
baseline reset 

Octets Remarked since 
Baseline

(octetsRemarked/NUM)                      
BASELINEDELTA

This attribute counts the 
number of octets that have 
exceeded the CIR rate and 
have been re-marked by this 
traffic meter since last 
baseline reset 

Packets Discarded since 
Baseline

(packetsDiscarded/NUM)                      
BASELINEDELTA

This attribute counts the 
number of packets discarded 
by this traffic policer since last 
baseline reset 

Octets Discarded since 
Baseline

(octetsDiscarded/NUM)                      
BASELINEDELTA

This attribute counts the 
number of octets discarded 
by this traffic policer since last 
baseline reset 

Table 91 (Continued)
Component: EM/ VR/ PP/ IPPORT ES METER/

Name Formula Meaning
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Table 92
Component: EM/ VR/ PP/ IPPORT IS METER/

Name Formula Meaning

Packets Received (packetsReceived/NUM)                      
DELTA

This attribute counts the 
number of packets received 
on an interface

Octets Received (octetsReceived/NUM)                      
DELTA

This attribute counts the 
number of octets received on 
an interface

EIR Packets Received (eirPacketsReceived/NUM)                      
DELTA

This attribute counts the 
number of octets received on 
an interface that have only 
EIR rate enforced by this 
traffic meter.

EIR Octets Received (eirOctetsReceived/NUM)                      
DELTA

This attribute counts the 
number of octets received on 
an interface that have only 
EIR rate enforced by this 
traffic meter.

Packets Remarked (packetsRemarked/NUM)                      
DELTA

This attribute counts the 
number of packets that have 
exceeded the CIR rate and 
have been re-marked by this 
traffic meter.

Octets Remarked (octetsRemarked/NUM)                      
DELTA

This attribute counts the 
number of octets that have 
exceeded the CIR rate and 
have been re-marked by this 
traffic meter.

Packets Discarded (packetsDiscarded/NUM)                      
DELTA

This attribute counts the 
number of packets discarded 
by this traffic policer.

Octets Discarded (octetsDiscarded/NUM)                      
DELTA

This attribute counts the 
number of octets discarded 
by this traffic policer.
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Committed Information 
Rate

(committedInformationRate/NUM) This attribute indicates the 
Committed Information Rate 
(cir) in bits per second.

Excess Information Rate (excessInformationRate/NUM) This attribute indicates the 
Excess Information Rate (eir) 
in bits per second.

Committed Burst Size (committedBurstSize/NUM) This attribute specifies the 
committed burst size (bc) in 
bits.

Excess Burst Size (excessBurstSize/NUM) This attribute specifies the 
excess burst size (be) in bits.

Measurment Interval (measurmentInterval/NUM) This attribute specifies the 
time interval (in milliseconds) 
over which rates and burst 
sizes are measured.

Packets Received since 
Baseline

(packetsReceived/NUM)                      
BASELINEDELTA

This attribute counts the 
number of packets received 
on an interface since last 
baseline reset 

Octets Received since 
Baseline

(octetsReceived/NUM)                      
BASELINEDELTA

This attribute counts the 
number of octets received on 
an interface since last 
baseline reset 

EIR Packets Received 
since Baseline

(eirPacketsReceived/NUM)                      
BASELINEDELTA

This attribute counts the 
number of octets received on 
an interface that have only 
EIR rate enforced by this 
traffic meter since last 
baseline reset 

Table 92 (Continued)
Component: EM/ VR/ PP/ IPPORT IS METER/

Name Formula Meaning
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EIR Octets Received since 
Baseline since Baseline

(eirOctetsReceived/NUM)                      
BASELINEDELTA

This attribute counts the 
number of octets received on 
an interface that have only 
EIR rate enforced by this 
traffic meter since last 
baseline reset 

Packets Remarked since 
Baseline

(packetsRemarked/NUM)                      
BASELINEDELTA

This attribute counts the 
number of packets that have 
exceeded the CIR rate and 
have been re-marked by this 
traffic meter since last 
baseline reset 

Octets Remarked since 
Baseline

(octetsRemarked/NUM)                      
BASELINEDELTA

This attribute counts the 
number of octets that have 
exceeded the CIR rate and 
have been re-marked by this 
traffic meter since last 
baseline reset 

Packets Discarded since 
Baseline

(packetsDiscarded/NUM)                      
BASELINEDELTA

This attribute counts the 
number of packets discarded 
by this traffic policer since last 
baseline reset 

Octets Discarded since 
Baseline

(octetsDiscarded/NUM)                      
BASELINEDELTA

This attribute counts the 
number of octets discarded 
by this traffic policer since last 
baseline reset 

Table 92 (Continued)
Component: EM/ VR/ PP/ IPPORT IS METER/

Name Formula Meaning
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Table 93
Component: EM/ VR/ PP/ MPLSPORT

Name Formula Meaning

In Octets Received (inOctets/NUM)                      DELTA The number of octets 
received from terminating or 
incoming tandem MPLS data 
traffic since the last probe.

In Octets Received since 
Baseline

(inOctets/NUM)                      
BASELINEDELTA

The number of octets 
received from terminating or 
incoming tandem MPLS data 
traffic since the last baseline 
reset.

In Octets Discarded (inDiscards/NUM)                      
DELTA

The number of octets 
received but discarded from 
terminating or incoming 
tandem MPLS data traffic 
since the last probe.

In Octets Discarded since 
Baseline

(inDiscards/NUM)                      
BASELINEDELTA

The number of octets 
received but discarded from 
terminating or incoming 
tandem MPLS data traffic 
since the last baseline reset.

Out Octets Received (outOctets/NUM)                      DELTA The number of octets 
transmitted for originating or 
outgoing transit  MPLS data 
since the last probe.

Out Octets Received since 
Baseline

(outOctets/NUM)                      
BASELINEDELTA

The number of octets 
transmitted for originating or 
outgoing transit  MPLS data 
since the last baseline reset.
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Out Octets Discarded (outDiscards/NUM)                      
DELTA

The total number of packets 
transmitted that were 
discarded since  the last 
probe.

Out Octets Discarded since 
Baseline

(outDiscards/NUM)                      
BASELINEDELTA

The total number of packets 
transmitted that were 
discarded since  the last 
baseline reset.

Table 93 (Continued)
Component: EM/ VR/ PP/ MPLSPORT

Name Formula Meaning
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Table 94
Component: EM/ VR/ PP/ MPLSPORT INSEG/

Name Formula Meaning

De0 Octets Received (de0Oct/NUM)                      DELTA The number of the received 
and successfully passed 
through octets  for the ingress 
traffic on this segment since 
the last probe. The octets 
reflect the non discard-
eligible traffic.

De0 Octets Received since 
Baseline

(de0Oct/NUM)                      
BASELINEDELTA

The number of the received 
and successfully passed 
through octets  for the ingress 
traffic on this segment since 
the last baseline reset. The 
octets reflect the non discard-
eligible traffic.

De1 Octets Received (de1Oct/NUM)                      DELTA The number of the received 
and successfully passed 
through octets  for the ingress 
traffic on this segment since 
the last probe. The octets 
reflect the non discard-
eligible traffic.

De1 Octets Received since 
Baseline

(de1Oct/NUM)                      
BASELINEDELTA

The number of the received 
and successfully passed 
through octets  for the ingress 
traffic on this segment since 
the last baseline reset. The 
octets reflect the non discard-
eligible traffic.

De0 Octets Discarded (de0OctDsc/NUM)                      
DELTA

The number of the received 
but discarded octets for the 
ingress  traffic on this 
segment since the last probe. 
The octets reflect the non 
discard-eligible traffic.
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De0 Octets Discarded 
since Baseline

(de0OctDsc/NUM)                      
BASELINEDELTA

The number of the received 
but discarded octets for the 
ingress  traffic on this 
segment since the last 
baseline reset. The octets 
reflect the non discard-
eligible traffic.

De1 Octets Discarded (de1OctDsc/NUM)                      
DELTA

The number of the received 
but discarded octets for the 
ingress traffic on this segment 
since the last probe. The 
octets reflect the non discard-
eligible traffic.

De1 Octets Discarded 
since Baseline

(de1OctDsc/NUM)                      
BASELINEDELTA

The number of the received 
but discarded octets for the 
ingress traffic on this segment 
since the last baseline reset. 
The octets reflect the non 
discard-eligible traffic.

Table 94 (Continued)
Component: EM/ VR/ PP/ MPLSPORT INSEG/

Name Formula Meaning

 (Sheet 2 of 2)
241-6001-031   15.1    



Appendix A Passport performance metrics   293
Table 95
Component: EM/ VR/ PP/ MPLSPORT OUTSEG/

Name Formula Meaning

De0 Octets Received (de0Oct/NUM)                      DELTA The number of the received 
and successfully passed 
through octets for the egress 
traffic on this segment since 
the last probe. The octets 
reflect the non discard-
eligible traffic.

De0 Octets Received since 
Baseline

(de0Oct/NUM)                      
BASELINEDELTA

The number of the received 
and successfully passed 
through octets for the egress 
traffic on this segment since 
the last baseline reset. The 
octets reflect the non discard-
eligible traffic.

De1 Octets Received (de1Oct/NUM)                      DELTA The number of the received 
and successfully passed 
through octets for the egress 
traffic on this segment since 
the last probe. The octets 
reflect the non discard-
eligible traffic.

De1 Octets Received since 
Baseline

(de1Oct/NUM)                      
BASELINEDELTA

The number of the received 
and successfully passed 
through octets for the egress 
traffic on this segment since 
the last baseline reset. The 
octets reflect the non discard-
eligible traffic.

De0 Octets Discarded (de0OctDsc/NUM)                      
DELTA

The number of the received 
but discarded octets for the 
egress traffic on this segment 
since the last probe. The 
octets reflect the non discard-
eligible traffic.
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De0 Octets Discarded 
since Baseline

(de0OctDsc/NUM)                      
BASELINEDELTA

The number of the received 
but discarded octets for the 
egress traffic on this segment 
since the last baseline reset. 
The octets reflect the non 
discard-eligible traffic.

De1 Octets Discarded (de1OctDsc/NUM)                      
DELTA

The number of the received 
but discarded octets for the 
egress traffic on this segment 
since the last probe. The 
octets reflect the non discard-
eligible traffic.

De1 Octets Discarded 
since Baseline

(de1OctDsc/NUM)                      
BASELINEDELTA

The number of the received 
but discarded octets for the 
egress traffic on this segment 
since the last baseline reset. 
The octets reflect the non 
discard-eligible traffic.

Table 95 (Continued)
Component: EM/ VR/ PP/ MPLSPORT OUTSEG/

Name Formula Meaning
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Table 96
Component: EM/ VROUTE/

Name Formula Meaning

Calls From Subnet (totalCallsFromSubnet/NUM)                      
DELTA

Number of call attempts from 
the subnet since the last 
probe.

Calls From Subnet since 
Baseline

(totalCallsFromSubnet/NUM)                      
BASELINEDELTA

Number of call attempts from 
the subnet since the last 
baseline reset.

Calls Cleared (No Channel) (callsClearedNoChannel/NUM)                      
DELTA

Number of call attempts from 
the subnet since the last 
probe rejected  due to lack of 
idle channels.

Calls Cleared (No Channel) 
since Baseline

(callsClearedNoChannel/NUM)                      
BASELINEDELTA

Number of call attempts from 
the subnet rejected due to 
lack of idle channels, since 
the last baseline reset.

Calls Cleared (Out of 
Service)

(callsClearedOutOfService/NUM)                      
DELTA

Number of call attempts from 
the subnet since the last 
probe rejected  due to lack of 
in-service channels.

Calls Cleared (Out of 
Service) since Baseline

(callsClearedOutOfService/NUM)                      
BASELINEDELTA

Number of call attempts from 
the subnet rejected due to 
lack of in-service channels, 
since the last baseline reset.

Calls Rejected (callsRejected/NUM)                      
DELTA

Number of call attempts from 
the subnet since the last 
probe rejected due to 
typeOfCall or signaling 
protocol mismatches.

Calls Rejected since 
Baseline

(callsRejected/NUM)                      
BASELINEDELTA

Number of call attempts from 
the subnet rejected due to 
typeOfCall or  signaling 
protocol mismatches, since 
the last baseline reset.
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Table 97
Component: EM/ VS/ FRAMER

Name Formula Meaning

Total Cells (totalCells/NUM)                      DELTA Total number of cells since 
last probe.

Total Cells since Baseline (totalCells/NUM)                      
BASELINEDELTA

Total number of cells since 
the last baseline reset.

Audio Cells (audioCells/NUM)                      
DELTA

Number of audio cells since 
last probe.

Audio Cells since Baseline (audioCells/NUM)                      
BASELINEDELTA

Number of audio cells since 
the last baseline reset.

Frames To Network (64 s) (frmToNetwork[0]/NUM)                      
DELTA

Number of frames to network 
since last probe.

Frames To Network (64 s) 
since Baseline

(frmToNetwork[0]/NUM)                      
BASELINEDELTA

Number of frames to network 
since the last baseline reset.

Frames To Network (32 s) (frmToNetwork[1]/NUM)                      
DELTA

Number of frames to network 
since last probe.

Frames To Network (32 s) 
since Baseline

(frmToNetwork[1]/NUM)                      
BASELINEDELTA

Number of frames to network 
since the last baseline reset.

Frames To Network (24 s) (frmToNetwork[2]/NUM)                      
DELTA

Number of frames to network 
since last probe.

Frames To Network (24 s) 
since Baseline

(frmToNetwork[2]/NUM)                      
BASELINEDELTA

Number of frames to network 
since the last baseline reset.

Frames To Network (16 s) (frmToNetwork[3]/NUM)                      
DELTA

Number of frames to network 
since last probe.

Frames To Network (16 s) 
since Baseline

(frmToNetwork[3]/NUM)                      
BASELINEDELTA

Number of frames to network 
since the last baseline reset.

Frames To Network (8 s) (frmToNetwork[4]/NUM)                      
DELTA

Number of frames to network 
since last probe.

Frames To Network (8 s) 
since Baseline

(frmToNetwork[4]/NUM)                      
BASELINEDELTA

Number of frames to network 
since the last baseline reset.
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Frames Lost In Network (frmLostInNetwork/NUM)                      
DELTA

Number of frames lost in 
network since last probe.

Frames Lost In Network 
since Baseline

(frmLostInNetwork/NUM)                      
BASELINEDELTA

Number of frames lost in 
network since the last 
baseline reset.

Frames Underruns (frmUnderRuns/NUM)                      
DELTA

Number of frame underruns 
since last probe.

Frames Underruns since 
Baseline

(frmUnderRuns/NUM)                      
BASELINEDELTA

Number of frame underruns 
since the last baseline reset.

Frames Dumped (frmDumped/NUM)                      
DELTA

Number of frame dumps 
since last probe.

Frames Dumped since 
Baseline

(frmDumped/NUM)                      
BASELINEDELTA

Number of frame dumps 
since the last baseline reset.

LRC Errors (lrcErrors/NUM)                      DELTA Number of LRC errors since 
last probe.

LRC Errors since Baseline (lrcErrors/NUM)                      
BASELINEDELTA

Number of LRC errors since 
the last baseline reset.

Modem Cells (modemCells/NUM)                      
DELTA

Number of modem cells since 
last probe.

Modem Cells since 
Baseline

(modemCells/NUM)                      
BASELINEDELTA

Number of modem cells since 
the last baseline reset.

Table 97 (Continued)
Component: EM/ VS/ FRAMER

Name Formula Meaning
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Table 98
Component: EM/ VS/ LCO

Name Formula Meaning

Voice Tx Rate (kb/s) (pktsToNetwork/NUM)                      
DELTA                      352                      
MULTIPLY                      SECONDS                      
DIVIDE                      1000                      
DIVIDE

Kilobits sent per second (44 
Bytes/packet).

Voice Tx (kb) since 
Baseline

(pktsToNetwork/NUM)                      
BASELINEDELTA                      352                      
MULTIPLY                      1000                      
DIVIDE

Kilobits sent (44 Bytes/
packet) since the last 
baseline reset.

Voice Rx Rate (kb/s) (pktsFromNetwork/NUM)                      
DELTA                      352                      
MULTIPLY                      SECONDS                      
DIVIDE                      1000                      
DIVIDE

Kilobits received per second 
(44 Bytes/packet).

Voice Rx (kb) since 
Baseline

(pktsFromNetwork/NUM)                      
BASELINEDELTA                      352                      
MULTIPLY                      1000                      
DIVIDE

Kilobits received (44 Bytes/
packet) since the last 
baseline reset.

Round trip delay (ms) (measuredRoundTripDelay/NUM) Measured round trip delay in 
milliseconds. 

Path Up DateTime (pathUpDateTime/STR) Path up date and time.
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Table 99
Component: EM/ VSR/

Name Formula Meaning

Active Channel Number (activeChannels/NUM) Number of currently active B-
channels.

Active Voice Channel 
Number

(activeVoiceChannels/NUM) Number of currently active B-
channels carrying voice.

Active Modem Channel 
Number

(activeModemChannels/NUM) Number of currently active B-
channels carrying MODEM 
(2100Hz tone).

Active Data Channel 
Number

(activeDataChannels/NUM) Number of currently active B-
channels carrying data.
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Appendix B
DPN-100 metrics

DPN-100 Metrics
DPN-100 metrics are generated by the DPN Performance Viewer, and are 
detailed in the following sections.

• “Micro status” (page 301).

• “Net Link status” (page 302).

• “Trunk status” (page 303).

• “Gateway status” (page 304).

• “Summary status” (page 305).

Micro status
This DPN Performance Viewer option provides metrics for the PEs of a 
specific DPN-100 module. The information for these metrics is gathered from 
the DPN-100 NCS PE status records.

See the table “Destination mnem: PM/<mnemonic> or just <mnemonic>” 
(page 302).
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Net Link status
This PV option provides metrics for all the network links whose endpoint 
modules report to a specific DPN-100 NCS OA. The information for these 
metrics is gathered from the DPN-100 NCS Network Link status records.

See the table “Destination mnem: OA/<mnemonic> or just <mnemonic>” 
(page 303).

Table 100
Destination mnem: PM/<mnemonic> or just <mnemonic> 

Name Formula Label Meaning
CPU Utilization (%) peCpuUtilization UT PE CPU utilitilization 

Range: 0-100 %, -1 = 
down

Free Heap (%) peFreeHeap HP PE free heap space 
utilization 
Range: 0-100 %, -1 = 
down

Free MSG (%) peFreeMsgPE MSG free message blocks 
utilization
Range: 0-100 %, -1 = 
down

PPS Sent pePpsSent TXPK/S Packets per second sent
Initial Range: 0-20 pps, -1 
= down

PPS Received pePpsReceived RXPK/S Packets per second 
received
Initial Range: 0-20 pps, -1 
= down

PE Service peService SERVICE PE service name
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Trunk status
This DPN Performance Viewer option provides metrics for all the Trunks 
whose endpoint modules report to a specific DPN-100 NCS OA. The 
information for these metrics is gathered from the DPN-100 NCS Trunk 
status records.

See the table “Destination mnem: OA/<mnemonic> or just <mnemonic>” 
(page 303).

Table 101
Destination mnem: OA/<mnemonic> or just <mnemonic>

Name Formula Label Meaning
Netlink Transmit 
Utilization (%)

netlinkUtilization UT Network link transmit side 
utilization Range: 0-100 
%, -1 = down

Netlink Local Mnemonic netlinkLocalMnemonic LOCAL Local network link 
mnemonic

Netlink Remote 
Mnemonic

netlinkRemoteMnemonic REMOTE Remote network link 
endpoint component ID

Table 102
Destination mnem: OA/<mnemonic> or just <mnemonic>

Name Formula Label Meaning
Trunk Transmit 
Utilization (%)

trunkUtilization UT Trunk transmit side link 
utilization
Range: 0-100 %, -1 = 
down

Trunk Local Mnemonic trunkLocalMnemonic LOCAL Local trunk mnemonic

Trunk Remote 
Mnemonic

trunkRemoteMnemonic REMOTE Remote trunk endpoint 
component ID
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Gateway status
This DPN Performance Viewer option provides metrics for all the X.25 and 
X.75 gateways whose endpoint module reports to a specific DPN-100 NCS 
OA. The information for these metrics is gathered from the DPN-100 NCS 
X.25 and X.75 Gateway status records.

See the table “Destination mnem: OA/<mnemonic> or just <mnemonic>” 
(page 304).

Table 103
Destination mnem: OA/<mnemonic> or just <mnemonic>

Name Formula Label Meaning
Gateway Type gatewayType TYPE Type of gateway (X25 or 

X75)

Gateway Call (%) gatewayCall CALL Maximum percentage 
number of active LCNs 
compared to the total 
number of LCNs for the 
status interval
Range: 0-100 %, -1 = 
down

Link Transmit Utilization 
(%)

gatewayLinkUtilization LINK UT Total link sending and 
receiving utilization
Range: 0-100 %, -1 = 
down

Gateway Pkt Sent gatewayPktSent TXPK/S Packets per second sent
Initial Range: 0-20 pps, -1 
= down

Gateway Pkt Received gatewayPktReceived RXPK/S Packets per second 
received
Initial Range: 0-20 pps, -1 
= down
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Summary status
This DPN Performance Viewer option provides NCS Common Memory 
metrics for modules reporting to a specific DPN-100 NCS OA. The 
information for these metrics is gathered from the DPN-100 NCS Common 
Memory status records.

See the table “Destination mnem: OA/<mnemonic> or just <mnemonic>” 
(page 305).

Table 104
Destination mnem: OA/<mnemonic> or just <mnemonic>

Name Formula Label Meaning
Bus Utilization (%) pmBusUtilization BUS Module bus utilization

Range: 0-100

Common MSG (%) pmCommonMsg MSG Common memory 
message block utilization
Range: 0-100
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Appendix C 
Metric file format

This appendix describes the metric elements and their associated attributes in 
SNMP metric files, describes their formats, and provides sample metric files. 
The section contains the following topics:

• “SNMP metric file formats” (page 307)

• “METRICFILE” (page 307)

• “Metric file example” (page 318)

Add metrics and components to extend the SNMP metric file as required.

The metric file is a flat ASCII file in XML format. To edit it, use a standard 
Unix text editor.

SNMP metric file formats
The metric file contains elements and attributes. For a description of the 
format of this file, see “METRICFILE” (page 307). To view sample metric 
file formats, see “Metric file example” (page 318)

METRICFILE
The keyword <METRICFILE> is mandatory. This keyword denotes the 
beginning of a metric file and must be the first entry in the metric file. The 
keyword </METRICFILE> is also mandatory. This keyword denotes the end 
of a metric file and must be the last entry in the metric file.
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Comment
The comment element is optional. Place comments anywhere within the 
metric file. The format for this element is <!--Comments-->.

COMPONENT
The COMPONENT element is mandatory. This element describes the 
characteristics of the component. Embed one or more COMPONENT 
elements within the METRICFILE tags. The notation <COMPONENT...> 
indicates the beginning of the COMPONENT definition and the notation 
</COMPONENT> indicates the end of that definition. Define all attributes of 
the COMPONENT element within these notations. The attributes of the 
COMPONENT element are as follows:

COMPONENT NAME
The format for the NAME attribute of the COMPONENT element is 
<COMPONENT NAME = “<component name>”> where <component 
name> is the component name used in the Preside Multiservice Data Manager 
component hierarchy. The name begins with the device type which is the root 
of the hierarchy. A slash (/) at the end of each component type indicates that 
a component attribute is required. Use only uppercase characters in this field.

Note: The short form of the component prompt must be used for 
<component name>. Do not leave any white space before or after 
<component name>. Failure to do this when adding or editing metrics 
results in a component not available message when polling for one or 
more metrics.

SEPARATE_IP
The SEPARATE_IP element is optional. When used, it is an element within 
the COMPONENT element. This element indicates that the component has a 
different IP address than the device with which it is associated. To define this 
element, use the <SEPARATE_IP/> notation. 

MAP
The MAP element is optional. When used, it is an element within the 
COMPONENT element. Use this element to map a component instance in the 
component name to a different value. Define one or more MAP elements 
within the COMPONENT element. The notation <MAP...> indicates the 
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beginning of the MAP element definition and the notation </MAP> indicates 
the end of that definition. The are two attributes of the MAP element are as 
follows:

• NAME
The MAP NAME attribute is mandatory when using the MAP element. 
This attribute is an attribute of the MAP element and defines the 
component instance in the component name. The format of the MAP 
NAME attribute is <MAP NAME=”<name>” where <name> uses the 
convention $n to indicate the nth component instance in the component 
name. 

• VALUE
The MAP VALUE indicates the decrement value of the component 
instance. The format of this attribute is VALUE=”<value>” where 
<value> is “DEC(<offset>)” and <offset> is any integer or single 
alphabetic character (A to Z). The notation “DEC(<offset>)” decrements 
the component instance specified in the NAME attribute by the value 
specified in <offset>. The following example shows a sample MAP 
element:

<MAP NAME=”$4”
VALUE=”DEC(A)”>

</MAP>

The value of “$4” for the MAP NAME attribute indicates the mapping 
of the value is performed on the fourth component instance in the 
component name. The value “DEC(A) indicates the fourth component 
instance value will be decremented by the value of the character A. If the 
fourth component instance is “A”, then the resulting value is “0”. If the 
fourth component instance is “B”, then the resulting value is “1”. The 
resulting VALUE is then used as the INDEX value in the METRIC 
element if this component instance is defined in the metric INDEX 
attribute.

METRIC
This METRIC element is mandatory. This element is an element within the 
COMPONENT element. Define one or more METRIC elements within the 
COMPONENT element. The notation <METRIC...> indicates the beginning 
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of the METRIC element definition and the notation </METRIC> indicates 
the end of that definition. Define all attributes of the METRIC element within 
these notations. The attributes of the METRIC element are as follows:

• NAME
The format for the NAME attribute of the METRIC element is 
<METRIC NAME=“<metric name>...>” where <metric name> is the 
name of the metric. The Data Viewer main window uses this name to 
identify the metric.

• POLLBYDEFAULT
The POLLBYDEFAULT attribute of the METRIC element specifies the 
default polling of the metric. The value of this keyword can be “yes” or 
“no”. If “yes”, the metric is polled by default and the metric name 
appears in the “Metrics to be Polled” list in the Data Viewer main 
window. If “no”, the metric is not polled by default and appears in the 
“Metrics Available” list in the Data Viewer main window. To define this 
attribute, use the notation POLLBYDEFAULT=“<yes or no>”.

• THRESHOLD
The THRESHOLD attribute is optional. This attribute of the METRIC 
element specifies the maximum threshold value of the metric. If a metric 
value exceeds the defined threshold, the Data Viewer windows displays 
that data in red. To define this attribute, use the notation 
THRESHOLD=“<value>” where <value> is the threshold value. 

• STACK
The STACK attribute of the METRIC element identifies the attributes to 
be polled and the required calculation. To define this attribute, use the 
notation STACK=“<stack elements>” where <stack elements> contain 
one of the following items:

— an attribute which is defined as name/type

— a constant, entered as a string of digits

— an operator keyword, which indicates that a numerical operation 
should be performed on the current stack contents (for example, 
ADD, SUBTRACT, MULTIPLY). 

— a special keyword (SECONDS) used to represent the elapsed time 
since the last update
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The following are examples of metric stacks:

STACK=“(sdmErroredSeconds/NUM)
(sdmSeverelyErroredSeconds/NUM
PERCENT”

STACK=“(sdmErroredSeconds/NUM)
DELTA
8
MULTIPLY
SECONDS
DIVIDE
2
DIVIDE
2
SUBTRACT”

The stack depth is limited to two. Therefore, express new Data Viewer 
metrics in a manner that runs with a stack depth of two.

Attributes
Each attribute specification is replaced on the stack by the corresponding 
value received from the network. Attributes are written as (name/type), where

 name is the table column name taken from the MIB table for SNMP devices

type indicates the type of data returned from the device for this attribute. The 
Data Viewer supports only the numeric data type (NUM).

Include the same attribute in more than one metric. In this case, only one copy 
of the attribute is stored in the Data Viewer; however, all metrics are 
calculated using the same attribute value.

Constants
Place integer constants on the stack as required to compute the desired value. 
Constants are useful for

• dividing a value by 100 for display as a percentage
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• converting between different units (for example, bytes per second to bits 
per second).

Operators
Several operators are available for use in a metric definition. In the following 
descriptions the top of the stack is the value (attribute or constant) most 
recently placed onto the stack. The bottom of the stack is the other value 
(since Data Viewer requires a stack depth of two).

The following binary operators are supported. When using an operator, both 
the top and bottom values on the stack are removed and the resulting value is 
placed on the top of the stack.

• ADD 
Use this operator to add the two values on the stack and store the result.

• SUBTRACT
Use this operator to subtract the top value from the bottom value and 
store the result. For example, “7 4 SUBTRACT” leaves a result of “3” on 
the stack.

• MULTIPLY
Use this operator to multiply the stack values and store the result.

• DIVIDE
Use this operator to divide the value on the bottom of the stack by the 
value on top and store the result. For example, “6 2 DIVIDE” leaves a 
result of “3” on the stack.

• PERCENT
Use this operator as a shortcut to ensure that percentage calculations are 
performed correctly. In this example, “A B DIVIDE 100 MULTIPLY” 
normally produces the wrong answer because the (integer) division is 
performed before the multiplication. To ensure correct results, use the 
format “A B PERCENT”.
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The following unary operators affect only the top element on the stack. Apply 
them to both attributes and constants. However, they are only useful when the 
top element on the stack is an attribute or the result of a previous stack 
operation.

• NEGATE
This operator toggles the sign of the value on top of the stack. For 
example, “6 2 NEGATE” leaves “6 -2” on the stack.

• DELTA
This operator replaces the attribute value with the difference between the 
current value and the previous value for the same attribute. This is useful 
when dealing with attributes, such as alarm counts, that continue to grow 
over time.

• BASELINEDELTA
This operator replaces the attribute value with the difference between the 
current value and the baseline value. The baseline value is the first 
sample taken after polling is started or resumed. 

SECONDS Keyword
Place the SECOND keyword on the stack to support time-based calculations. 
It is replaced on the stack by the elapsed time since the last update or 
calculation cycle, expressed in the appropriate units. For example, use the 
SECOND keyword to construct metrics of the form “Alarms per minute”. To 
do so, define the following (pseudo) stack:

(AlarmCount/123)
DELTA
SECONDS
DIVIDE
60
MULTIPLY
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In this case the AlarmCount attribute is assumed to be a continually 
increasing variable. Therefore, use the DELTA operator to ensure that only 
the new alarms are used in this calculation.

• INDEX 
The INDEX describes the index of the attributes specified in the stack 
elements. 

The following conventions describe an index:

— $n
The index for the object identifier (OID) of the attribute in the stack 
uses the nth component instance in the component name. In the 
following example, the INDEX attribute has a value of $3. As a 
result, the third-level component in the component name is used as 
the index for the OID of the STACK attribute.

<COMPONENT NAME = “<deivce type>/ <component>/”>
<METRIC NAME=“Uncorrectable HEC errors”

POLLBYDEFAULT=“no” 
THRESHOLD=“100” 
STACK=“(<stack attribute>/NUM) DELTA”
INDEX=“$3” >

</METRIC>
</COMPONENT>

where: 
device typeis the device type
componentis the component type
attribute stackis the attribute name of which its value is used
to calculate the metric value

When entering the component <ABC>/NNE CA/1 SH/1 AWM/11 
in the Data Viewer, and select the metric “Uncorrectable HEC 
errors”, the attribute “awmUncorrHecErrors” translates into the OID 
.1.3.6.1.4.1.562.21.1.1.8.1.4.17.2.1.16. Because the INDEX 
attribute has a value of “$3”, the third component instance (which is 
11 for AWM) is used as the index to the MIB table column. The 
resulting OID is .1.3.6.1.4.1.562.21.1.1.8.1.4.17.2.1.16.11.
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— (<table column>)
The index uses an entry in a MIB table column. The <table column> 
identifies the MIB table column that contains the index. This 
notation retrieves all values for the OID that are associated with the 
<table column>.

If there is only one value in the <table column>, then that value is 
used as the index. If there is more than one value in the <table 
column>, select the appropriate value for the index. This value is 
used as the index for all the selected component instances.

In the following example, the INDEX attribute is defined as the table 
column “brmUpChanId”.

<COMPONENT NAME = “<device type>/ <component>/”>
<METRIC NAME=“<metric name>”

POLLBYDEFAULT=“no” 
THRESHOLD=“100” 
STACK=“(<stack attribute>/NUM) DELTA”
INDEX=“(<index attribute)” >

</METRIC>
</COMPONENT>

where: 
device typeis the device type
componentis the component type
metric nameis the name of the metric
stack attributeis the attribute name of which its value is used to
calculate the metric value
index attributeis the attribute name of which its value is used to
define the index value of the attribute name
<attribute name>

When entering the component <device type>/ <component>/” in the 
Data Viewer and select the metric “Up Total Cell Count”, the 
INDEX attribute “brmUpChanId” is polled and values in this table 
column display in the Index Selection dialog.
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— The selected value is used as the index to the attribute 
“bUpToTCellCount”. For example, if the OID for 
“bUpToTCellCount” is 
.1.3.6.1.4.1.562.21.1.1.8.1.4.19.1.18.1.2.and the selected index 
value is 2, then the OID becomes 
.1.3.6.1.4.1.562.21.1.1.8.1.4.19.1.18.1.2.2.

— (<table column>/COMPONENT)
The index uses an index of the <table column>. The keyword 
COMPONENT uses the component name in the Data Viewer 
window to find the index. When a value of the <table column> 
matches the component, the value’s associated index is used as the 
index for the OID of the attribute name.

In the following example, the INDEX attribute is defined as the 
value “mcmSysIfExtName/COMPONENT”.

<COMPONENT NAME = “MPA/ CARD/ PO/”>
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<METRIC NAME=“Frames received from WAN”
POLLBYDEFAULT=“no” 
THRESHOLD=“100” 
STACK=“(wanifGlobalStatisticsRxBlockCount/NUM) 

DELTA”
INDEX=“(mcmSysIfExtName/COMPONENT)” >

</METRIC>
</COMPONENT>

When entering the component MPA/MPA1 CARD/1 PO/1 in Data 
Viewer and select the metric 
“wanifGlobalStatisticsRxBlockCount”, the table column 
“mcmSysIfExtName” is polled. If a value in this table matches the 
string CARD/1 PO/1, then the index of the matched entry is used as 
the index for the STACK attribute 
“wanifGlobalStatisticsRxBlockCount”. For example, if the OID for 
“wanifGlobalStatisticsRxBlockCount” is 
.1.3.6.1.4.1.562.21.1.1.8.1.4.19.1.18.1.2 and the index entry of the 
table column “mcmSysIfExtName” that matches the string 
CARD/1 PO/1 is 150, then the OID of the STACK attribute 
“wanifGlobalStatisticsRxBlockCount” becomes 
.1.3.6.1.4.1.562.21.1.1.8.1.4.19.1.18.1.2.150.

— <any string>
The constant string <any string> is used as the index for the OID of 
the attribute.

In the following example, the INDEX attribute has the value “0”.

<COMPONENT NAME = “<device type>/ <component>/”>
<METRIC NAME=“Snr”

POLLBYDEFAULT=“no” 
STACK=“(<stack attribute>/NUM)”
INDEX=“(<index attribute>)” >

</METRIC>
</COMPONENT>

where: 
device type is the device type
componentis the component type
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stack attributeis the attribute name of which its value is used to
calculate the metric value

When entering the component <ABC>/NIU3 TMM in Data Viewer 
and select the metric “Snr”, the STACK attribute “tmmDsSnr” is 
translated into its OID .1.3.6.1.4.1.562.21.1.2.14.12. With an 
INDEX value of “0”, the OID for “tmmDsSnr becomes 
.1.3.6.1.4.1.562.21.1.2.14.12.0.

If the OID of the attribute name specified in the stack requires more than one 
index, combine any index method except for (<table column>/
COMPONENT).

Metric file example
<METRICFILE>

<COMPONENT NAME = “<device type>/ <component>/”>
<SEPARATE_IP/>

<METRIC NAME=“<metric name>”
POLLBYDEFAULT=“yes” 
THRESHOLD=“100” 
STACK=“(<stack attribute>/NUM) DELTA”
INDEX=“(<index attribute>)” 

</METRIC>
<METRIC NAME=“<metric name>”

POLLBYDEFAULT=“no”
THRESHOLD=“100”
STACK=“(<stack attribute>/NUM) DELTA”
INDEX=“(<index attribute>)”>

</METRIC>

<--! This is different COMPONENT -->
<COMPONENT NAME = “<device type>/ <component?/”>

<MAP NAME=”$4”
VALUE=”DEC(A)”>

</MAP>
<METRIC NAME=“<metric name>”

POLLBYDEFAULT=“no”
THRESHOLD=“100”
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STACK=“(<stack attribute>>/NUM) DELTA”
INDEX=“$3 $4”>

</METRIC>
<METRIC NAME=“<metric name>”

POLLBYDEFAULT=“no”
THRESHOLD=“100”
STACK=“(<stack attribute>/NUM) DELTA”
INDEX=“$3 $4”>

</METRIC>
</COMPONENT>

</METRICFILE>

where: 
device type is the device type
component is the component type
metric name is the name of the metric
stack attribute is the attribute name of which its value is used to

calculate the metric value
index attribute is the attribute name of which its value is used to 
define

the index value of the attribute name <attribute 
name>
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